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PREFACE

About This Guide

This guide is intended for technical staff who are responsible for upgrading Oracle Knowledge to Release 
8.5.1. This guide covers only the process for upgrading a “plain vanilla” installation of Oracle Knowledge. It 
does not cover processes for upgrading any custom work done to your installation.

Important!   All changes should be applied and thoroughly tested in a development environment prior to 
being implemented in production. Also be sure to back up your database prior to upgrading to mitigate risk 
of data loss.

More information about specific features and defect resolution for each release can be found in Release 
Notes for your point release.

This preface contains the following information:

• In This Guide

• Examples of Product Screens and Text

• References to Web Content

• Examples of Product Screens and Text

In This Guide
The Oracle Knowledge Upgrade Guide is divided into the following sections:

Examples of Product Screens and Text
The product screens, screen text, and file contents depicted in the documentation are examples. We 
attempt to convey the product's appearance and functionality as accurately as possible; however, the 
actual product contents and displays may differ from the published examples.

Chapter 1: General 
Upgrade Information

This chapter contains general information about performing the upgrade.

Chapter 2: Upgrading 
Intelligent Search

This chapter describes the upgrade process for the Oracle Knowledge Intelligent 
Search component.

Chapter 3: Upgrading 
Information Manager

This chapter describes the upgrade process for the Oracle Knowledge Information 
Manager component.

Chapter 4: Upgrading 
InfoCenter and Web 
Applications

This chapter describes the upgrade process for the Oracle Knowledge InfoCenter 
and web applications components.

Chapter 5: Performing an 
In-place Upgrade

This chapter describes the upgrade process for release 8.5.0.0, or higher. This  
chapter covers all products in the Oracle Knowledge suite.
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2  REFERENCES TO WEB CONTENT

U

References to Web Content
For your convenience, this guide refers to Uniform Resource Locators (URLs) for resources published on 
the World Wide Web, when appropriate. We attempt to provide accurate information; however, these 
resources are controlled by their respective owners and are therefore subject to change at any time.

Operating System Variations in Examples and Procedures
We generally use Linux screen displays and naming conventions in our examples and procedures. We 
include other operating system-specific procedures or steps as noted in section headings, or within topics, 
as appropriate.

We present command syntax, program output, and screen displays:

• in Linux format first

• in other Unix-specific variants only when necessary for proper operation or to clarify functional 
differences

• in Windows format only when necessary for clarity
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CHAPTER 1

General Upgrade Information

This chapter provides an overview of the upgrade process.

Upgrade Process Overview
Oracle Knowledge provides a parallel upgrade from release 8.1.2.1 through release 8.4.2.2. With a parallel 
upgrade, you install the latest release and then upgrade and migrate necessary components from the 
previous installation into the new installation. There are several benefits of the parallel upgrade process:

• Requires less downtime. Since the previous installation continues to operate as usual while the new 
installation is configured and tested, there is minimal downtime. 

• Reduces risk of failure. With a parallel upgrade, you can manage and resolve issues in the 
development environment before you put the new installation into production.

• Simplifies the back-out procedure. Backing out is as simple as switching back to the previous 
installation’s URL. 

Oracle Knowledge provides an in-place upgrade for release 8.5.0.0 and higher. With an in-place upgrade, you 
run an upgrade process on the current installation, which involves installing the new software over the current 
software and upgrading and migrating the data and configuration. This may require more downtime than a 
parallel upgrade as the system must be offline to run the upgrade process.

This section provides the following upgrade information:

• Supported Upgrade Paths

• Preparing to Upgrade

• Performing the Parallel Upgrade

Supported Upgrade Paths
This guide provides instructions for completing a parallel upgrade to release 8.5.1 from any release between 
8.1.2.1 and 8.4.2.2; and also provides information on the in-place upgrade from release 8.5.0.0 and higher. 

For information on upgrading from release 8.1.2.0 or earlier, please contact Oracle Consulting Services.
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4   PREPARING TO UPGRADE
Preparing to Upgrade
There are a few tasks you should complete before you start the Oracle Knowledge upgrade.

• Check your hardware configuration to assure that you have the necessary hardware to support the 8.5.1 
installation.

For details, see the Oracle Knowledge 8.5 Supported Environments Matrix on the Oracle Knowledge 
documentation website at http://www.oracle.com/technetwork/indexes/documentation/knowledge-
documentation-1506742.html.

• Install all necessary supporting software for 8.5.1.

For details, see Installing and Configuring Oracle Knowledge.

• Download and extract the 8.5.1 installer and upgrade files.

Extract the 'upgrade-8.5.1.0.zip' upgrade archive into a temporary directory; we refer to this directory as 
<TMP-DIR> throughout this document.

Important!   You must extract the upgrader into a temporary directory that contains only alpha-
numeric characters and no spaces. For example, 852_IMDBUpgrader would be a valid name while 
852_IM+DB_Upgrader would not be valid.

• For Intelligent Search, perform a dictionary object export from the most current dictionary.

You need these objects to recreate any customizations from your current installation. 

• Make a backup of your Information Manager and Analytics Databases.

• Make a backup of the Information Manager content resource files stored at the Content Resource Mount 
Point. The files stored at this location include content .xml files and any file attachments for each 
translation and version of a document. 

Important!   The instructions contained in this guide assume that all planned and required operating 
system upgrades and database upgrades have been successfully completed prior to beginning the Oracle 
Knowledge upgrade. Specifically, upgrades should be performed in the following order: 
1. Upgrade the operating system 
2. Upgrade the database 
3. Upgrade Oracle Knowledge

Performing the Parallel Upgrade
Note:   This section applies only to customers upgrading from release 8.1.2.1 through release 8.4.2.2, using 
the parallel upgrade process. For upgrading from release 8.5.0.0 and higher, please see “Performing an In-
place Upgrade” on page 100.

To perform a parallel upgrade to the Oracle Knowledge 8.5.1 release, you first install and configure the 
products you want to upgrade in a Development environment using the installer available from Oracle. Test 
the installation to assure that it works as expected, without any customizations. Then recreate any 
customizations from the current implementation. This process is then repeated for the Staging environment 
and the Production environment.

The following sections provide an overview of the upgrade process for individual products. The upgrade 
process for a given product may involve a number of manual steps as well as some initial setup, which is 
covered in “Preparing to Upgrade” on page 4.
UPGRADING ORACLE KNOWLEDGE
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5   PERFORMING THE PARALLEL UPGRADE
Intelligent Search Upgrade
Perform a fresh installation of the new release for Intelligent Search, including all required instances and 
basic configuration. 

For Intelligent Search, you must recreate the Domains and Domain Lists in the current Production 
environment. Using the dictionary objects exported in preparation, import these objects into the newly 
installed dictionary, resolving conflicts when completed. 

Next, you must recreate the Personalized Navigation as it appears in the current Production environment. 
Reconcile differences between the current #.xml with the new #.xml file. Finally, recompile all 
customizations with the new JRE and rebuild into .war files. Then you can complete full content processing 
and system testing. See “Upgrading Intelligent Search” on page 7.

Information Manager Upgrade
First, make a copy of the current IM database schema. Perform a fresh installation of the new release of 
Information Manager across all required machines using the Information Manager installer. When the IM 
installer prompts If the Information Manager Database doesn’t exist, do you want the installer to create 
it? select No and provide the database parameters to access the new copy of the current IM database. Once 
the installation has been completed successfully, run the database upgrade utility to update the database 
schema to the schema supported by the new release.

Proceed to migrate the custom settings made in the applications.properties, config.properties, 
and web.xml files. Migrate any custom e-mail templates and any additions to the spell-check dictionary. 
Finally, migrate any other customizations that you wish to deploy with the new release. See “Upgrading 
Information Manager” on page 19.

WEB APPLICATIONS UPGRADE

Install InfoCenter and migrate InfoCenter configuration and data from the current environment to 8.5.1. Verify 
InfoCenter is working. Repeat this for other web applications (iConnects). Merge the installed customer UI 
components with the existing customer UI components and recompile using the new JRE and build into .war 
files. Then merge the taskconfig files and load the IM Resources and IM Library.

Finally, merge in RTE/FCK customizations into the Customer UI and Information Manager and provide 
appropriate clientlibrary.jar to consuming CL applications. See “Upgrading InfoCenter and Web Applications” 
on page 76.

Analytics Upgrade
Because of the new architecture of release 8.5 Analytics, it is impossible to upgrade the Analytics system 
from previous releases, i.e. 8.4.2.2 or earlier. If you desire access to the Analytics data and reports for the 
current system, you must keep the application running in parallel to the new Analytics application.

To upgrade to the new Analytics application, perform a new installation of Oracle Knowledge Analytics and 
complete all post installation configuration. To install the new Analytics application, see the Oracle Knowledge 
Installation Guide.

To upgrade from release 8.5.0.0 and higher, please see “Performing an In-place Upgrade” on page 100.
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6   PERFORMING THE PARALLEL UPGRADE
AnswerFlow Upgrade
You can install AnswerFlow using the Oracle Knowledge 8.5.1 installer. There is no parallel upgrade available 
for AnswerFlow.

To upgrade from release 8.5.0.0 and higher, please see “Performing an In-place Upgrade” on page 100.

Taking Production Live
After the Production environment has been sufficiently tested and ready to go into live mode you must stop 
any further Information Manager authoring, if you have not done so already. Once you stop all Information 
Manager authoring, you must copy the current IM database into the 8.5.1 production environment and run the 
IM Upgrade utility to upgrade the database. IM authoring has to be stopped until the upgrade has been 
completed and turned live. Any transactional information such as document ratings and user visits will not be 
visible while the IM database upgrade utility runs. Run full content processing with synchronization.

Shut down the current production environment. Route the production web applications to use the 8.5.1 
production environment. 

Finally, live-test the production application. 

FALLBACK PROCESS

If a critical problem occurs after cutting over to 8.5.1, you may fallback by routing the production web 
applications to use the old production environment.
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CHAPTER 2

Upgrading Intelligent Search

This chapter provides instructions to upgrade Intelligent Search to 8.5.1.

Overview of the Search Upgrade Process
The following steps must be taken to upgrade the Search installation:

1 Pre-Migration Upgrade Steps

2 Migrate the Search Dictionary

3 Migrate Custom Code

4 Migrate the Search Configuration

5 Migrate the Application Settings

6 Post Upgrade Instructions

Packaging
The upgrade package contains one utility in the Media Pack for Oracle Knowledge Intelligent Search 8.5.1:

• Search Configuration Migration utility – searchConfigUpgradeUtility-8.5.1.zip

Pre-Migration Upgrade Steps
Before you begin migrating the current installation, complete the following steps:

• Install Fresh 8.5.1

• Configure the Application Data Stores

• Configure Existing Data Sources

Install Fresh 8.5.1
Install Intelligent Search 8.5.1 following the instructions in the Oracle Knowledge 8.5.1 Installation Guide.

During the installation, when prompted to install the Dictionary, select Yes. When prompted to create the 
Application Instance, select No.
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8   CONFIGURE THE APPLICATION DATA STORES
After the installation is complete, create a Content Processing instance in the development environment 
following the instructions in the Oracle Knowledge 8.5.1 Installation Guide.

After the instance has been created and the web application has been built and deployed, set the 
Administrator account password following the instructions in the Oracle Knowledge 8.5.1 Installation Guide.

Configure the Application Data Stores
With your Database Management System tool, create a new schema to be used as the new Content Store. 

Following the instructions in the Oracle Knowledge 8.5.1 Installation Guide, configure the Application Data 
Stores:

1 Configure the Content Store Data Source to point to the newly created database schema. 

2 Configure the Quality Monitor Data Source to point to the previous installation’s Quality Monitor 
database schema.

Note:   You should restart your browser when switching between viewing the old installation’s web 
application and the new installation as all browser cookies must be deleted. If you still encounter errors, 
manually delete the browser cookies.

After the data stores have been configured, use the Common Environment to create the Content Store. To 
create the content store database tables, enter the following command from the Common Environment 
command line prompt:

On Linux:

createContentStore.sh

On Windows:

createContentStore.bat

Configure Existing Data Sources
Follow the instructions below to configure the other pre-existing data sources in the 8.5.1 installation 
environment. These other data sources may be used with the Information Manager settings, database 
crawlers, or custom crawlers. It is important to configure these data sources before migrating the Search 
Configuration, since the configuration may depend on the data sources.

1 Launch the pre-8.5.1 and 8.5.1 System Manager in two separate browser windows or tabs (to avoid 
overlapping cookie issues) and log in both.

2 In both windows, open the Advanced Config window.

3 In both Advanced Config windows, navigate to the Data Sources List. One method of doing this is:

a Click Crawler Settings.

b Click Edit, under Database Crawlers.

c Click Add New Item.

d Click Edit List for the Data Source.

4 In the pre-8.5.1 Advance Config window, click each non-sample data source in the list to view the data 
source properties.
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9   PREPARATION BEFORE EXPORTING
5 In the 8.5.1 Advanced Config window, click Add New Item and add a new data source for each 
existing one and enter the exact match of the Item Name, connection information, and any additional 
properties listed. 

Note:   The Item Name must match exactly because the Search Configuration Migration Utility may migrate 
crawlers that depend on the data source Item Name.

Migrate the Search Dictionary
This section consists of following sections:

• Preparation Before Exporting

• Export Custom Dictionary Content

• Add or Enable User-Added Languages or Locales

• Import Custom Dictionary Content

Preparation Before Exporting
Perform the following prerequisites before exporting dictionary content:

• Perform Dictionary Validation 

• Commit All Dictionary Changes

• Record Domain Lists and Subject Maps in Use

Perform Dictionary Validation 

For each domain list in use, perform dictionary validation on all objects, using the “Validate Dictionary” option 
from the Tools menu. Fix all issues, e.g. concept loops and null references within custom rules and intents.

Commit All Dictionary Changes

Commit all custom dictionary changes, using the “Commit work to central repository” option from the Tools 
menu.

Record Domain Lists and Subject Maps in Use

Record the domain lists and subject maps in use. Record all domains for the domain lists in use, make sure 
the orders are kept. These objects can’t be exported and must be manually added in the 8.5.1 dictionary.

Export Custom Dictionary Content
Determine which dictionary objects should be transferred to the new dictionary. The following sections 
provide instructions to:

• Export Concepts
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10   EXPORT CUSTOM DICTIONARY CONTENT
• Export Process Wizards

• Export All Other Dictionary Objects

Export Concepts

Find the concepts that have been either created or modified for the installation by searching on author or last 
edit date. This assures that any installed concepts which were later modified are migrated to the new 
installation. Do not attempt to export all of the concepts in the dictionary.

Note:   Some concepts may not have an edit date. To make sure that you get all desired concepts, search 
on (1) last edit date, (2) custom author, and (3) custom concept domain name.

After you have identified the desired concepts:

1 Select all in the find results.

2 Right-click, and select Export. 

Note:   If there are objects other than concepts in your find results, the Export option does not appear in 
the context menu.

3 Save the files to a folder. 

If you have multiple exports, you can export to the same folder, and choose to merge rather than 
overwrite the existing contents. You can also choose to save the log by appending it to a previous log. 
This makes it easier to track multiple exports.

Export Process Wizards

To export Process Wizards:

1 Open Process Wizard Editor.

2 Select Export Wizard or Export All Wizards under Tools. 

3 Save the files to a folder.

Export All Other Dictionary Objects

For all other objects, search for each of the eight types of non-concept objects one at a time, each time 
searching only for those edited after the date of the original installation. This assures that any installed objects 
which were later modified are migrated to the new installation. For each result set, determine which ones 
have been created or modified for the installation, and of that set, determine which are still actively needed for 
the new installation.

If there are installed intents or rules being used, we recommended that you do not export them, but instead 
use the 8.5.1 versions of these. Most of these have been improved by changing the IML to be language-
neutral and by retesting their accuracy. Also, be aware that many installed search component rules have 
been removed because they were found to not consistently improve search results. Some of those may have 
been modified in your installation, but you may find that you no longer need them.
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After you determine which of the objects in the result set you want to export, select them, right-click, and 
choose Export. Export each of the result sets to the same directory. Objects are stored in subdirectories as 
follows:

Add or Enable User-Added Languages or Locales
If your current installation has user–added languages or locales, you must add these languages or locales 
using System Manager.

Note:   This section is applicable only to installations with user-added languages or locales.

To add or enable languages and locales:

1 Log in System Manager as Administrator/Administrator.

You will be asked to change your password through Language Workbench.

2 Select the Languages tab in System Manager.

3 Select the language you want to enable

- or -

add a language that is not preconfigured in the Languages tab.

a Select New.

b Provide the Language Display Name and the Language Code.

4 Click Save.

Important!   Once enabled, languages or locales cannot be disabled.

Import Custom Dictionary Content
Important!   If your pre-8.5.1 install has user-added languages or locales named differently from 8.5.1, you 
need to edit the exported files before importing. Please back up all exported files before editing.

In Release 8.5.1, the naming convention is defined by language name followed by region name. For example, 
en-AR is named Spanish Argentina. If your pre-8.5.1 installation named en-AR as Argentinian 
Spanish, you must edit the exported files to change them to Spanish Argentina. 

Note:   It is not necessary to edit the names of British English, Simplified Chinese, or 
Taiwanese Chinese, they are imported to the 8.5.1 Dictionary as English Great Britain, Chinese 
Simplified, and Chinese Traditional respectively, as this is an Oracle Knowledge installed name 
change. 

• ALIAS_LIST: Alias Lists • INTENT: Intents

• ANSWER: Intent Responses • PROFILE: User Profiles

• EXCEPTION_LIST: Stemmer Exception Lists • RULE: Rules

• HIERARCHY: Intent Hierarchies • SPELLCHECK_LIST: Spellcheck List

Note: If the same object is exported twice, it overwrites the previous version of that object.
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Import Users

To import users:

1 Copy <PRE_8.5.1_INSTALL_HOME>\instances\<SCHEDULER_INSTANCE>\development 
\content\applications\default\userdata\users\_META_USER\user directory to a 
location accessible by the 8.5.1 installation and rename user to USER.

2 Delete the files named Administrator and im_synch if they exist in the user directory.

3 Rename the rest of the files in the user directory by adding .xml to the file names.

4 Log in to Language Workbench as Administrator/Administrator.

You will be asked to change your password if this is the first time accessing Language Workbench.

5 Choose Import Dictionary Objects under Tools.

6 Browse to the parent directory of the USER directory copied in step 1.

7 Select Import.

Note:   If you wish to search on these objects by author in the 8.5.1 dictionary, you must add those users. 
For this reason, you want to keep users who have edited objects even if they are no longer using the 
Language Workbench.

Import US City Concepts (Optional)

If your installation requires the set of approximately 23,000 US city concepts, import these to 8.5.1 at this 
time. 

1 Choose Import Ontology Objects from the Tools menu. 

2 Browse to the following directory:

<8.5.1_INSTALL_HOME>\resources\Dictionary_Import_Files\US_City_Concept_Import

3 Select Import.

Recreate Custom Domains, Domain Lists, And Subject Maps

Go through the domain lists and subject maps you recorded in the Record Domain Lists and Subject Maps 
in Use step. If they exist in the 8.5.1 Dictionary, verify that the domains included in these domain lists are 
identical with your pre-8.5.1 Dictionary. Make changes if necessary. If they do not exist in the 8.5.1 Dictionary, 
You must recreate them manually. 

Import Concepts

Exporting the concepts generates three files: concepts.csv, synsets.csv, and clusters.csv. If you have multiple 
sets of concept files to import, you may import them one at a time, or you may combine the files before import.

When you first import your concept files, you might find that some adjustments need to be made. Therefore 
the first iterations of the concept import are test runs. 
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To import the concept files:

1 Choose Import Ontology Objects from the Tools menu of the Dictionary Manager.

2 Browse to the directory containing the files.

The first dialog screen asks if you only want to check for errors, rather than doing a complete import. 

3 Select Yes.

The test run generates log messages which may help you decide whether you need to make adjustments to 
your import files. For example, if your import file contains a concept that exists in the 8.5.1 Dictionary, you will 
see the following message:

Concept 'test' exists; the imported concept may replace the existing concept, 
be merged with it, be ignored, or be renamed

After you have finalized your import files, you may conduct the actual import. You must choose how to handle 
any concepts which were found to already exist in the 8.5.1 Dictionary. You are asked to either (1) ignore the 
concept in the import file, (2) replace the concept in the dictionary with the one in the import file, (3) add a 
suffix to the name of the concept being imported to differentiate it from the one in the dictionary, or (4) merge 
the two concepts.

The best choice is usually to merge the existing concepts. After the import is done, you have a chance to 
compare the installed 8.5.1 version with your imported concepts. 

Before committing changes:

1 Identify the concepts which have been changed.

2 Right-click on the find results.

3 Select Diff from the menu. 

This gives you a side by side comparison with the differences highlighted. You can then choose to 
revert to the installed 8.5.1 version or make any other desired changes.

Note:   If your import files contain synonyms in British English, Simplified Chinese, or Taiwanese Chinese, 
they are imported to the 8.5.1 Dictionary as synonyms in English Great Britain, Chinese Simplified, and 
Chinese Traditional, respectively.

Backing Out of a Concept Import

If, at any point during the concept import, you decide that you need to start over, do the following: 

1 Find all of the concepts last edited on today’s date. 

2 Select all concepts in the find results.

3 Right click, and choose Revert.

This resets the dictionary to its original state, and you can start the concept import over from the beginning.

First Dictionary Validation

Run dictionary validation from the Tools menu. For each of the domain list(s) you intend to use, check the 
Concepts, Clusters, and Synsets boxes. Make sure that no issues have been introduced. You may need to fix 
issues in the import files, back out your changes, and reimport, as described in Backing Out of a Concept 
Import.
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Commit Concepts Import

Commit imported concept changes, using the Commit work to central repository option from the Tools 
menu.

Import Process Wizards

To import Process Wizards:

1 Choose Import Process Wizards from the Tools menu.

2 Browse to the directory where you saved the Process Wizard export files. 

3 Select Import.

Import All Other Dictionary Objects

Select Import Dictionary Objects from the Tools menu to import all other dictionary objects. 

As with the concept import, the first import of the non-ontology objects should be done in test-only mode. This 
gives you a chance to fix any errors, and add any further concepts to the dictionary should they be needed.

After you are able to validate the non-ontology import files without any errors, you may go ahead with the 
actual import.

Second Dictionary Validation

Choose the domain list(s) that contain the imported objects and run dictionary validation. Fix any issues 
found.

Commit Dictionary Import

Commit imported dictionary changes, using the Commit work to central repository option from the Tools 
menu.

Import Taxonomy

1 Choose Import Taxonomies under Tools.

2 Browse to the following file:

<Pre_8.5.1_INSTALL_HOME>\instances\<SCHEDULER_INSTANCE>\<ENVIRONMENT_ROLE>\
content\applications\default\navigation\runtime\Default\revision\<LATEST_RE
VISION_NUMBER>\taxonomy.xml

3 Select Import to import from your pre-8.5 installation.
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Migrate Custom Code
This section describes how to migrate any custom Java classes implemented in your previous installed 
release of Intelligent Search to the freshly installed release 8.5.1 Intelligent Search.

You must recompile the source code of your custom implementations of Crawlers, Document Preprocessors, 
Tasks, Authenticators, and Handlers with the freshly installed release 8.5.1 interface jar files in the class path 
and the previously installed release jar files removed from the class path. 

All jars containing the interfaces can be found within the following directory:

<8.5.1 INSTALL DIR>/inquira/lib/

After your custom code has been compiled against the freshly installed release 8.5.1 Intelligent Search APIs, 
rebuild the jar file(s) that contain your custom class files.

To configure the freshly installed Intelligent Search to use your custom code, copy the newly rebuilt jar file(s) 
to the following directories:

<8.5.1 INSTALL DIR>/lib

For the Content Processing instance you created in your freshly installed release 8.5.1 Intelligent Search 
environment, shut down the instance if it was running and exit any open Common Environment command line 
prompts. Open a new Common Environment command line prompt and follow the instructions to build the 
web application (buildWebApp) with your newly rebuilt .jar file(s) and deploy the modified web application 
(deployApp).

The freshly installed release 8.5.1 Intelligent Search will be configured to use your custom code following the 
steps outlined in the “Migrate the Search Configuration” and “Migrate the Application Settings” sections 
below.

Migrate the Search Configuration
This section provides an overview of the Search Configuration Migration utility and the execution steps.

Overview of the Utility Process

The utility must be executed within the Common Environment of the 8.5.1 installation. This is so that utility 
can have access to the environment’s configuration.

Before the utility can be executed, you must save the in-memory configuration to the n.xml file (where n is 
{1, 2, 3…}) in the pre-8.5.1 environment so that you can provide the n.xml as the source of truth of the 
latest configuration settings. Afterwards, you must provide the latest n.xml from the pre-8.5.1 environment to 
the utility.

The utility analyzes certain configuration elements within the Pre-8.5.1 n.xml, determine if the elements are 
user added or customized, and export them for migration. These elements include reject patterns, URL 
builders, filters, collections, crawlers, email notifications, tasks, jobs, and handlers. The elements are not 
exported if they have been discontinued in 8.5.1. The utility generates an autoimport.xml file that is used 
to synchronize the exported configuration elements with the latest n.xml file in the 8.5.1 installation.
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Running the Search Configuration Migration Utility

Before you begin the Search Configuration migration steps, shutdown the 8.5.1 environment Content 
Processing instance if it is running. Extract the searchConfigUpgradeUtility-8.5.1.zip file into a 
temporary directory on the machine hosting the 8.5.1 environment. This temporary directory is referred to as 
<TMP> in the following instructions.

To run the migration utility:

1 Log into the System Manager of the Pre-8.5.1 environment and open the Advanced Config window.

2 Select Custom Config.

3 Select Edit.

4 Select Add New Item, provide 8.5.1_Upgrade as the Item Name and select OK.

5 Select to delete the newly added Configuration Item and select OK.

6 Select Save and select Exit Configuration to close the Advanced Config window.

7 Now that memory configuration has been pushed to the file system, locate the n.xml in your pre-8.5.1 
environment, where n is the highest number available. It can be found in the following location:

<Pre-8.5.1 INSTALL DIR>/INSTANCES/<CONTENT_PROCESSING_INSTANCE>/
development/<INSTANCE_ROLE>/data/config/default

where CONTENT_PROCESSING_INSTANCE refers to the Content Processing instance name and 
INSTANCE_ROLE refers to the instance role in your Pre-8.5.1 development environment. The default 
instance role for Content Processing instances is content.

8 Copy the located n.xml into the <TMP> directory where the utility was extracted in your 8.5.1 
environment.

9 Open the Common Environment command line prompt from the 8.5.1 installation’s Content 
Processing instance.

10 Change the directory to the <TMP> directory.

11 On Linux or Solaris, change the file permission of the search_config_upgrade.sh script to make it 
executable:

chmod 750 *.sh

12 Execute the Search Configuration Migration script:

On Linux and Solaris: search_config_upgrade.sh

On Windows: search_config_upgrade.bat

13 The utility prompts you to specify the full path to the n.xml that you copied to the <TMP> directory from 
your pre-8.5.1 environment.

If the utility determines the n.xml file is a valid Search Configuration file, the utility proceeds with the 
analysis and export of the configuration elements. The utility generates the following file:

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/autoimport.xml;  
where INSTANCE is the Content Processing instance name.

The Search Configuration Migration utility informs you of the actions being taken along the way on the 
command line prompt. This information can also be found in a detailed log file in the following location:

<8.5.1 INSTALL DIR>/logs/UPGRADE/<INSTANCE>/search_config_upgrade_MM-dd-
yyyy-HHmmss.log; where INSTANCE is the Content Processing instance name.
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After the utility has finished executing, perform the following steps to complete the migration process.

14 Exit the Common Environment command line prompt.

15 Open a new Common Environment command line prompt to initiate the importing of the exported 
configuration elements from the generated autoimport.xml file.

16 Validate the migrated configuration by executing the following command:

On Linux: validateConfig.sh

On Windows: validateConfig

Important!   If the validation yields any errors, contact Oracle Customer Support.

17 Review the log file to assess which elements were exported for migration and why other elements 
were ignored.

Migrate the Application Settings
Because the Search Configuration Migration utility only merges certain configuration settings, you must use 
the System Manager’s Advanced Config functionality to migrate the remaining configuration settings. 

Use the following instructions to migrate only the settings not migrated by the Search Configuration Migration 
utility; the covered configuration settings were listed in the “Migrate the Search Configuration” section.

1 Launch the pre-8.5.1 and 8.5.1 System Manager in two separate browser windows or tabs (to avoid 
overlapping cookie issues) and log in on both.

2 In both windows, open the Advanced Config window.

3 Review each setting that was changed in the pre-8.5.1 release (while ignoring the settings affected by 
the migration utility) and make the same change in the 8.5.1 release.

4 Save any configuration changes.

After the settings available through Advanced Config have been migrated, you must manually verify that all 
remaining settings not available for configuration through the UI are migrated. Create a backup of the latest 
n.xml in your Content Processing instance in your 8.5.1 environment (where n is in {1, 2, 3…}). Perform a 
manual file comparison of the latest n.xml in your 8.5.1 environment and the n.xml that was used as the 
source of the pre-8.5.1 environment’s configuration in the Migrate the Search Configuration section. 
Determine if any remaining settings should be configured on the 8.5.1 release and manually add them.

After all the settings have been migrated, exit any open Common Environment command line prompts and 
open a new Common Environment command line prompt. Validate the configuration by executing the 
following command:

On Linux: validateConfig.sh

On Windows: validateConfig

Resolve any errors that the validation yields or revert to your backup n.xml file.
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Post Upgrade Instructions
After the migration steps have been completed, complete the following steps to finish the upgrade:

1 Create the desired instances within the 8.5.1 environment using the createApp utility. Follow the 
instructions in the Oracle Knowledge 8.5.1 Installation Guide, Installing Oracle Knowledge Intelligent 
Search, “Configuring Application Remote Clients and Data Stores”. This includes building and 
deploying the web app (buildWebapp.{sh|bat} and deployApp.{sh|bat}); Be sure to specify 
the existing Content Processing instance but specify not to install it. 

2 Propagate the configuration into your staging and production environments after they are created as 
opposed to repeating the entire upgrade process in your staging and production environments. Make 
certain that when you propagate the configuration that all custom ..jar files are copied from your 
existing environment to the <8.5.1 INSTALL DIR>/lib directory of the newly created staging and 
production environments.

3 Start Content Processing using Full Document Conversion and Full Index.

Important!   The first time you conduct Content Processing after the upgrade, you must run Full 
Document Conversion and Full Index.
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CHAPTER 3

Upgrading Information Manager 

This chapter provides instructions for upgrading Information Manager. You can upgrade Information Manager 
using either a parallel upgrade process or an in-place upgrade process. Both processes include steps to:

• upgrade the Information Manager database

• migrate your application-specific information and settings

Important!   You should always make a backup copy of the Content Resource Mount point before you 
upgrade Information Manager. 

Upgrading the Information Manager Database
You upgrade the Information Manager database using one of the following processes, depending on whether 
you are performing a parallel upgrade or an in-place upgrade.

1 Analyze the database to identify users having the same or missing login information and/or email 
addresses using the Duplicate User Information Utility and resolve any duplicates, as described in 
“Resolving Duplicate and Missing User Information” on page 20

2 Create a copy or backup of the database:

a For parallel upgrades, create a copy of the database, as described in “Creating the Database Copy 
for a Parallel Upgrade” on page 27 

b For in-place upgrades, or applying a patch, create a backup of the database as described in “Backing 
Up the Database for an In-Place Upgrade or when Applying a Patch” on page 28

3 Configure an instance of the current Information Manager release to database you are upgrading:

a For parallel upgrades, install the new release of Information Manager, and configure it to use the 
copied database as described in “Installing the New Information Manager Software for a Parallel 
Upgrade” on page 27

b For in-place upgrades, upgrade the Information Manager software as described in “Performing an In-
place Upgrade” on page 92

c If you are applying a patch, follow the patch README instructions to apply the software changes to 
the Information Manager installation

4 Analyze the database for duplicate content text records, and resolve any duplicate records using the 
Database Upgrade utility and the resolution process described in “Identifying and Resolving Duplicate 
Content Text Records” on page 30

5 Execute the pre-data migration SQL scripts, the data migration classes, and the post-data migration 
SQL scripts for each release until the database schema and data matches the 8.5.1 database model.
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Information Manager Upgrade Utilities
The Oracle Knowledge 8.5.1 Media Pack includes the following Information Manager upgrade utilities:

Resolving Duplicate and Missing User Information
In Release 8.5.1, Information Manager no longer permits certain conditions within the database that could 
exist in previous releases, including:

• users that are missing a user ID (login)

• multiple users that have the same user ID (login)

• users that are missing an email address

• multiple users that have the same email address

If users have null or duplicate login information, the application cannot reliably identify users and record their 
activity when using the application. If users have null or duplicate email addresses, the new password reset 
function cannot reliably send the password reset email only to the requesting user; it may send the reset 
password email to users who did not request it

Release 8.5.1 enforces unique user login information and email addresses, to ensure that:

• every user has a unique login

• every user has a unique email address

When you upgrade to Release 8.5.1, you must resolve any null or duplicate login or email information prior to 
upgrading the database. 

Important!   If you are performing a parallel upgrade process, ensure that you create the parallel upgrade 
and backup copies of the database only after you resolve duplicate user information. 

Using the Duplicate User Information Utility
You can use the Duplicate User Information utility to resolve null or duplicate login or email information. The 
Duplicate User Information utility analyzes all of the Information Manager database user information to 
identify users having null or duplicate login or email information. The utility also applies database level non-
null and unique constraints on login information and email addresses to ensure that null and duplicate data 
are not created in the future. 

Note:   You can use the Duplicate User Information utility independent of the upgrade process.

You use the utility by:

• running the utility on your existing database, prior to performing upgrade, to determine whether duplicate 
user information exists

• using the reports that the utility generates in Read Only mode to determine whether to resolve null and 
duplicate user information automatically or manually

Utility File Name

Database Upgrade utility im_database_upgrade-8.5.1.zip

Duplicate User Information utility dup_login_email_utility.zip
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Note:   You can use the Duplicate User Information utility independent of the upgrade process. See “Using 
the Duplicate User Information Utility” on page 20 for information on how Read Only mode and Update mode 
operate before using the utility.

Duplicate User Information Utility Operation
You can use the Duplicate User Information utility in Read Only mode or Update mode.

Setting the Duplicate User Information Utility Operating Mode
You set the mode of the Duplicate User Information utility using the -dryrun command line argument in the 
format:
dup_login_email_utility.sh -im_home=<full path to IM configuration files> -dry-
run=<true | false>

The default value of the dryrun argument is true; if you do not specify the dryrun argument, the Duplicate 
User Information utility will operate in Read Only mode.

Running the Duplicate User Information Utility in Read Only Mode
You can run the Duplicate User Information utility in Read Only mode to determine whether null and duplicate 
logins and email addresses exist in the database.

1 Extract the dup_login_email_utility.zip file into a temporary directory <TEMP>

2 Open an ICE command window in either the original (pre-8.5.1) instance or in the parallel upgrade 
instance:

setenv.sh / .bat

In... The utility...

Read Only mode... • analyzes all of the user information in the database
• generates reports of null and duplicate login information and email 

addresses
• does not modify the database

The utility operates in Read Only mode by default. You can run the 
utility in Read Only mode in releases 8.5, as well as earlier and later 
releases.

Note: You do not need to stop the Information Manager application to 
run the duplicate user information utility; the utility does not modify the 
database.

Update mode... • automatically updates the database to resolve null and duplicate 
login information and email addresses

• generates reports listing the affected users and the missing or 
duplicate information for each

See “Automatically Resolving Null and Duplicate User Information” on 
page 24

true sets the utility to execute in Read Only mode

false sets the utility to execute in Update mode
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3 Change to the <TEMP> directory.

4 On Linux or Solaris, change the file permission of the dup_login_email_utility.sh script to 
make it executable:

chmod 750 *.sh

5 Execute the script and supply the im_home argument:

a (Linux and Solaris) dup_login_email_utility.sh -im_home=<full path to IM 
configuration files>

b (Windows) dup_login_email_utility.bat "-im_home=<full path to IM 
configuration files>"

Note:   The full path to the IM configuration files in these instructions refers to $INQUIRA_ROOT/
InfoManager after an initial installation.

DUPLICATE USER INFORMATION UTILITY READ ONLY MODE OUTPUT

The Duplicate User Information utility informs you of whether it has identified null or duplicate logins or email 
addresses, and lists the location of each report that it produces. The following is a sample message:

[23 Jan 2014 13:23:40,876] - [INFO]: Supplied value of dryrun=true, Null login/
email and duplicates login/email will  NOT  be fixed!
[23 Jan 2014 13:23:40,877] - [INFO]: About to perform analysis: DetectAndCleanDu-
pLoginAndEmail
[23 Jan 2014 13:23:41,544] - [INFO]: There are 8 null logins and 9 null emails. A 
report has been generated and saved to /home/username/Oracle/Knowledge/IM/InfoMan-
ager/logs/UPGRADE/Reports/NullLoginsEmails_1390501421394.xls
[23 Jan 2014 13:23:41,615] - [INFO]: DetectAndCleanDupLoginAndEmail: Null Logins 
Count:8, Null Emails Count:9, Null logins and Null Emails will NOT be fixed as per 
request!
[23 Jan 2014 13:23:41,689] - [INFO]: There are duplicate login/email.  A report has 
been generated and saved to /home/username/Oracle/Knowledge/IM/InfoManager/logs/
UPGRADE/Reports/DuplicateLoginAndEmails_1390501421675.xls
[23 Jan 2014 13:23:41,756] - [INFO]: DetectAndCleanDupLoginAndEmail: Duplicates 
Count:38, Duplicate logins and emails will NOT be fixed as per request!
[23 Jan 2014 13:23:41,774] - [INFO]: Summary:Duplicate login/emails found. Count:38

You can use the reports to review null and duplicate user information and evaluate the changes that the utility 
will make when run Update mode, as described in “Using the Duplicate User Information Reports” on 
page 22.

Using the Duplicate User Information Reports
The Duplicate User Information utility generates reports on users having null or duplicate logins or email 
addresses. It generates the reports in either .xls or .csv spreadsheet format, and places the reports in the 
following location:
<INSTALL DIR>/InfoManager/logs/UPGRADE/Reports/

Report Type File Name

Null User Information NullLoginsEmails_<datetime>.<file_extension>

Duplicate User Information DuplicateLoginAndEmails_<datetime>.<file_extension>
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The reports list the following information for each user: 

• Unique Record ID

• Date Added

• Date Modified

• Repository

• First Name

• Last Name

• User ID (login)

• Will User ID Be Modified?

• Email

• Will Email Be Modified?

• Active Flag

• Is Active (Active, Inactive, Locked, Imported)

• User Type Flag

• User Type (Console, Web, or Super User)

The Duplicate User Information Report also includes the following fields:

• User ID Order# 

• Email Order# 

The report columns Will User ID Be Modified? and Will Email Be Modified? indicate the action that the utility 
will take when operating in Update mode:

The Is Active column indicates whether the user can log into the account (Active) or not (Inactive), is locked out 
pending an administrator reset (Locked) or has been Imported using the User Import feature.

The User ID Order# and Email Order# fields indicate the order of priority of each user's login and/or email 
address within a set of duplicates.

Resolving Null and Duplicate User Information
You must resolve any null or duplicate user information before continuing with the database upgrade. Each 
user must have a unique login and email address. 

Important!   The Database Upgrade utility checks for null and duplicate user information and will not 
complete the upgrade if any exist.

You can use either of the following methods to resolve duplicate user information:

Yes indicates that the utility will change the login and/or email 
address for this user

No indicates that the utility will preserve the login and/or email 
address for this user
UPGRADING ORACLE KNOWLEDGE



24   UPGRADING THE INFORMATION MANAGER DATABASE
Automatically Resolving Null and Duplicate User Information
You can run the Duplicate User Information utility in Update mode to automatically resolve null and duplicate 
user information from the database.

Important!   You must stop the Information Manager application to run the duplicate email address utility in 
Update mode; the utility modifies user information in the database.

In Update mode, the utility analyzes the database and automatically updates duplicate user information:

You can manually correct the modified information to conform to your organization's requirements using the 
IM Console as an Administrator.

Running the Duplicate User Information Utility in Update Mode
To run the Duplicate User Information Utility in Update mode:

1 Extract the dup_login_email_utility.zip file into a temporary directory <TEMP>

2 Open an ICE command window in the parallel upgrade installation:

setenv.sh / .bat

3 Change the directory into the <TMP> directory.

4 On Linux or Solaris, change the file permission of the dup_login_email_utility.sh script to 
make it executable:

Automatic Resolution You can run the utility in Update mode to automatically update 
duplicate user information and email addresses, then later manually 
correct the modified information to conform to your organization’s 
requirements, as described in “Automatically Resolving Null and 
Duplicate User Information” on page 24

Manual Resolution You can log into the IM Console to manually update the users and 
email addresses that are identified as requiring resolution in the 
generated report, as described in “Manually Resolving Duplicate and 
Missing User Information” on page 26.

If the utility identifies... Then it...

users sharing the same login 
information or email addresses

• automatically determines which instance among each set 
of duplicates to preserve, and changes all but that instance 
using a pre-set patter to rename the user logins and/or 
email addresses as described in “Automatically Resolving 
Null and Duplicate User Information” on page 24.

• generates a report of all the updated user information, 
including the corresponding new values generates a report 
and notifies you of the location of the report on the screen

users that have no login or email 
address information

• automatically populates the null user logins and null user 
email addresses using a pre-set pattern as described in 
“Automatically Resolving Null and Duplicate User 
Information” on page 24.

• generates a report of all the updated user information, 
including the corresponding new values generates a report 
and notifies you of the location of the report on the screen
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chmod 750 *.sh

5 Execute the script and supply the im_home and dryrun arguments:

a (Linux and Solaris) dup_login_email_utility.sh -im_home=<full path to IM 
configuration files> -dryrun=false

b (Windows) dup_login_email_utility.bat "-im_home=<full path to IM 
configuration files>" “-dryrun=false”

Note:   The full path to the IM configuration files in these instructions refers to $INQUIRA_ROOT/
InfoManager after an initial installation.

DUPLICATE USER INFORMATION UTILITY UPGRADE MODE OUTPUT

The Duplicate User Information utility informs you of whether it has updated null or duplicate logins or email 
addresses, and lists the location of each report that it produces. The following is a sample message:

[09 Dec 2013 20:59:31,494] - [INFO]: Supplied value of dryrun=false, Duplicates 
login/email will  be fixed! 
[09 Dec 2013 20:59:31,495] - [INFO]: About to perform analysis: DetectAndCleanDu-
pLoginAndEmail 
[09 Dec 2013 20:59:32,048] - [INFO]: There are duplicate login/email.  A report has 
been generated and saved to /home/username/IM_HOME/InQuira_8.1.2.5/InfoManager/
logs/UPGRADE/Reports/DuplicateLoginAndEmails_1386640771940.xls 
[09 Dec 2013 20:59:32,111] - [INFO]: DetectAndCleanDupLoginAndEmail: Duplicates 
Count:31, Duplicate logins and emails will be fixed as per request! 
[09 Dec 2013 20:59:32,112] - [INFO]: Cleaning up any previous execution's arti-
facts. 
[09 Dec 2013 20:59:32,347] - [INFO]: Successfully removed duplicate logins/emails 
from USERINFORMATION table: Both login and email fixed:10, Only Login Fixed: 4, 
Only Email Fixed: 10 
[09 Dec 2013 20:59:32,371] - [INFO]: Number of Errored duplicates:0 
[09 Dec 2013 20:59:32,425] - [INFO]: Number of fixedDuplicates found for the Fixed 
Report:31 
[09 Dec 2013 20:59:32,466] - [INFO]: For the fixed duplicate login/email,  a fixed 
report has been generated and saved to /home/username/IM_HOME/InQuira_8.1.2.5/In-
foManager/logs/UPGRADE/Reports/FixedDuplicateLoginAndEmails_1386640772438.xls 

You can use the reports to review null and duplicate user information and evaluate the changes that the utility 
will make when run Update mode, as described in “Using the Fixed Null and Duplicate User Information 
Reports” on page 25.

Using the Fixed Null and Duplicate User Information Reports
The Duplicate User Information utility generates reports on users having null or duplicate logins or email 
addresses. It generates the reports in either .xls or .csv spreadsheet format, and places the reports in the 
following location:
<INSTALL DIR>/InfoManager/logs/UPGRADE/Reports/

Report Type File Name

Null User Information NullLoginsEmails_<datetime>.<file_extension>

Duplicate User Information DuplicateLoginAndEmails_<datetime>.<file_extension>
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If the utility detects users having null or duplicate logins or email addresses, it generates the following reports:

You can review the "Was User ID Modified?" and "Was Email Modified?" columns of the Fixed Duplicate User 
Information and Fixed Null User Information reports to identify the modified logins and email addresses. The 
utility modifies login information and email addresses as follows:

You can manually correct the modified information to conform to your organization's requirements using the 
IM Console as an Administrator.

Manually Resolving Duplicate and Missing User Information
You can manually resolve duplicate and missing user information as an alternative to running the Duplicate 
User Information script in Update mode. To manually resolve duplicate user information:

• log into the management console of the pre-8.5.1 instance as an Administrator having one of the 
following Security Roles:

You can assign new login information and email addresses or de-activate affected users by changing their 
status to Inactive.

Important!   Do not delete users as part of this process. Deleting a user may jeopardize the integrity of the 
data associated with the user (i.e. documents, recommendations, discussion posts, etc). 

Every user, including Inactive users, must have unique login information and a unique email address. You can 
assign fake email addresses (such as john.doe@junkmail.com) to users; however, you must use the 
standard email address format.

When you have resolved all duplicate and missing login information and email addresses, validate the 
process by running the Duplicate User Information utility again. The database upgrade utility checks for 

Report Type Report Description

Fixed Null User 
Information

FixedNullLoginsEmails_ 
<datetime>.<file_extensi
on>

lists only the user logins and emails that were 
updated and their new values when the utility was 
run in Update mode.

Fixed Duplicate User 
Information

FixedDuplicateLoginAnd
Emails_<datetime>.<file_
extension>

lists only the user logins and emails that were 
updated and their new values when the utility was 
run in Update mode.

Information Type Modified Format

duplicate login ok_dup_<original_login>_<random_guid>

null login <random_guid>

duplicate email address ok_dup_<random_guid>_<original_email>

null email address <random_guid>

Security Role Description

Default Administrator can perform any action within the repository in which the user 
was created, and can log into only that repository

Super Admin can perform any action on any repository

Super Support can perform any action on any repository
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missing and duplicate logins and email addresses, and will terminate the upgrade process if it encounters 
any. Run the utility as many times as necessary to ensure that the database contains no missing or duplicate 
user information or email addresses.

The utility also applies database level non-null and unique constraints on login information and email 
addresses to ensure that null and duplicate data are not created in the future. 

Important!   You can use the Duplicate User Information utility independent of the upgrade process.

We recommend that you run the utility to identify and resolve any null or duplicate logins and email addresses 
as soon as possible, so that the constraints are applied and your application is protected from issues that may 
arise from duplicate data.

Creating the Database Copy for a Parallel Upgrade
Create a new copy of the existing Information Manager database. Do not use a backup copy that you created 
earlier. Place this copy into the directory that you will use for the upgraded Information Manager application. 
When you install the new Information Manager, you will configure it to use this copied database.

Installing the New Information Manager Software for a 
Parallel Upgrade
Install Information Manager 8.5.1 by following the instructions in Installing Oracle Knowledge, Release 8.5.1.

Important!   Specify the following values during the installation process:

• When the installation process prompts you for the Information Manager Database connection 
information, enter the information corresponding to the database copy that you created for the upgrade.

• When the installation process prompts you to specify database table creation, choose No so that the 
installation process will preserve the existing (pre-8.5.1) tables and data. 

• When the installation process prompts you for the Content Resource Mount Point, enter the actual 
location of the Content Resource Mount Point. Do not enter an empty directory, since the installation 
process may make modifications to the files stored in this location. 

Note:   If you use FTP to access content, you should point to the actual directory, since the installer must be 
able to access the files during the installation process.

When the installation process completes, the newly installed instance may start automatically, depending on 
your application server. See Installing Oracle Knowledge for more information. 

• If the instance is running, stop the instance immediately. 

Important!   Do not attempt to start or use the newly installed instance. The pre-8.5.1 database schema 
and data do not match the 8.5.1 database model.

The next steps in the upgrade process updates the tables and data in the database copy to match the 8.5.1 
database model.
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Backing Up the Database for an In-Place Upgrade or when 
Applying a Patch
If you are performing and in-place upgrade, or are applying a patch, we recommend that you create a backup 
copy of your IM database for use as a restore point if you need to roll back the upgrade or patch.

Preparing the Database for Upgrading
The Information Manager database’s DBVIEWCOUNT table includes the DATEOFCOUNT column. If the version 
of the database that you are using does not include this column, you must add the column prior to running the 
database upgrade utility.

You can check that the DBVIEWCOUNT table has the DATEOFCOUNT column by executing the following 
statement on the database schema:

If the above statement yields a count of 1, proceed with the upgrade. If the statement yields a count of 0, 
execute the following SQL statement to add the column to the DBVIEWCOUNT table:

Running the Information Manager Database Upgrade 
Utility
You run the database upgrade utility within an ICE command window in the newly installed 8.5.1 environment. 
This enables the utility to access the keystore, database information, and the content resource mount point 
that you specified during the installation process.

Important!   You must run the utility from within the ICE prompt of the newly installed 8.5.1 instance. 

Database Upgrade Process Overview
The database upgrade utility performs the following process:

• checks for multiple users having the same login information and/or email addresses

If there are multiple users having the same address, the utility issues a message and stops:

Important!   You should have resolved any duplicate email addresses using the process described in 
“Resolving Duplicate and Missing User Information” on page 20 prior to running the upgrade utility. You must 
resolve any duplicate email addresses before continuing the upgrade process.

If there are no duplicate logins or email addresses, the utility continues the upgrade process by:

Oracle SELECT COUNT(*) FROM USER_TAB_COLS WHERE TABLE_NAME='DBVIEWCOUNT' AND 
COLUMN_NAME='DATEOFCOUNT';

SQL Server SELECT COUNT(*) FROM INFORMATION_SCHEMA.COLUMNS WHERE 
TABLE_NAME='DBVIEWCOUNT' AND COLUMN_NAME='DATEOFCOUNT';

Oracle ALTER TABLE DBVIEWCOUNT ADD (DATEOFCOUNT NUMBER(7, 0) DEFAULT 0 NOT NULL);

SQL Server ALTER TABLE DBVIEWCOUNT ADD DATEOFCOUNT NUMERIC(7, 0) DEFAULT 0 NOT NULL;
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• determining whether there are duplicate content text records, as described in “Identifying and Resolving 
Duplicate Content Text Records” on page 30

Previous releases may have created duplicate content text records in error. You must resolve any duplicate 
content text records before continuing the upgrade process. When you have resolved any duplicate content 
text records, you can continue the upgrade process by executing the required upgrade scripts to 
incrementally update the database to the current model as described in “Executing the Upgrade Scripts” on 
page 32.

Running the IM Database Upgrade Utility
Extract the im_database_upgrade-8.5.1.zip file into a temporary directory. This temporary directory is 
referred to as <TMP> in the following instructions.

To run the upgrade process:

1 Start the ICE command window from the 8.5.1 installation.

2 Change the directory into the <TMP> directory.

3 On Linux or Solaris, change the file permission of the im_database_upgrade.sh script to make it 
executable:

chmod 750 *.sh

4 Execute the IM Database Upgrade script with no arguments:

• (Linux and Solaris) im_database_upgrade.sh

• (Windows) im_database_upgrade.bat

The utility prompts you to specify the in Megabytes. This allocates the amount of memory the upgrade 
utility uses while executing. The minimum value that you can specify is 1024; the default value is 2800.

5 Specify the Memory Allocation Pool Maximum Size, or accept the default value.

The utility begins the upgrade process by checking for duplicate content text records, and duplicate user 
information and email addresses.

6 Review the utility’s output for duplicate content records notification.

The utility checks for duplicate content text records. If the utility finds duplicate content text records, it 
generates a report and issues a message to notify you of the location of the report, for example:

[14 Feb 2013 13:45:38,966]-[INFO]: 
============================================================ 
[14 Feb 2013 13:45:38,967]-[INFO]: INFORMATION MANAGER DATABASE UPGRADE UTILITY  
[14 Feb 2013 13:45:38,968]-[INFO]: 
============================================================  
[14 Feb 2013 13:45:38,968]-[INFO]: IM_HOME folder found-/home/username/Oracle/Knowledge/IM/
InfoManager  
[14 Feb 2013 13:45:38,995]-[INFO]: Database type is Oracle  
[14 Feb 2013 13:45:40,597]-[INFO]: The target upgrade version is 8.5.1  
[14 Feb 2013 13:45:42,691]-[INFO]: The last installed version is 8.1.2.4  
[14 Feb 2013 13:45:42,703]-[INFO]: The last installation date is Feb 14, 2013 12:58 PM  
[14 Feb 2013 13:45:42,724]-[INFO]: Verifying that pre-upgrade requirements have been met.  
[14 Feb 2013 13:45:43,686]-[INFO]: Checking to see if duplicate Content Text records exist 
in the db. 
[14 Feb 2013 13:45:43,700]-[INFO]: About to perform analysis: DetectDuplicateContentTexts  
[14 Feb 2013 13:45:46,220]-[INFO]: Successfully generated report for duplicates in content 
text in /home/username/Oracle/Knowledge/IM/InfoManager/logs/UPGRADE/Reports/
DuplicateCTRowReport_1360849057.xls  
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[14 Feb 2013 13:45:46,226]-[ERROR]: FAILED: The Information Manager Database Upgrade cannot 
continue until all duplicate content text records have been resolved!

If the utility does not detect any duplicate content text records, it notifies you that there are no duplicate 
content text records and continues the upgrade process.

7 Review the utility’s output for duplicate login information and duplicate email addresses.

The utility checks for users having duplicate login information and/or email addresses. If the utility 
detects duplicates, it generates a report and notifies you of the report location.

Important!   You should have resolved any duplicate user information and email addresses using 
the process described in “Resolving Duplicate and Missing User Information” on page 20 prior to 
running the upgrade utility. You must resolve any duplicate user information and email addresses 
before continuing the upgrade process.

If the utility does not detect any duplicate email addresses, it continues the upgrade process.

8 Execute the appropriate Pre-data Migration scripts, Data Migration classes, and Post-data Migration 
scripts, depending on your current release level, as described in “Executing the Upgrade Scripts” on 
page 32.

Identifying and Resolving Duplicate Content Text Records
The upgrade utility checks for duplicate content text records. Duplicate content text records are records 
having the same CONTENTID, DOCUMENTID, LOCALEID, MAJORVERSION, and MINORVERSION 
values. If duplicate records exist, the utility generates a Duplicate Content Text Records report in spreadsheet 
format with either .xls or .csv extension.

You use the Duplicate Content Text Records report to resolve duplicate records as described in “Using the 
Duplicate Content Text Records Report” on page 30.

Using the Duplicate Content Text Records Report
You can use the Duplicate Context Record report to identify each document and its duplicate content text 
records. You use the report by:

• reviewing the Comments field for each duplicate record; the Comments field recommends which records 
to retain and which to delete

• comparing the content_*.xml files stored on the staging resource mount point to determine which 
Content Text record(s) should be deleted (the * in content_*.xml represents the Content Text record ID) 

• manually updating the report to indicate which records to remove 

• reviewing and manually annotating the report 

• running the Upgrade utility to remove the designated duplicate records 

DETERMINING WHICH CONTENT TEXT RECORDS TO RETAIN

You can determine which content text records to retain in the database by comparing the content_*.xml files.

1 Open the report to review the suggested records to retain and the full path to each content_*.xml file

If you choose to adopt the suggested deletions and retentions:
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2 Annotate and save the report as described in “Annotating the Duplicate Content Record Report” on 
page 31. 

If you need to review the duplicate content records in more detail:

1 Navigate to the Content Resource Mount Point on the file system

2 Open each content_*.xml file, where * is the document’s CONTENTTEXTID from the report, using an 
XML editor

3 Format and indent the XML for readability, and save the file

4 Use a file comparison tool to compare the content_*.xml files

5 Determine which candidate is best to retain in the system

6 Annotate the report as described in “Annotating the Duplicate Content Record Report” on page 31

7 Save the annotated report

Important!   You must save the annotated report in either .xls or .csv format.

ANNOTATING THE DUPLICATE CONTENT RECORD REPORT

You annotate the Duplicate Content Record report to designate which duplicate content records to remove, 
and use the annotated report as input to the Upgrade utility. The Upgrade utility uses the report to delete the 
content records that you have marked for removal.

For a given set of duplicate records:

• specify to preserve one record (false)

• specify to remove all duplicates of the record (true)

Important!   Do not mark all of the duplicate records to be deleted. If the utility determines that a record 
and all of its duplicates are selected for deletion, the utility will stop.

To annotate the report:

1 specify a value in the RemoveRecord column for every content record in the report

a specify a T (true) to remove the content text record

b specify an F (false) to preserve the record

RUNNING THE UPGRADE UTILITY TO REMOVE DUPLICATE CONTENT RECORDS

You remove the designated duplicate content records by running the Upgrade utility again, specifying the 
annotated report as input to the utility. The utility removes the designated records from the database.

To specify the report as input to the content deletion process:

• execute the IM Database Upgrade script, specifying the delete.from.report argument and the full 
path to the modified report file:

- (Linux and Solaris) im_database_upgrade.sh –delete.from.report=<full path to 
the modified report file>

- (Windows) im_database_upgrade.bat "-delete.from.report=<full path to the 
modified report file>"

For example, a command in a Windows environment would be similar to:
im_database_upgrade.bat "-delete.from.report=C:\Oracle\Knowledge\IM\InfoMan-
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ager\logs\UPGRADE\Reports\DuplicateCTRowReport_run1.xls"

The utility:

• removes the content text records that are marked for deletion

• performs another analysis to identify any remaining duplicate content text records

You can use the utility to perform identify and eliminate duplicate content text records over multiple iterations, 
which may be helpful if there are many duplicates.

When the utility completes an analysis and does not identify any duplicate content text records, it issues a 
message to that no duplicates were found, and continues the upgrade process without generating a report.

Executing the Upgrade Scripts
The Database Upgrade utility executes various scripts, depending upon the current release installed. The IM 
Database Upgrade utility updates the database schema and data for each release after the starting point until 
the 8.5.1 database model is matched. 

For example, if you are currently at Release 8.4.2.2, the upgrade process:

• runs all the pre-data migration SQL scripts associated with release 8.5.0.0

• runs all the data migration classes associated with release 8.5.0.0

• runs all the post-data migration SQL scripts associated with release 8.5.0.0

When these processes complete, the database is upgraded to Release 8.5.0.0, and the upgrade process:

• runs all the pre-data migration SQL scripts associated with release 8.5.1

Since there are no data migration classes or post-data migration SQL scripts associated with 8.5.1, the 
upgrade process is complete and the database schema and data match the 8.5.1 database model.

See “Information Manager Database Upgrade Scripts and Classes” on page 33for detailed lists of the pre-
data migration scripts, data migration classes, and post-data migration scripts that the utility executes as part 
of the upgrade process.

Upgrade Utility Script Notification
The IM Database Upgrade utility informs you of the actions being taken along the way on the command line 
prompt. This information can also be found in detailed log files. Detailed information for each class and script 
can be found in a specific log file and you are informed of the log file location for every execution. 

If any part of the upgrade fails, you are notified immediately and the upgrade process halts. You are then 
directed to review the detailed log file containing more information about the process that failed. You must 
address the failure, if possible, and restart the execution providing no arguments. If the failure cannot be 
addressed, contact customer support.

Here is an example excerpt from the utility’s execution:
[15 Jan 2014 19:00:17,577] - [INFO]: ============================== VERSION 8.5.1 STARTING ======================
[15 Jan 2014 19:00:18,213] - [INFO]: 
 
[15 Jan 2014 19:00:18,214] - [INFO]: Pre-migration SQL scripts starting... 
[15 Jan 2014 19:00:19,767] - [INFO]: Executing 8.5.1: SQL Script BUILD_8510.sql. 
[15 Jan 2014 19:10:26,900] - [INFO]: SUCCESS: 8.5.1 SQL Script BUILD_8510.sql completed successfully with no errors. 
Please see /home/username/Oracle/Knowledge/IM/InfoManager/logs/UPGRADE/01-15-2014_161137/8.5.1/1_pre-migration-SQL/
BUILD_8510.log for more details. 
[15 Jan 2014 19:10:28,470] - [INFO]: Executing 8.5.1: SQL Script BUILD_unique_contenttext_constraints.sql. 
[15 Jan 2014 19:11:08,762] - [INFO]: SUCCESS: 8.5.1 SQL Script BUILD_unique_contenttext_constraints.sql completed suc-
cessfully with no errors. Please see /home/username/Oracle/Knowledge/IM/InfoManager/logs/UPGRADE/01-15-2014_161137/
8.5.1/1_pre-migration-SQL/BUILD_unique_contenttext_constraints.log for more details. 
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[15 Jan 2014 19:11:10,317] - [INFO]: Executing 8.5.1: SQL Script BUILD_unique_contenttextpub_constraints.sql. 
[15 Jan 2014 19:11:12,326] - [INFO]: SUCCESS: 8.5.1 SQL Script BUILD_unique_contenttextpub_constraints.sql completed 
successfully with no errors. Please see /home/username/Oracle/Knowledge/IM/InfoManager/logs/UPGRADE/01-15-
2014_161137/8.5.1/1_pre-migration-SQL/BUILD_unique_contenttextpub_constraints.log for more details. 
[15 Jan 2014 19:11:13,886] - [INFO]: Executing 8.5.1: SQL Script BUILD_unique_userinformation_constraints.sql. 
[15 Jan 2014 19:11:15,199] - [INFO]: SUCCESS: 8.5.1 SQL Script BUILD_unique_userinformation_constraints.sql completed 
successfully with no errors. Please see /home/username/Oracle/Knowledge/IM/InfoManager/logs/UPGRADE/01-15-
2014_161137/8.5.1/1_pre-migration-SQL/BUILD_unique_userinformation_constraints.log for more details. 
[15 Jan 2014 19:11:15,200] - [INFO]: 
 
[15 Jan 2014 19:11:15,200] - [INFO]: Pre-migration SQL scripts completed. 
[15 Jan 2014 19:11:15,277] - [INFO]: 
 
[15 Jan 2014 19:11:15,277] - [INFO]: Data migration classes starting... 
[15 Jan 2014 19:11:16,102] - [INFO]: Executing 8.5.1 Data Migration Class IMCaseLinkCleanup 
[15 Jan 2014 19:11:18,259] - [INFO]: IM_HOME folder found  - /home/username/Oracle/Knowledge/IM/InfoManager
[15 Jan 2014 19:11:18,261] - [INFO]: Database type is Oracle 
[15 Jan 2014 19:11:18,362] - [INFO]: The target upgrade version is 8.5.1 
[15 Jan 2014 19:11:18,370] - [INFO]: Initializing EOFactory! 
[15 Jan 2014 19:11:18,370] - [INFO]: MultiOSC: EOFactory initialized: Not using  IQECManager.ObjectStore pooling! 
[15 Jan 2014 19:11:19,107] - [INFO]: ObjectStore Added Notification 
[15 Jan 2014 19:11:19,110] - [INFO]: ObjectStore Delegate Set to all stores 
[15 Jan 2014 19:13:03,760] - [INFO]: SUCCESS: 8.5.1 Data Migration Class IMCaseLinkCleanup completed successfully with 
no errors. Please see /home/username/Oracle/Knowledge/IM/InfoManager/logs/UPGRADE/01-15-2014_161137/8.5.1/2_data-mi-
gration-classes?IMCaseLinkCleanup.log for more details. 
[15 Jan 2014 19:13:03,760] - [INFO]: 
 
[15 Jan 2014 19:13:03,761] - [INFO]: Data migration classes completed. 
[15 Jan 2014 19:13:04,405] - [INFO]: 
 
[15 Jan 2014 19:13:04,406] - [INFO]: Post-migration SQL scripts starting... 
[15 Jan 2014 19:13:06,606] - [INFO]: Executing 8.5.1: SQL Script BUILD_8510_CaseLinkCleanup-post.sql. 
[15 Jan 2014 19:13:36,085] - [INFO]: SUCCESS: 8.5.1 SQL Script BUILD_8510_CaseLinkCleanup-post.sql completed success-
fully with no errors. Please see /home/username/Oracle/Knowledge/IM/InfoManager/logs/UPGRADE/01-15-2014_161137/8.5.1/
3_post-migration-SQL/BUILD_8510_CaseLinkCleanup-post.log for more details. 
[15 Jan 2014 19:13:37,666] - [INFO]: Executing 8.5.1: SQL Script BUILD_8510_CONTENTATTRIBUTESUMMARY.sql. 
[15 Jan 2014 19:13:44,181] - [INFO]: SUCCESS: 8.5.1 SQL Script BUILD_8510_CONTENTATTRIBUTESUMMARY.sql completed suc-
cessfully with no errors. Please see /home/username/Oracle/Knowledge/IM/InfoManager/logs/UPGRADE/01-15-2014_161137/
8.5.1/3_post-migration-SQL/BUILD_8510_CONTENTATTRIBUTESUMMARY.log for more details. 
[15 Jan 2014 19:13:44,182] - [INFO]: 
 
[15 Jan 2014 19:13:44,182] - [INFO]: Post-migration SQL scripts completed. 
[15 Jan 2014 19:13:45,173] - [INFO]: 
 
[15 Jan 2014 19:13:45,173] - [INFO]: ============================== VERSION 8.5.1 COMPLETE =======================

Note:   The console output can also be found in this log file: <8.5.1 INSTALL DIR>/InfoManager/
logs/UPGRADE/<date time>/im_database_upgrade.log.

Information Manager Database Upgrade Scripts and Classes
The following tables list all of the Pre-data Migration SQL Scripts (Table 1), Data Migration Classes (Table 2), 
and Post-data Migration SQL Scripts (Table 3) that are executed for most InQuira/Oracle Knowledge releases 
from 8.1.2.3.4 to 8.5.1.0. 

TABLE 1. Pre-data Migration SQL Scripts 

Release Script Description

8.1.2.3.4 BUILD_81234.sql Adds the LASTMODIFIEDDATE column to the 
DBTOPICMETRICS table.

8.1.2.4 BUILD_8124.sql Creates indexes on the CONTENT and 
CONTENTTEXT tables.

8.1.2.5 BUILD_8125.sql Updates the WFSTEPID column in the 
CONTENTTEXT table to have an empty string 
where the value is NULL.
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8.1.2.7 BUILD_8127.sql 1. Adds the LASTMODIFIEDDATE column to the 
CONTENTTEXT table.

2. Adds the SPELLCHECKINGSUPPORT column 
to the LOCALE table and set it to ‘N’ for all entries.

3. Adds newly supported locales: de_DE, 
fr_FR, es_ES, zh_CN, zh_TW, pt_BR, 
ko_KR, nl_NL, pl_PL, and sk_SK.

4. Turns on spell-checking support for all locales 
that support it: en_US, de_DE, fr_FR, 
es_ES, it_IT, pt_BR, en_GB, ru_RU, 
uk_UK, and nl_NL.

8.1.3.0 BUILD_8130.sql Creates the DBTOPICDATA and 
DBMESSAGEDATA tables.

BUILD_8130_populateDBTopicData.sql Populates the DBTOPICDATA table with data from 
the BODY column in the DBTOPIC table.

BUILD_8130_populateDBMessageData.sql Populates the DBMESSAGEDATA table with the 
data from the BODY column in the DBMESSAGE 
table.

8.1.3.3 BUILD_8133.sql Creates indexes on the CASELINK and 
CASELINKCONTENT tables.

8.2.0.0 BUILD_8200.sql 1. Adds the 
REPLACEMENTTEXT_NON_FORMATTED 
column to the LOCALIZEDTOKENS table.

2. Creates an index on the CONTENTTEXTPUB 
table.

3. Updates the locale table to set the 
LOCALEDESC value to Português 
Brasileiro where RECORDID is pt_BR.

4. Sets the NUMBEROFVERSIONS column to 
NULL for all rows in the CONTENTCHANNEL 
table.

8.2.0.1 BUILD_8201.sql Updates the database to support the Move Topic 
functionality.

8.4.0.0 BUILD_8400.sql Creates indexes on the CONTENT, 
CONTENTTEXT, CONTENTTEXTPUB, and 
SURVEYRESULTSDETAILS tables.

8.4.2.0 BUILD_8420.sql Updates the PUBLISHEDDATE column in all rows 
of the CONTENTTEXTPUB table where the 
PUBLISHEDDATE column is NULL to have the 
same value as DATEADDED.

BUILD_8420_unifyPublishDate.sql Updates the PUBLISHDATE column in all rows of 
the CONTENTTEXT table where PUBLISHDATE 
column is NULL and PUBLISHED column is Y to 
have the same value as the PUBLISHEDDATE 
column in the CONTENTTEXTPUB table.

TABLE 1. Pre-data Migration SQL Scripts (Continued)

Release Script Description
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8.5.0.0 BUILD_8500.sql 1. Removes anything related to the Geocode 
functionality.

2. Increases the capacity of the COUNT column of 
the CONTENTMETRICS table.

3. Updates the priority look-up codes in order for 
them to display in order in the UI.

4. Adds the data needed for the Publish channel 
privilege.

5. Adds the data needed for the Manage Analytics 
secured activity and give all Site Administrators the 
activity.

6. Adds the REPORTINGUSERGROUPID column 
to the USERINFORMATION table.

7. Adds the REFERENCEKEY column to the 
WORKFLOWSTEP table.

8. Adds the data needed for the following secured 
activities: Import Repository Data for Translation, 
Export Repository Data for Translation, Manage 
Content Batches, Configure Batch Jobs, and 
Configure Tasks and Notifications. Also, give the 
Default Administrator role those secured activities.

9. Updates Quartz-related tables in order to 
support the Quartz upgrade.

10. Adds the RETENTION column to the 
BATCHJOBS table.

11. Adds the URLTOKEN and 
URLTOKENEXPIRATION columns to the 
USERINFORMATION table.

12. Creates DBMESSAGEFILE and 
DBTOPICFILE tables.

13. Performs miscellaneous localization updates.

BUILD_8500_startEndDatesNotNull.sql Updates database to ensure that the 
DISPLAYSTARTDATE and DISPLAYENDDATE 
columns in the CONTENT, CONTENTTEXT, 
CONTENTTEXTPUB, and SURVEY tables are not 
NULL and will never be NULL.

BUILD_8500_tasksUpdate.sql 1. Updates all content expiration tasks with the 
correct ContentTexts.

2. Updates all translation tasks with correct 
ContentTexts using the 
CONTENTLOCALEREQUEST version.

3. Updates the TASKLOG table so that records are 
per-ContentText instead of per-Content for 
content expiration tasks.

4. Updates all content changed tasks with the 
correct ContentText.

BUILD_8500_GFR.sql Adds the data needed to support Global Find and 
Replace.

BUILD_8500_SDP.sql Adds the data needed to support Start Date 
Publishing.

TABLE 1. Pre-data Migration SQL Scripts (Continued)

Release Script Description
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8.5.0.0
(continued)

BUILD_8500_newLocales.sql Adds the following supported locales and their 
localized resources:  cs_CZ, da_DK, fi_FI, 
no_NO, pt_PT, sv_SE, th_TH, and 
tr_TR.

BUILD_newBulkUpdate.sql Adds the data needed to support Bulk Updates to 
Content.

BUILD_8500_contentHistoryUpdates.sql Inserts data into the CONTENTHISTORY table 
related to content locale requests.

BUILD_8500_constraintsAndIndexes.sql Adds constraints and indexes to various tables.

8.5.1.0 BUILD_8510.sql Adds the following supported locales and their 
localized resources:  ar_SA and he_IL. Updated 
translations for existing resources as needed.

8.5.1.0 BUILD_unique_contenttext_constraints.sql Adds a unique constraint on the CONTENTTEXT 
to prevent duplicate content text records. Adds a 
unique constraint on CONTENTTEXT so that only 
one version of a content can be published at a 
time.

8.5.1.0 BUILD_unique_contenttextpub_constraints.
sql

This script is for Oracle DB only. Adds a unique 
constraint on CONTENTTEXTPUB so that only 
one version of a content can be published at a 
time.

8.5.1.0 BUILD_unique_userinformation_constraints
.sql

Adds 2 different unique constraints on the USER-
INFORMATION table so that user logins and 
emails are unique per repository.

TABLE 1. Pre-data Migration SQL Scripts (Continued)

Release Script Description
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TABLE 2. Data Migration Classes 

Release Class Description

8.2.0.0 com.inquira.infomanager.migration.IM8200 For each localized token in system, saves a  
version of the replacement text without formatting.

8.5.0.0 com.inquira.infomanager.migration.IM8500 
_CheckinContentTexts

For each ContentText that is checked out and is 
not the latest version, check it back in and check 
out its latest version.

com.inquira.infomanager.migration.IM8500 
_PublishPrivilege

For each content channel, add the Publish  
privilege to the CONTENTCHANNELPRIVILEGE 
table.

com.inquira.infomanager.migration.IM8500 
_WFStepRefKeys

For each Workflow Step, creating a reference key 
based on the name in the base locale for the 
repository.

com.inquira.infomanager.migration.IM8500 
_TasksNamesUpdate

For each ContentTask-related task, update the 
task name by prepending the document ID to the 
current task's name.

com.inquira.infomanager.migration.IM8500 
_BatchJobRetention

For each current batch job, update the job with the 
correct default for its retention time.

com.inquira.infomanager.migration.IM8500 
_NewBatchJobs

For each existing repository, add the new Start-
DatePublisher, BulkUpdateJob, TrimBatchHistory 
batch jobs.

com.inquira.infomanager.migration.IM8500 
_RoleNameTranslations

For both the Default Administration and Default 
User Roles, update their display names for all 
available locales in each repository.

com.inquira.infomanager.migration.IM8500 
_DBAttachFilePrivilege

For each discussion board and discussion board 
forum in all repositories, add the Attach File  
privilege and configure accordingly.

8.5.0.0 com.inquira.infomanager.migration.IMMet-
ricsMerger

This is an Update Class to create Topic and  
Content Metrics Merger batch jobs for existing 
repositories.

com.inquira.infomanager.migration.IMUpda-
teUsers

Replaces encrypted user password values with an 
equivalent but secure one-way hashed value for all 
users.

8.5.0.0 BUILD_newBulkUpdate.sql Adds the data needed to support Bulk Updates to 
Content.

8.5.1.0 com.inquira.infomanager.data.migra-
tion.IMCaseLinkCleanup

The purpose of this class is to resolve duplicate 
and orphaned CaseLinks within each repository. 
For each repository, two CaseLinks with the same 
case number (CASEVALUE column) should not 
co-exist. CaseLinks that are not assigned to any 
document should not exist.
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Post-upgrade Requirements
When the upgrade process completes, remove the IM Database Upgrade utility from the system; a command 
line utility that can update the database and file system presents a security risk.

To delete the utility:

1 Navigate with a file browser to <TMP>.

2 Delete all the contents of the extracted im_database_upgrade-8.5.1.zip as well as the 
im_database_upgrade-8.5.1.zip itself.

TABLE 3. Post-data Migration SQL Scripts 

Release Script Description

8.1.2.4 BUILD_8124-post.sql Updates the locale table to set the LOCALE-

DESC value to Українська where RECOR-
DID is uk_UA

8.1.2.7 BUILD_8127-post.sql 1. Updates all references to old ko locale to use 
the new ko_KR locale and delete old ko locale.

2. Updates all references to old sk locale to use 
the new sk_SK locale and delete old sk locale.

8.1.3.0 BUILD_8130-post.sql 1. Drops the BODY column in the DBTOPIC 
table.

2. Drops the BODY column in the DBMESSAGE 
table.

8.5.0.0 BUILD_8500-post.sql 1. Removes Editor Groups-related tables and 
data from the database.

2. Removes Shopping Cart-related tables and 
data from the database.

3. Performs miscellaneous database updates.

BUILD_8500_SDP-post.sql 1. Deletes pending documents from the CON-
TENTTEXTPUB table.

2. Drops CONTENTTAG, CONTENTSECURI-
TYTAG, and SITECONTENT tables.

BUILD_8500_SDP_createContentSecurityTag-
post.sql

Creates the CONTENTSECURITYTAG view.

BUILD_8500_SDP_createContentTag-post.sql Creates the CONTENTTAG view.

BUILD_8500_SDP_createSiteContent-post.sql Creates the SITECONTENT view.

8.5.1.0 BUILD_8510_CaseLinkCleanup-post.sql Adds a unique constraint on CASELINK to pre-
vent case links with duplicate case numbers 
(CASEVALUE). Adds a unique constraint on 
CASELINKCONTENT to prevent the same case 
link from being assigned to the same document 
more than once.

8.5.1.0 BUILD_8510_CONTENTATTRIBUTESUMMA
RY.sql

Creates the CONTENTATTRIBUTESUMMARY 
table and populates it with the CASELINK count 
for each CONTENT row that has case links 
assigned to it.
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Note:   You should restart your browser before preceding as all browser cookies should be deleted. If you 
still encounter errors, manually delete the browser cookies.

If you encounter any issues with the database upgrade utility, see “Troubleshooting the Information Manager 
Database Upgrade Utility” on page 72 for possible causes and related solutions.

Upgrading Information Manager Configuration, 
You upgrade Information Manager configuration, custom information, and application settings using the 
processes described in the following sections.

• Migrate Custom Settings in application.properties

• Migrate Custom Settings in config.propertiesMigrate Custom E-mail Templates

• Migrate Custom Additions to the Information Manager Spell-Check Dictionaries

• Migrate Custom Settings in the IM Management Console Web Application Deployment Descriptor

• Migrate Custom Settings in the IMWS Web Application Deployment Descriptor

• Migrate a Custom iAuthenticator

• Migrate Custom Rich Text Area Settings

• Migrate Custom JGroups Settings

• Migrate Custom Profanity Lists

• Migrate Custom Delegate Classes

• Migrate Custom Allowed HTML Tags

Migrate Custom Information and Settings
The instructions given in the following sections describe what you must do to migrate custom information and 
settings from the previously installed release of Information Manager to the freshly installed release 8.5.1 of 
Information Manager in order to fully complete the upgrade process. 

Note:   The following instructions must be performed after the database upgrade to 8.5.1 and the parallel 
installation of Information Manager 8.5.1 have been completed and verified.

Migrate Custom Settings in application.properties
This section describes how to migrate custom settings from the applications.properties files, located 
in either <IM_HOME>/config/IMADMIN or <IM_HOME>/config/IMWEBSERVICES, from the previously 
installed release of Information Manager to the freshly installed release 8.5.1 of Information Manager.

As part of the installation process of release 8.5.1, a configured copy of application.properties is put 
into both the IMADMIN and IMWEBSERVICES configuration (config) folders. As such, the following 
properties are already properly configured and should not be migrated:

• JDBCUserid

• JDBCPassword
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• DATABASE_TYPE

• JDBCURL

• JDBCDriver

• webservices.app.url

• temp.dir

The new application.properties files in release 8.5.1 in the IMADMIN and IMWEBSERVICES config 
folders contain all available settings with descriptions and default values, but most of them are commented 
out. Also, the following settings may have been available in the previously installed release but are no longer 
available in 8.5.1:

• jgroups.configsynchronizer.enabled

• jgroups.configsynchronizer.group.identifier

In order to migrate custom settings in application.properties for either IMADMIN or IMWEBSERVICES, 
the following steps must be performed while the 8.5.1 instance is not running (the previously installed 
release's instance can still be running when performing these steps):

1 In a text editor, open application.properties, located in <IM_HOME>/config/<DOMAIN>, for 
the previously installed release of Information Manager.

a <DOMAIN> can either be IMADMIN or IMWEBSERVICES.

2 In a text editor, open the corresponding application.properties for release 8.5.1.

3 For each setting name in application.properties for the previously installed release, do a 
search for that setting name in the application.properties for release 8.5.1.

Important!   Disregard the settings listed in the above bullet lists when performing this step.

4 If the setting name is found in 8.5.1:

a Uncomment the line, if it is commented out.

b Change the value to the same value in the previously installed release.

5 If the setting name is not found in 8.5.1, copy both the setting name and value from the previously 
installed release to 8.5.1, using the same placement.

6 Repeat step 3 through step 5 until all settings in the previously installed release have been migrated.

Migrate Custom Settings in config.properties
This section describes how to migrate custom values for settings in the config.properties file from the 
previously installed release of Information Manager to the freshly installed 8.5.1 release of Information 
manager. This section covers migrating custom values from the System repository and other created 
repositories and requires that the previously installed release of Information Manager and the freshly installed 
release both be up and running.

If logged into Information Manager as a user with System Administration privileges in the System repository 
or any other created repository, it is possible to change the settings contained in the config.properties 
file for that repository through the Oracle Knowledge Settings page. Some important settings can be changed 
through the configuration pages, and all settings can be changed through Expert Mode.
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Accessing the Oracle Knowledge Settings Page
To navigate to the Oracle Knowledge Settings page:

1 Log into Information Manager.

2 Select Tools.

3 Select Configure under System on the side bar.

Information Manager displays the Oracle Knowledge Settings page, containing a list of links to 
configuration pages.

Using Configuration Pages to Migrate Custom Settings
For some settings in the config.properties, it best to use the configuration pages to change the settings.

You must use the specific configuration pages to modify the following configurations:

• Resource Configuration

• LDAP Configuration

• Email Configuration

• InQuira Search Configuration

• Delegate Classes Configuration

• Delegate Translation

The Oracle Knowledge Settings page also displays a link to go to Expert Mode. Use Expert Mode to modify 
only those settings which do not appear in the above configurations. 

RESOURCE CONFIGURATION

The Resource Configuration page affects the following settings from the config.properties file:

The values on this configuration page, for the System repository and other created repositories, do not need 
to be migrated from the pre-8.5.1 release to 8.5.1 since you configured these settings during the installation.

LDAP CONFIGURATION

The LDAP Configuration page affects the following settings from the config.properties file:

• LDAP_ENABLED

• LDAP_SETTINGS

• LDAP_SINGLE_SIGN_ON

• CONTENT_RESOURCE_MOUNT_POINT • MANAGEMENT_CONSOLE_URL

• FILE_TRANSFER_TYPE • RESOURCE_HOST_URL

• FTP_SERVER_HOSTNAME • SECURE_RESOURCE_HOST_URL

• FTP_SERVER_PASSWORD • STAGING_RESOURCE_HOST_URL

• FTP_SERVER_USERNAME • STATIC_RESOURCE_PATH

• FTP_STAGING_SERVER_HOSTNAME • USE_SSL

• FTP_STAGING_SERVER_PASSWORD • WYSIWYG_LIBRARY_PATH

• FTP_STAGING_SERVER_USERNAME • WYSIWYG_THUMBNAIL_PATH
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• LDAP_SINGLE_SIGN_ON_KEY

• LDAP_RECURSION_DEPTH_LEVEL

If you have custom changes to the LDAP configuration in the System repository in the pre-8.5.1 release, do 
the following:

1 Launch the pre-8.5.1 and 8.5.1 Information Manager in two separate browser windows or tabs and log 
into the System repository on both.

2 In both browser windows/tabs, follow the steps outlined above in “Accessing the Oracle Knowledge 
Settings Page” to navigate to the Oracle Knowledge Settings page.

3 Select LDAP Configuration.

4 Make the same changes in the 8.5.1 LDAP Configuration page that exist in the pre-8.5.1 LDAP 
Configuration page.

5 Select Save LDAP Configuration.

If you have custom changes to the LDAP configuration in any of the created repositories in the pre-8.5.1 
release, do the following for each repository with changes:

1 Launch the pre-8.5.1 and 8.5.1 Information Manager in two separate browser windows or tabs and log 
into the System repository on both.

2 In the pre-8.5.1 browser/tab, change the repository to the repository with changes.

3 In the 8.5.1 browser/tab, change the repository to the 8.5.1 equivalent of the repository from step 2.

4 In both browser windows/tabs, follow the steps outlined above in “Accessing the Oracle Knowledge 
Settings Page” to navigate to the Oracle Knowledge Settings page.

5 Select LDAP Configuration.

6 Select Override Default Configuration if it displays at the bottom of the LDAP Configuration page 
while in the 8.5.1 browser/tab, If not displayed, proceed to step 7.

7 Make the same changes in the 8.5.1 LDAP Configuration page that exist in the pre-8.5.1 LDAP 
Configuration page.

If the text boxes and/or radio buttons in the 8.5.1 browser/tab are not editable, do the following in the 
8.5.1 browser/tab:

a Select Cancel.

b Select Go to Expert Mode on the Oracle Knowledge Settings page.

c Select LDAP_ENABLED.

d Make sure the Allow administrators to edit value check box is checked.

e Select Save.

f Navigate back to the LDAP Configuration page.

g Return to step 5.

8 Select Save LDAP Configuration.

EMAIL CONFIGURATION

The Email Configuration page affects the following settings from the config.properties file:
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• SMTP_HOST

• ADMIN_EMAIL

• SMTP_USE_AUTHENTICATION

• SMTP_USER_NAME

• SMTP_PASSWORD

The values on this configuration page, for the System repository and other created repositories, do not need 
to be migrated from the pre-8.5.1 release to 8.5.1 since you configured these settings during the installation.

INQUIRA SEARCH CONFIGURATION

The InQuira Search Configuration page affects the following settings from the config.properties file:

• INQUIRA_URL_FOR_SEARCH

• INQUIRA_HIGHLIGHT_FOR_SEARCH

• INQUIRA_SHOW_SIMILAR_FOR_SEARCH

• INQUIRA_DEFAULT_IM

• INQUIRA_MIN_SCORE_FOR_SEARCH

• INQUIRA_MIN_DIFF_FOR_SEARCH

• INQUIRA_MAX_DISPLAY_FOR_SEARCH

If you have custom changes to the InQuira Search configuration in the System repository in the pre-8.5.1 
release, do the following:

1 Launch the pre-8.5.1 and 8.5.1 Information Manager in two separate browser windows or tabs and log 
into the System repository on both.

2 In both browser windows/tabs, follow the steps outlined above in “Accessing the Oracle Knowledge 
Settings Page” to navigate to the Oracle Knowledge Settings page.

3 Select InQuira Search Configuration.

4 Make the same changes in the 8.5.1 InQuira Search Configuration page that exist in the pre-8.5.1 
InQuira Search Configuration page.

5 Select Save.

If you have custom changes to the InQuira Search configuration in any of the created repositories in the pre-
8.5.1 release, do the following for each repository with changes:

1 Launch the pre-8.5.1 and 8.5.1 Information Manager in two separate browser windows or tabs and log 
into the System repository on both.

2 In the pre-8.5.1 browser/tab, change the repository to the repository with changes.

3 In the 8.5.1 browser/tab, change the repository to the 8.5.1 equivalent of the repository from step 2.

4 In both browser windows/tabs, follow the steps outlined above in “Accessing the Oracle Knowledge 
Settings Page” to navigate to the Oracle Knowledge Settings page.

5 Select InQuira Search Configuration.

6 Select Override Default Configuration if it displays at the bottom of the InQuira Search Configuration 
page while in the 8.5.1 browser/tab, If not, proceed to step 7.
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7 Make the same changes in the 8.5.1 InQuira Search Configuration page that exist in the pre-8.5.1 
InQuira Search Configuration page.

If the text boxes and/or radio buttons in the 8.5.1 browser/tab are not editable, do the following while in 
the 8.5.1 browser/tab:

a Select Cancel.

b Select Go to Expert Mode on the Oracle Knowledge Settings page.

c Select INQUIRA_URL_FOR_SEARCH.

d Make sure the Allow administrators to edit value check box is checked.

e Select Save.

f Navigate back to the InQuira Search Configuration page.

g Return to step 5.

8 Select Save.

DELEGATE CLASSES CONFIGURATION

The Delegate Classes Configuration page affects the following settings from the config.properties file:

If you have custom changes to the Delegate Classes configuration in the System repository in the pre-8.5.1 
release, do the following:

1 Launch the pre-8.5.1 and 8.5.1 Information Manager in two separate browser windows or tabs and log 
into the System repository on both.

2 In both browser windows/tabs, follow the steps outlined above in “Accessing the Oracle Knowledge 
Settings Page” to navigate to the Oracle Knowledge Settings page.

3 Select Delegate Classes Configuration.

4 Make the same changes in the 8.5.1 Delegate Classes Configuration page that exist in the Pre-8.5.1 
Delegate Classes Configuration page.

5 Select Save Delegate Classes.

If you have custom changes to the Delegate Classes configuration in any of the created repositories in the 
Pre-8.5.1 release, do the following for each repository with changes:

1 Launch the pre-8.5.1 and 8.5.1 Information Manager in two separate browser windows or tabs and log 
into the System repository on both.

2 In the pre-8.5.1 browser/tab, change the repository to the repository with changes.

• ChangeLocalAction • LostPasswordAction

• ChannelSearchAction • NewsLetterFindEmailAction

• ContributeAction • NewsLetterSubscribeAction

• CreateFaqAction • PageEmailAction

• EditProfileAction • RecommendAction

• FullTextSearchAction • TakeSurveyAction

• GenericFormAction • TalkbackAction

• LoginAction
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3 In the 8.5.1 browser/tab, change the repository to the 8.5.1 equivalent of the repository from step 2.

4 In both browser windows/tabs, follow the steps outlined above in “Accessing the Oracle Knowledge 
Settings Page” to navigate to the Oracle Knowledge Settings page.

5 Select Delegate Classes Configuration.

6 Select Override Default Configuration if it displays at the bottom of the Delegate Classes 
Configuration page while in the 8.5.1 browser/tab. If not, proceed to step 7.

7 Make the same changes in the 8.5.1 Delegate Classes Configuration page that exist in the pre-8.5.1 
Delegate Classes Configuration page.

If the text boxes and/or radio buttons in the 8.5.1 browser/tab are not editable, do the following while in 
the 8.5.1 browser/tab:

a Select Cancel.

b Select Go to Expert Mode on the Oracle Knowledge Settings page.

c Select ChangeLocalAction.

d Make sure the Allow administrators to edit value check box is checked.

e Select Save.

f Navigate back to the Delegate Classes Configuration page.

g Return to step 5.

8 Select Save Delegate Classes.

DELEGATE TRANSLATION

The Translation Delegate Class Configuration page affects the following setting from the 
config.properties file:

• TranslationDelegate

If you have a custom change to the Delegate Classes configuration in the System repository in the pre-8.5.1 
release, do the following:

1 Launch the pre-8.5.1 and 8.5.1 Information Manager in two separate browser windows or tabs and log 
into the System repository on both.

2 In both browser windows/tabs, follow the steps outlined above in “Accessing the Oracle Knowledge 
Settings Page” to navigate to the Oracle Knowledge Settings page.

3 Select Delegate Translation.

4 Make the same change in the 8.5.1 Translation Delegate Class Configuration page that exists in the 
pre-8.5.1 Translation Delegate Class Configuration page.

5 Select Save Delegate Class.

If a custom change was made to the Translation Delegate Class configuration in any of the created 
repositories in the pre-8.5.1 release, do the following for each repository with changes:

1 Launch the pre-8.5.1 and 8.5.1 Information Manager in two separate browser windows or tabs and log 
into the System repository on both.

2 In the pre-8.5.1 browser/tab, change the repository to the repository with changes.
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3 In the 8.5.1 browser/tab, change the repository to the 8.5.1 equivalent of the repository from step 2.

4 In both browser windows/tabs, follow the steps outlined above in “Accessing the Oracle Knowledge 
Settings Page” to navigate to the Oracle Knowledge Settings page.

5 Select Delegate Translation.

6 Select Override Default Configuration if it displays at the bottom of the Translation Delegate Class 
Configuration page while in the 8.5.1 browser/tab. If not, proceed to step 7.

7 Make the same change in the 8.5.1 Translation Delegate Class Configuration page that exists in the 
pre-8.5.1 Translation Delegate Class Configuration page.

If the text boxes and/or radio buttons in the 8.5.1 browser/tab are not editable, do the following while in 
the 8.5.1 browser/tab:

a Select Cancel.

b Select Go to Expert Mode on the Oracle Knowledge Settings page.

c Select TranslationDelegate.

d Make sure the Allow administrators to edit value check box is checked.

e Select Save.

f Navigate back to the Translation Delegate Class Configuration page.

g Return to step 5.

8 Select Save Delegate Class.

Using Expert Mode to Migrate Custom Settings
Since the configuration pages only affect certain settings in the config.properties file, the way to migrate 
those settings that are not affected by the configuration pages is to use Expert Mode in Information Manager. 
The Expert Mode page lists all the available settings in the config.properties files with descriptions for 
each. To edit a setting, select the setting.

To navigate to the Expert Mode page:

1 Select Tools.

2 Select Configure under System on the side bar.

3 Select Go to Expert Mode.

Use the following instructions to migrate only the settings not affected by the configuration pages which were 
listed in their respective sections. Ignore those settings which have been modified through their respective 
configuration pages when following these instructions. The following instructions are for migrating custom 
settings for both the System repository and/or each of the created repositories.

1 Launch the pre-8.5.1 and 8.5.1 Information Manager in two separate browser windows or tabs and log 
into the System repository on both.

If migrating settings for the System repository, skip to step 4.

If migrating settings for a created repository, go on to step 2.

2 In the pre-8.5.1 browser/tab, change the repository to the repository with changes.

3 In the 8.5.1 browser/tab, change the repository to the 8.5.1 equivalent of the repository from step 2.
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4 In both browser windows/tabs, follow the steps above to navigate to the Expert Mode page.

5 For each setting that was changed in pre-8.5.1 release (while ignoring the settings affected by 
configuration pages), make the same change in the 8.5.1 release.

Migrate Custom E-mail Templates
This section describes how to migrate custom, modified e-mail templates from the previously installed release 
of Information Manager.

The e-mail template files can be found in the following locations:

• <IM_HOME>/config/SYSTEM/taskconfig

• <IM_HOME>/config/<REPO_REFKEY>/taskconfig

- <REPO_REFKEY> is a repository reference key and does not include IMADMIN or IMWEBSERVICES.

- A copy of the template would be stored here only if the e-mail template was modified for the specific 
repository.

The e-mail template file names are in the following format:

<template_name>_<language>.xml

- <language> is the two-letter language code (e.g. en).

- Example file name: contentexpiration_fr.xml

Steps to Migrate Custom E-mail Templates
When migrating the custom e-mail templates from the previously installed release of Information Manager, 
the following changes need to be taken into account:

• Passwords in Templates: The use of the password token, <P1>, in e-mail templates is not supported in 
8.5.1. If any modified e-mail templates contain the password token, they must be edited to remove the 
password token.

• Lost Password Template: The Lost Password template (forgotPassword_<language>.xml) is not 
used in 8.5.1 and should not be migrated from the previously installed release to 8.5.1.

• Inactive Account Template: The Inactive Account notification is sent to a user who has unsuccessfully 
tried to log in more than the maximum allowed attempts. Due to the change in the process of unlocking a 
locked user account, the Inactive Account template (inactiveAccount_<language>.xml) has been 
changed considerably to work with the new process. The template now contains instructions, a link to 
reset the user password in order to unlock the account, and a valid link expiration period. Since the 
process for which this template is used has changed, Oracle strongly recommends that you modify the 
template in 8.5.1 if needed. You should not migrate any custom changes to the Inactive Account 
template from the previously installed release, as this could introduce inconsistencies.

• Content Recommendation Template: The Content Recommendation notification is sent to a user who 
has been assigned a Content Recommendation task. The Content Recommendation template 
(contentrecommendation_<language>.xml) has been changed to reflect more accurately the call 
to action to the user. Since the template is more accurate, Oracle strongly recommends that you modify 
the template in 8.5.1 if needed.

Note:   If necessary, the email Template migration can be performed while both the previously installed 
release of Information Manager and release 8.5.1 of Information Manager are running.
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MIGRATE CUSTOM REPOSITORY-SPECIFIC E-MAIL TEMPLATES

The following steps describe how to migrate the repository-specific e-mail templates from the previously 
installed release to release 8.5.1. These steps only apply if e-mail template files are contained in the 
taskconfig folder in a repository's configuration folder located in <IM_HOME>/config/<REPO_REFKEY>. 
If not, then skip these steps. If multiple repositories that have custom repository-specific e-mail templates 
exist, these steps must be repeated for each repository.

1 Navigate to <PRE_8.5.1_IM_HOME>/config/<REPO_REFKEY>/taskconfig, and copy ALL of 
the e-mail template files while excluding the following e-mail template files if they exist:

- forgotPassword_<language>.xml - no longer used

- inactiveAccount_<language>.xml - must be manually modified in 8.5.1

2 Navigate to the matching <8.5.1_IM_HOME>/config/<REPO_REFKEY>/taskconfig, and paste 
the copied e-mail template files into the directory.

If <8.5.1_IM_HOME>/config/<REPO_REFKEY> does not exist, log into that repository using the 
8.5.1 release of Information Manager, and the system creates the folder. The new folder contains a 
taskconfig folder.

3 If any of the customized e-mail templates that were just migrated make use of the password token 
<P1>, log into the repository through Information Manager as any user with the Default Administration 
role and remove the token by editing the template. To navigate to the proper template to edit:

a Select the Tools tab.

b Select Configure under Tasks & Notifications in the side bar.

c Select the desired task name to edit the e-mail template.

If the edit boxes on the edit page are not disabled, the e-mail template was not customized.

MIGRATE CUSTOM SYSTEM DEFAULT E-MAIL TEMPLATES

The following steps describe how to migrate the system default e-mail templates, which are contained in 
<IM_HOME>/config/SYSTEM/taskconfig, from the previously installed release to release 8.5.1. These 
steps only apply if customizations were made to the e-mail templates in the SYSTEM repository. If 
customizations were not made, then skip these steps.

1 Since the steps to migrate the system default e-mail templates include the replacement of files in 
release 8.5.1, create the following folder structure for backups if it does not already exist:

<8.5.1_INSTALL_DIR>/backups/8.5.1/IM_HOME/config/SYSTEM

2 Determine and make note of which e-mail templates are customized in the SYSTEM repository in the 
previously installed release of Information Manager.

3 Backup the taskconfig folder located in <8.5.1_IM_HOME>/config/SYSTEM/ to the following 
path: <8.5.1_INSTALL_DIR>/backups/8.5.1/IM_HOME/config/SYSTEM created in step 1.

4 Navigate to <PRE_8.5.1_IM_HOME>/config/SYSTEM/taskconfig, and copy ONLY the 
customized e-mail template files (include localized releases) while excluding the following e-mail 
template files if they were customized:

- forgotPassword_<language>.xml - no longer used

- inactiveAccount_<language>.xml - must be manually modified in 8.5.1

5 Navigate to the matching <8.5.1_IM_HOME>/config/SYSTEM/taskconfig directory and paste 
the copied e-mail template files into the directory.
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If prompted to replace a file, confirm to replace.

6 If any of the customized e-mail templates that were just migrated made use of the password token 
<P1>, log into the SYSTEM repository through Information Manager as any user with the Default 
Administration role and remove the token by editing the template. To navigate to the proper template to 
edit:

a Select the Tools tab.

b Select Configure under Tasks & Notifications in the side bar.

c Select the desired task name to edit the e-mail template.

Migrate Custom Additions to the Information Manager 
Spell-Check Dictionaries
This section describes how to migrate any custom additions to the Information Manager spell-check 
dictionaries from the previously installed release of Information Manager to the freshly installed release 8.5.1. 
If no additions have been made to the spell-check dictionaries in the previously installed version of 
Information Manager, skip this section.

The spell-check dictionary files can be found in the following locations:

• For English:

<IM_HOME>/ssce

• For Other Locales:

<IM_HOME/ssce/<locale_CODE>

<locale_CODE> is the locale code (e.g. de_DE)

Also, within the <IM_HOME>/ssce folder, the imspellcheck.properties file is kept. This is a properties 
file that contains settings that affect how the spell checker works along with the settings that determine where 
the default dictionaries are located (English by default).

Backing up Spell-Check Dictionaries in Version 8.5.1
Since the steps to migrate custom additions to the spell-check dictionaries include the replacement of files in 
version 8.5.1, perform the following steps to back up the spell-check dictionaries in version 8.5.1.

1 Create the following folder structure for backups if it does not already exist:

<8.5.1_INSTALL_DIR>/backups/8.5.1/IM_HOME

2 Copy <8.5.1_IM_HOME>/ssce into <8.5.1_INSTALL_DIR>/backups/8.5.1/IM_HOME, 
which you created in step 1. This should result in <8.5.1_INSTALL_DIR>/backups/8.5.1/
IM_HOME containing an ssce folder.

Steps to Migrate Custom Additions to Spell-Check Dictionaries
When migrating customizations to the spell-check dictionaries, the following cases need to be taken into 
consideration:

• Customizations done to the imspellcheck.properties file
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• Customizations done to the default (English) dictionary files

• Customizations done to other locales dictionary files

The following steps must be performed while the release 8.5.1 installation is not running. The previously 
installed release can still be running if needed.

CUSTOMIZATIONS TO THE IMSPELLCHECK.PROPERTIES FILE

If no customizations where done to the imspellcheck.properties file in the previously installed release, 
skip the following steps.

1 In a text editor, open up the imspellcheck.properties file in <PRE_8.5.1_IM_HOME>/ssce.

2 In a text editor, open up the imspellcheck.properties file in <8.5.1_IM_HOME>/ssce.

3 For each setting, compare the value from the previously installed release to 8.5.1, and change the 
value in 8.5.1 if they do not match.

If a setting was added in the previously installed release and does not exist in the 8.5.1, add it to the 
end of the file in 8.5.1.

Note:   The default value for the setting, SPLIT_HYPHENATED_WORDS_OPT, is now false in 8.5.1.

CUSTOMIZATIONS DONE TO THE DEFAULT (ENGLISH) DICTIONARY FILES

If no customizations were done to the default (English) dictionary files in the previously installed version, skip 
the following steps.

1 Navigate to <PRE_8.5.1_IM_HOME>/ssce, and copy the following files:

- ssceam.tlx

- ssceam2.clx

- userdic.tlx

2 Navigate to <8.5.1_IM_HOME>/ssce, and paste the copied files.

If prompted to replace the file, confirm to replace.

CUSTOMIZATIONS DONE TO OTHER LOCALES' DICTIONARY FILES

If no customizations were done to other locales dictionary files in the previously installed version, skip the 
following steps.

1 Navigate to <PRE_8.5.1_IM_HOME>/ssce, and copy the locale folders that had customizations 
done to their dictionary files.

This includes custom locales that were added.

2 Navigate to <8.5.1_IM_HOME>/ssce, and paste the copied folders.

If prompted to replace the file, confirm to replace.
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Migrate Custom Settings in the IM Management Console 
Web Application Deployment Descriptor
This section describes how to migrate custom settings in the deployment descriptor of the previously installed 
release of the IM Management Console web application to the freshly installed release 8.5.1 IM Management 
Console web application.

The web application’s deployment descriptor for the previously installed and deployed release of the IM 
Management Console web application can be found in:

<Pre-8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/InfoManager/
WEB-INF/web.xml

In release 8.5.1, the IM Management Console web application’s deployment descriptor location depends 
upon which application server you use:

The freshly installed 8.5.1 deployment descriptor uses the following descriptor elements:

• Context Parameters

• Filters and Filter Mappings

• Listeners

• Servlets and Servlet Mappings

• Session Configurations

Review the deployment descriptor for the previously installed release of the IM Management Console web 
application. If the web.xml contained any descriptor elements not mentioned above, add them to the freshly 
installed release 8.5.1 web.xml.

For every descriptor element used in the freshly installed release 8.5.1 IM Management Console web 
application deployment descriptor, we outline the installed settings and how to maintain your customizations 
from the previously installed release of the IM Management Console web application’s deployment descriptor.

Context Parameters

WOAPPMODE PARAMETER

<context-param>
<param-name>WOAppMode</param-name> 
<param-value>Deployment</param-value>

</context-param>

This parameter setting has not changed for 8.5.1.

WOCLASSPATH PARAMETER

<context-param>
<param-name>WOClasspath</param-name>
<param-value>WEBINFROOT/InfoManager.woa/Contents/Resources/Java/infomanager-

WebLogic <8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/InfoManager/app/ 
WEB-INF/web.xml

Tomcat <8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/ 
InfoManager/WEB-INF/web.xml
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8.5.1.jar</param-value>
</context-param>

This parameter has been updated in 8.5.1. In releases prior to 8.5.1, the parameter’s value was:

<param-value>

WEBINFROOT/Library/Frameworks/JavaJDBCAdaptor.framework/Resources/Java/
javajdbcadaptor.jar

WEBINFROOT/Library/Frameworks/JavaEOControl.framework/Resources/Java/
javaeocontrol.jar

WEBINFROOT/Library/Frameworks/IMModel.framework/Resources/Java/immodel.jar

WEBINFROOT/Library/Frameworks/JavaWOJSPServlet.framework/Resources/Java/
javawojspservlet.jar

WEBINFROOT/Library/Frameworks/IMServices.framework/Resources/Java/
imservices.jar

WEBINFROOT/Library/Frameworks/JavaWOExtensions.framework/Resources/Java/
JavaWOExtensions.jar

WEBINFROOT/Library/Frameworks/IMFoundation.framework/Resources/Java/
imfoundation.jar

WEBINFROOT/Library/Frameworks/JavaWebObjects.framework/Resources/Java/
javawebobjects.jar

WEBINFROOT/Library/Frameworks/JavaEOProject.framework/Resources/Java/
javaeoproject.jar

WEBINFROOT/Library/Frameworks/JavaEOAccess.framework/Resources/Java/
javaeoaccess.jar

WEBINFROOT/Library/Frameworks/JavaFoundation.framework/Resources/Java/
javafoundation.jar

WEBINFROOT/Library/Frameworks/JavaWebServicesSupport.framework/Resources/Java/
javawebservicessupport.jar

WEBINFROOT/Library/Frameworks/JavaWebServicesClient.framework/Resources/Java/
javawebservicesclient.jar

WEBINFROOT/Library/Frameworks/ERJars.framework/Resources/Java/ERJars.jar

WEBINFROOT/Library/Frameworks/ERJars.framework/Resources/Java/
erxservletadaptor.jar

WEBINFROOT/Library/Frameworks/ERExtensions.framework/Resources/Java/
ERExtensions.jar

WEBINFROOT/Library/Frameworks/ERJGroupsSynchronizer.framework/Resources/Java/
ERJGroupsSynchronizer.jar

WEBINFROOT/InfoManager.woa/Contents/Resources/Java/infomanager.jar

</param-value>

If the web.xml for the previously installed release of the IM Management Console web application specified 
any other class files, jar files or directories not listed above in the value of the WOClasspath parameter, add 
them to the WOClasspath parameter value of the freshly installed release 8.5.1 web.xml.
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WOAPPLICATIONCLASS PARAMETER

<context-param>
<param-name>WOApplicationClass</param-name> 
<param-value>com.inquira.admin.Application</param-value>

</context-param>

This parameter setting has not changed for 8.5.1.

CUSTOM CONTEXT PARAMETERS

If the web.xml for the previously installed release of the IM Management Console web application specified 
any other context parameters, add them to the freshly installed release 8.5.1 web.xml.

Filters and Filter Mappings

INFOMANAGER SERVLET FILTER

<filter>
<filter-name>InfoManager Servlet Filter</filter-name>
<filter-class>com.inquira.servletfilter.IMServletFilter</filter-class> 
<!-- 
<init-param>

<param-name>redirectURL</param-name> 
<param-value>/loginpage/login.jsp</param-value>

</init-param> 
--> 
<!--  
<init-param>

<param-name>allowIPs</param-name> 
<param-value>10.0.20.28,localhost</param-value>

</init-param> 
--> 
<init-param>

<param-name>cookieExpireMinutes</param-name> 
<param-value>10</param-value>

</init-param>
<init-param>

<description>This is a regex expression that matches allowed URL patterns, 
all non matched patterns will be rejected</description> 
<param-name>allowedURLPatterns</param-name> 
<param-value>.*/InfoManager.woa.*</param-value>

</init-param>
</filter>

The filter class specification, com.inquira.servletfilter.IMServletFilter, has not changed for 
8.5.1.

The cookieExpireMinutes initialization parameter has not changed for 8.5.1. If the web.xml for the 
previously installed release of the IM Management Console web application configured the 
cookieExpireMinutes initialization parameter of the InfoManager Servlet filter to a custom value, 
configure the parameter with the custom value for the filter in the freshly installed release 8.5.1 web.xml.

The allowedURLPatterns initialization parameter has been updated in 8.5.1. In releases prior to 8.5.1, the 
initialization parameter’s value was:
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<param-value>.*/WebObjects.*\.woa/wo.*\.[0-9]+</param-value>

If the web.xml for the previously installed release of the IM Management Console web application configured 
the allowedURLPatterns initialization parameter of the InfoManager Servlet filter to a custom value not 
equal to the previous installed value, configure the parameter with the custom value for the filter in the freshly 
installed release 8.5.1 web.xml.

The InfoManager Servlet filter contains two initialization parameters that are disabled upon installation, 
redirectURL and allowIPs. 

The redirectURL initialization parameter can be used to specify a custom path to present when 
authentication fails. It can be set to a full URL or a relative path. The allowIPs initialization parameter can 
be used to specify a comma-separated list of IP addresses that the InfoManager Servlet filter allows access 
to the web application without checking security.

If the web.xml for the previously installed release of the IM Management Console web application enabled 
the redirectURL or the allowIPs initialization parameter for the InfoManager Servlet filter, enable and 
configure the parameter for the filter in the freshly installed release 8.5.1 web.xml

INFOMANAGER SERVLET FILTER MAPPING

<filter-mapping>
<filter-name>InfoManager Servlet Filter</filter-name> 
<url-pattern>/*</url-pattern>

</filter-mapping>

The InfoManager Servlet filter mapping has not changed in 8.5.1.

IQOBJECTSTOREASSIGNINGFILTER FILTER

This filter will be called after IMServletFilter. This filter need not handle requests that will be rejected by 
IMServletFilter.

<filter>
<filter-name>IQObjectStoreAssigningFilter</filter-name> 
<filter-class>com.inquira.foundation.utilities.IQObjectStoreAssigningFilter</
filter-class> 
<init-param>

<description>Set this flag to true in IM Console and InfoCenter so that User 
specific ObjectStore is stored in HttpSession.</description>
<param-name>attachObjectStoreToHttpSession</param-name>
<param-value>true</param-value>

</init-param>
</filter>

The IQObjectStoreAssigningFilter filter is new in 8.5.1.

IQOBJECTSTOREASSIGNINGFILTER FILTER MAPPING

<filter-mapping>
<filter-name>IQObjectStoreAssigningFilter</filter-name> 
<url-pattern>/*</url-pattern>

</filter-mapping>

The IQObjectStoreAssigningFilter filter mapping is new in 8.5.1.
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CUSTOM FILTERS AND FILTER MAPPINGS

If the web.xml for the previously installed release of the IM Management Console web application specified 
any other filters and filter mappings, add them to the freshly installed release 8.5.1 web.xml.

Listeners

CONFIGURATION CONTEXT LISTENER

<listener>
<listener-class>com.inquira.admin.configuration.ContextListener</listener-
class>

</listener>

The configuration context listener has not changed in 8.5.1.

CUSTOM LISTENERS

If the web.xml for the previously installed release of the IM Management Console web application specified 
any other listeners, add them to the freshly installed release 8.5.1 web.xml.

Servlets and Servlet Mappings

WOSERVLETADAPTOR SERVLET

<servlet>
<servlet-name>WOServletAdaptor</servlet-name>
<servlet-class>er.extensions.jspservlet.ERXServletAdaptor</servlet-class>
<load-on-startup>1</load-on-startup>

</servlet>

The WOServletAdaptor servlet has not changed in 8.5.1.

WOSERVLETADAPTOR SERVLET MAPPING

<servlet-mapping>
<servlet-name>WOServletAdaptor</servlet-name>
<url-pattern>/WebObjects/*</url-pattern>

</servlet-mapping>

The WOServletAdaptor servlet mapping has not changed in 8.5.1.

CKFINDERCONNECTORSERVLET SERVLET

<servlet>
<servlet-name>CKFinderConnectorServlet</servlet-name>
<servlet-class>com.inquira.services.components.CKFinderConnectorServlet</
servlet-class>
<init-param>

<param-name>configuration</param-name>
<param-value>com.inquira.services.components.CKFinderConfiguration</param-
value>

</init-param>
<init-param>
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<param-name>XMLConfig</param-name>
<param-value>/WEB-INF/ckfinder_config.xml</param-value>

</init-param>
<init-param>

<param-name>debug</param-name>
<param-value>false</param-value>

</init-param>
<load-on-startup>2</load-on-startup>

</servlet>

The CKFinderConnectorServlet servlet is new in 8.5.1.

CKFINDERCONNECTORSERVLET  SERVLET MAPPINGS

<servlet-mapping>
<servlet-name>CKFinderConnectorServlet</servlet-name>
<url-pattern>/resources/application/components/ckfinder/core/connector/java/
connector.java</url-pattern>

</servlet-mapping>

The CKFinderConnectorServlet servlet mapping is new in 8.5.1.

CUSTOM SERVLETS AND SERVLET MAPPINGS

If the web.xml for the previously installed release of the IM Management Console web application specified 
any other servlets and servlet mappings, add them to the freshly installed release 8.5.1 web.xml. Be sure to 
start the load on startup value for the custom servlets at 3 in order to maintain the instantiation order of the 
installed servlets with the custom servlets.

Session Configurations
<session-config>

<session-timeout>90</session-timeout>
</session-config>

The session timeout defines the default session timeout interval for all sessions created in this web 
application. The default value is 90 minutes. This default value has not changed in 8.5.1. The specified 
timeout must be expressed in a whole number of minutes. If the timeout is 0 or less, the container 
ensures the default behavior of sessions is never to time out. 

If the web.xml for the previously installed release of the IM Management Console web application configured 
the session timeout to a custom value, configure the session timeout with the custom value in the freshly 
installed release 8.5.1 web.xml.

Migrate Custom Settings in the IMWS Web Application 
Deployment Descriptor
This section describes how to migrate custom settings in the deployment descriptor of the previously installed 
release of the IMWS web application to the freshly installed release 8.5.1 IMWS web application.

The web application’s deployment descriptor for the previously installed and deployed release of the IMWS 
web application can be found in:

<Pre-8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/imws/WEB-INF/
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web.xml

The web application’s deployment descriptor for the freshly installed release 8.5.1 IMWS web application can 
be found in:

The freshly installed 8.5.1 deployment descriptor uses the following descriptor elements:

• Context Parameters

• Filters and Filter Mappings

• Servlets and Servlet Mappings

• Welcome File List

Review the deployment descriptor for the previously installed release of the IMWS web application. If the 
web.xml contained any descriptor elements not mentioned above, add them to the freshly installed release 
8.5.1 web.xml.

For every descriptor element used in the freshly installed release 8.5.1 IMWS web application’s deployment 
descriptor, we outline the installed settings and how to maintain your customizations from the previously 
installed release of the IMWS web application’s deployment descriptor.

Context Parameters

WOAPPMODE PARAMETER

<context-param>
<param-name>WOAppMode</param-name> 
<param-value>Deployment</param-value>

</context-param>

This parameter setting has not changed for 8.5.1.

WOCLASSPATH PARAMETER

<context-param>
<param-name>WOClasspath</param-name>
<param-value> WEBINFROOT/IMWebServices.woa/Contents/Resources/Java/
imwebservices-8.5.1.jar</param-value>

</context-param>

This parameter has been updated in 8.5.1. In releases prior to 8.5.1, the parameter’s value was:

<param-value>

WEBINFROOT/Library/Frameworks/JavaJDBCAdaptor.framework/Resources/Java/
javajdbcadaptor.jar

WEBINFROOT/Library/Frameworks/JavaEOControl.framework/Resources/Java/
javaeocontrol.jar

WEBINFROOT/Library/Frameworks/IMModel.framework/Resources/Java/immodel.jar

WEBINFROOT/Library/Frameworks/JavaWOJSPServlet.framework/Resources/Java/

WebLogic <8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/imws/app/WEB-INF/
web.xml

Tomcat <8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/imws/
WEB-INF/web.xml
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javawojspservlet.jar

WEBINFROOT/Library/Frameworks/IMServices.framework/Resources/Java/
imservices.jar

WEBINFROOT/Library/Frameworks/JavaWOExtensions.framework/Resources/Java/
JavaWOExtensions.jar

WEBINFROOT/Library/Frameworks/IMFoundation.framework/Resources/Java/
imfoundation.jar

WEBINFROOT/Library/Frameworks/JavaWebObjects.framework/Resources/Java/
javawebobjects.jar

WEBINFROOT/Library/Frameworks/JavaEOProject.framework/Resources/Java/
javaeoproject.jar

WEBINFROOT/Library/Frameworks/JavaEOAccess.framework/Resources/Java/
javaeoaccess.jar

WEBINFROOT/Library/Frameworks/JavaFoundation.framework/Resources/Java/
javafoundation.jar

WEBINFROOT/Library/Frameworks/JavaWebServicesSupport.framework/Resources/Java/
javawebservicessupport.jar

WEBINFROOT/Library/Frameworks/JavaWebServicesClient.framework/Resources/Java/
javawebservicesclient.jar

WEBINFROOT/Library/Frameworks/ERJars.framework/Resources/Java/ERJars.jar

WEBINFROOT/Library/Frameworks/ERExtensions.framework/Resources/Java/
ERExtensions.jar

WEBINFROOT/Library/Frameworks/ERJars.framework/Resources/Java/
erxservletadaptor.jar

WEBINFROOT/Library/Frameworks/ERJGroupsSynchronizer.framework/Resources/Java/
ERJGroupsSynchronizer.jar

WEBINFROOT/IMWebServices.woa/Contents/Resources/Java/imwebservices.jar

</param-value>

If the web.xml for the previously installed release of the IMWS web application specified any other class 
files, jar files or directories not listed above in the value of the WOClasspath parameter, add them to the 
WOClasspath parameter value of the freshly installed release 8.5.1 web.xml.

WOAPPLICATIONCLASS PARAMETER

<context-param>
<param-name>WOApplicationClass</param-name>
<param-value>com.inquira.imwows.application.Application</param-value>

</context-param>

This parameter setting has not changed for 8.5.1.

CUSTOM CONTEXT PARAMETERS

If the web.xml for the previously installed release of the IMWS web application specified any other context 
parameters, add them to the freshly installed release 8.5.1 web.xml.
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Filters and Filter Mappings

UTF8FILTER FILTER

<filter>
<filter-name>UTF8Filter</filter-name>
<filter-class>com.inquira.imwows.filters.ForceUTF8RequestEncodingFilter</
filter-class>

</filter>

The filter class specification, com.inquira.imwows.filters.ForceUTF8RequestEncodingFilter, 
has not changed for 8.5.1.

UTF8FILTER FILTER MAPPING

<filter-mapping>
<filter-name>UTF8Filter</filter-name>
<url-pattern>/*</url-pattern>

</filter-mapping>

The UTF8Filter filter mapping has not changed in 8.5.1.

IQOBJECTSTOREASSIGNINGFILTER FILTER

<filter>
<filter-name>IQObjectStoreAssigningFilter</filter-name>
<filter-class>com.inquira.foundation.utilities.IQObjectStoreAssigningFilter</
filter-class>
<init-param>

<description>Set this flag to true in IM Console, InfoCenter so that User 
specific ObjectStore is stored in HttpSession. But in IMWS, set this to 
false.</description>
<param-name>attachObjectStoreToHttpSession</param-name>
<param-value>false</param-value>

</init-param>
</filter>

The IQObjectStoreAssigningFilter filter is new in 8.5.1.

IQOBJECTSTOREASSIGNINGFILTER FILTER MAPPING

<filter-mapping>
<filter-name>IQObjectStoreAssigningFilter</filter-name> 
<url-pattern>/*</url-pattern>

</filter-mapping>

The IQObjectStoreAssigningFilter filter mapping is new in 8.5.1.

CUSTOM FILTERS AND FILTER MAPPINGS

If the web.xml for the previously installed release of the IMWS web application specified any other filters and 
filter mappings, add them to the freshly installed release 8.5.1 web.xml.
UPGRADING ORACLE KNOWLEDGE



60   MIGRATE CUSTOM INFORMATION AND SETTINGS
Servlets and Servlet Mappings

WOSERVLETADAPTOR SERVLET

<servlet>
<servlet-name>WOServletAdaptor</servlet-name>
<servlet-class>er.extensions.jspservlet.ERXServletAdaptor</servlet-class>
<load-on-startup>1</load-on-startup>

</servlet>

The WOServletAdaptor servlet has not changed in 8.5.1.

WOSERVLETADAPTOR SERVLET MAPPING

<servlet-mapping>
<servlet-name>WOServletAdaptor</servlet-name>
<url-pattern>/WebObjects/*</url-pattern>

</servlet-mapping>

The WOServletAdaptor servlet mapping has not changed in 8.5.1.

GATEWAYAUTODEPLOYER SERVLET

<servlet>
<servlet-name>gatewayautodeployer</servlet-name>
<!—
<display-name>Gateway Autodeployer Servlet</display-name>
<description>no description</description>
-->
<servlet-class>com.inquira.infra.trnsp.AutoDeployServlet</servlet-class>
<init-param>

<param-name>sleepTime</param-name>
<param-value>5000</param-value>

</init-param>
<load-on-startup>1</load-on-startup>

</servlet>

The GatewayAutoDeployer servlet was removed in 8.5.1.

CUSTOM SERVLETS AND SERVLET MAPPINGS

If the web.xml for the previously installed release of the IMWS web application specified any other servlets 
and servlet mappings that were not removed in 8.5.1, add them to the freshly installed release 8.5.1 
web.xml. Be sure to start the load on startup value for the custom servlets at 2 in order to maintain the 
instantiation order of the out of the box servlet with the custom servlets.

Welcome File List
<welcome-file-list>

<welcome-file>index.html</welcome-file> 
<welcome-file>index.htm</welcome-file> 
<welcome-file>index.jsp</welcome-file> 
<welcome-file>default.html</welcome-file> 
<welcome-file>default.htm</welcome-file> 
<welcome-file>default.jsp</welcome-file>

</welcome-file-list>
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The welcome file list has not changed in 8.5.1.

If the web.xml for the previously installed release of the IMWS web application specified a different welcome 
file list or list order, configure the welcome file list to the customized value in the freshly installed release 8.5.1 
web.xml.

Migrate a Custom iAuthenticator
This section describes how to migrate a custom iAuthenticator used to authenticate users in the previously 
installed release of Information Manager to the freshly installed release 8.5.1 Information Manager.

The freshly installed version 8.5.1 iAuthenticator API Java documentation can be found under:

<8.5.1 INSTALL DIR>/InfoManager/docs/iAuthentication/index.html

Review the 8.5.1 iAuthenticator API Java documentation for updates to the API.

The freshly installed release 8.5.1 iAuthenticator API can be found in the following .jar file:

<8.5.1 INSTALL DIR>/InfoManager/clientLibrary/Java/infra.jar

The previously installed release of the iAuthenticator API may have been contained in one of the following jar 
files:

• infra-1.0.jar together with shared.jar

• inquira-infra-1.1.jar

• inquira-infra-1.1.1.jar

Though none of the existing iAuthenticator interface signatures have changed in 8.5.1, you must recompile 
the source code of your custom iAuthenticator with the freshly installed release 8.5.1 infra.jar in the class 
path and the previously installed release infra jar file(s) removed from the class path.

Note:   The com.inquira.infra.InquiraException class has changed in 8.5.1. If your custom 
iAuthenticator has any classes that extend this class, review the changes below to resolve potential 
compilation issues.

REMOVED COM.INQUIRA.INFRA.INQUIRAEXCEPTION FIELDS

• public static final int UNKOWN = 0;

• public static final int TRANSACTION_RETRY = 2;

• public static final int APPLICATION_FATAL = 3;

• protected static ResourceBundle resources;

• protected static ResourceBundle logResources;

• protected static HashMap resourceFormats = new HashMap();

REMOVED COM.INQUIRA.INFRA.INQUIRAEXCEPTION CONSTRUCTORS

• public InquiraException(String id, Object[] args, int disposition);

• public InquiraException(String id, Object[] args, Throwable cause, int 
disposition);
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REMOVED COM.INQUIRA.INFRA.INQUIRAEXCEPTION METHODS

• public String printLogString();

• public static String printLogString(Throwable t);

• public String getID();

• public int getDisposition();

• public void setArguments(Object[] args);

• public boolean instanceOf(Class c);

• public boolean instanceOf(Throwable t, Class c);

• public String getFullMessage();

• public static String getFullMessage(Throwable theT);

• public String toFullString();

• public static String toFullString(Throwable theT);

• public String getFirstAndLastMessage();

• public static String getFirstAndLastMessage(Throwable theT);

• public String getFirstAndLastStackTrace();

• public static String getFirstAndLastStrackTrace(Throwabel theT);

• public String toFirstAndLastString();

• public static String toFirstAndLastString(Throwable theT);

MISCELLANEOUS UPDATES TO COM.INQUIRA.INFRA.INQUIRAEXCEPTION

The following inner class has been removed:

public static class Test;

The following method now executes a no-operation (i.e. the method does not append the mode to the 
StringBuilder):

protected static void appendExecutionMode(StringBuilder sb);

After your custom iAuthenticator has been compiled against the freshly installed release 8.5.1 iAuthenticator 
API, rebuild the jar file(s) that contain your custom iAuthenticator class files.

To configure the freshly installed 8.5.1 Information Manager to use your custom iAuthenticator, copy the 
newly rebuilt jar file(s) to the following directories:

The freshly installed release 8.5.1 IM Management Console should already be configured to use your custom 
iAuthenticator by the steps outlined in the “Migrate Custom Settings in config.properties” section, above. After 
starting up the instance, review the configuration following the instructions below:

WebLogic <8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/InfoManager/app/WEB-
INF/lib

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/imws/app/WEB-INF/lib

Tomcat <8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/
InfoManager/WEB-INF/lib

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/imws/WEB-
INF/lib
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1 Log in to your repository in the IM Management Console with an admin user with either of the following 
IM Security Roles:

- Default Administration Role - A user with this role can perform any action on the repository he was 
created for and can only log in to that repository.

- Super Admin - A user with this role can perform any action on any repository.

- Super Support - A user with this role can perform any action on any repository.

2 Navigate to Tools > System Configure.

3 Select Go to Expert Mode.

4 Set the REMOTE_AUTHENTICATION_ENABLED configuration parameter to true.

5 Set the REMOTE_AUTHENTICATION_CLASS configuration parameter to your fully qualified custom 
authenticator class (e.g. com.company.package.CustomAuthenticator).

6 The IFieldBuilder interface was added in version 8.2.3.0. If a custom IFieldBuilder is used, 
set the REMOTE_FIELD_BUILDER_CLASS configuration parameter to your fully qualified custom 
IFieldBuilder subclass.

Migrate Custom Rich Text Area Settings
In previous releases of Information Manager, the Rich Text Area component used in the IM Management 
Console was FCKEditor version 2.6.3. In 8.5.1, this component is updated to CKEditor version 3.6.1 and 
CKFinder version 2.0.2.1. CKEditor 3.6.1 is a new version of the previous FCKEditor and is a complete 
rewrite of the product, including major changes in its architecture.

If you configured the FCKEditor in the previously installed release of Information Manager with custom 
settings, consult the documentation from http://ckeditor.com for guidelines on how to map the configuration 
settings from the FCKEditor to the CKEditor.

The freshly installed release 8.5.1 IM Management Console should already be configured to use the custom 
rich text editor image upload store paths by the steps outlined in the “Migrate Custom Settings in 
config.properties” section above. After starting up the instance, review the configuration following the 
instructions below:

1 Log in to the repository in which the resource configuration settings are configured in the IM 
Management Console with an admin user with either of the following IM Security Roles:

- Default Administration Role - A user with this role can perform any action on the repository he was 
created for and can only log in to that repository.

- Super Admin - A user with this role can perform any action on any repository.

- Super Support - A user with this role can perform any action on any repository.

2 Select Tools.

3 Select System Configure.

4 Select Resource Configuration.

5 Review the Rich Text Editor Image Upload Store Paths.

6 If the WYSIWYG Library Path has been configured to a location other than $IM_HOME/library, set 
the WYSIWYG Thumbnail Path to a different directory in a relatively similar location so the images and 
their thumbnails can be accessed through the shared storage area (e.g. /Server_Name/
Shared_Folder/library and /Server_Name/Shared_Folder/thumbnail)
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If you configured the WYSIWYG Library and WYSIWYG Thumbnail paths to locations other than 
$IM_HOME/library and $IM_HOME/thumbnail, you must manually configure the resource web 
application to access the images and thumbnails from the new locations.

FOR WEBLOGIC USERS

During the installation process, the administrator specified the resource web application context name. The 
default name is OKResources. This resource web application also hosts the images and thumbnails 
uploaded through the rich text area. The following steps must be performed on the resource web application 
specified during the installation process.

1 Start the Administration Server (if it is not running).

2 Using a web browser, navigate to the WebLogic Administration Console URL. (This can be found at 
http://<Administration Server's Listen Address>:<Administration Server's 
Listen Port>/console).

3 Provide the administration server's credentials to log in.

4 From the Domain Structure section, select Deployments to manage and control the Information 
Manager Web Applications.

5 Select the name that corresponds to the name of the resource web application.

6 Note the Path to the web application; you must navigate there to make changes.

7 Navigate to the Path and edit the weblogic.xml file of the resource web application. (This can be 
found at <8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/<Context Name>/app/
WEB-INF/weblogic.xml)

8 If the WYSIWYG Library Path has been changed, edit the virtual-directory-mapping node that 
corresponds to the library path. 

a Set the local-path node to the parent directory of the new library path. 

b Set the url-pattern node to the directory name of the new library path using the following format:

/<new_library_directory>/

For example, if the WYSIWYG Library Path is /home/username/Oracle/Knowledge/IM/
InfoManager/library, the virtual mapping should read:

<virtual-directory-mapping>
<local-path>/home/username/Oracle/Knowledge/IM/InfoManager</local-
path>
<url-pattern>/library/*</url-pattern>

</virtual-directory-mapping>

c Save the file.

9 If the WYSIWYG Thumbnail Path has been changed, edit the virtual-directory-mapping node that 
corresponds to the thumbnail path. 

a Set the local-path node to the parent directory of the new thumbnail path. 

b Set the url-pattern node to the directory name of the new thumbnail. Use the following format:  
/<new_thumbnail_directory>/

For example, if the WYSIWYG Thumbnail Path was /home/username/Oracle/Knowledge/IM/
InfoManager/thumbnail, the virtual mapping should read:

<virtual-directory-mapping>
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<local-path>/home/username/Oracle/Knowledge/IM/InfoManager</local-
path>
<url-pattern>/thumbnail/*</url-pattern>

</virtual-directory-mapping>

c Save the file.

10 From the WebLogic Administration Console, click the Lock & Edit button in the Change Center to put 
the domain in edit mode.

11 Check the check box that corresponds to the name of the resource web application that was modified.

12 Select Update.

13 Select to Redeploy this application using the following deployment files:

14 Select Finish.

15 Select Activate Changes in the Change Center to activate the modifications to the resource web 
application.

16 The changes are reflected immediately on new web application sessions. For the changes to be 
reflected on existing sessions, the managed server hosting those web applications must be restarted.

FOR TOMCAT USERS

The installation process provided individual context files that represented the web applications used to access 
the images and thumbnails uploaded through the rich text area from the default locations. These context files 
must be manually modified by the administrator to account for the change. The following steps must be 
performed on every instance of Oracle Knowledge. 

WARNING!   The following steps include a restart of the application server.

1 Open the ICE Environment from the Information Manager instance.

2 Execute inquiraim.sh stop on Linux, inquiraim stop on Windows to shutdown the instance.

3 On the file system, navigate to <8.5.1 INSTALL DIR>/instances/<INSTANCE>/
appserverim/conf/Catalina/<InfoManager Host>.

4 If the WYSIWYG Library Path has been changed:

a Rename the library.xml context file to <DIRECTORY>.xml, where DIRECTORY is the directory 
name of the new library path. 

b Edit the file and set the docBase attribute of the Context element to the fully qualified path to the 
new library path. 

c Set the path attribute of the Context element to the directory name of the new library path using the 
following format:

/<directory_of_new_library_path>

For example, if the WYSIWYG Library Path is /home/username/Oracle/Knowledge/IM/
InfoManager/library, the context file should be named library.xml and its contents should 
contain the following:

<?xml version='1.0' encoding='utf-8'?>
<Context docBase="/home/username/Oracle/Knowledge/IM/InfoManager/
library" path="/library">

<Resources className="org.apache.naming.resources.FileDirContext"
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              allowLinking="true"/>
</Context>

d Save the file.

5 If the WYSIWYG Thumbnail Path has been changed:

a Rename the thumbnail.xml context file to <DIRECTORY>.xml, where DIRECTORY is the directory 
name of the new thumbnail path.

b Edit the file and set the docBase attribute of the Context element to the fully qualified path to the 
new thumbnail path.

c Set the path attribute of the Context element to the directory name of the new thumbnail path using 
the following format:

/<directory_of_new_thumbnail_path>

For example, if the WYSIWYG Thumbnail Path is /home/username/Oracle/Knowledge/IM/
InfoManager/thumbnail, the context file should be named thumbnail.xml and its contents 
should contain the following:

<?xml version='1.0' encoding='utf-8'?>
<Context docBase="/home/username/Oracle/Knowledge/IM/InfoManager/
thumbnail" path="/thumbnail">

<Resources className="org.apache.naming.resources.FileDirContext"
              allowLinking="true"/>

</Context>

d Save the file.

6 Delete the Tomcat work directory at <8.5.1 INSTALL DIR>/instances/<INSTANCE>/
appserverim/work.

7 From the ICE Environment, start the application by executing inquiraim.sh start on Linux, 
inquiraim start on Windows.

Migrate Custom JGroups Settings
This section describes how to migrate custom JGroups configurations from previous releases into the 8.5.1 
installation.

In previous releases, customizations could have been made to the JGroups configuration file, jgroups-
default.xml. This file could have been located in the following location (where WEB_APP refers to InfoManager, 
imws, or any IM Tag Library based web application):

<PRE-8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/<WEB APP>/
WEB-INF/Library/Frameworks/ERJGroupsSynchronizer.framework/Resources/jgroups-
default.xml

If you’ve modified this file, follow the instructions below to properly migrate the customizations to the 8.5.1 
installation.

Because the JGroups version was updated to 2.11 in this release, start with the latest jgroups-default.xml file 
from the 8.5.1 installation.
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For WebLogic Users
1 Navigate to <8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/InfoManager/app/

WEB-INF/lib.

2 Locate the erjgroupssynchronizer-5.0.jar file and unzip it to a directory we’ll refer to as 
<TMP>.

3 Copy the <TMP>/Resources/jgroups-default.xml to the following location:

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/InfoManager/app/WEB-INF/
InfoManager.woa/Contents/WebServerResources 

Important!   Rename the file to any other name so that there is no conflict with the default 
configuration file (e.g. jgroups-custom.xml).

4 Delete the <TMP> directory.

5 Apply your customizations from the previously customized jgroups-default.xml to the newly 
copied file.

6 Distribute the newly customized file to the following locations and register your customized file with the 
application:

For InfoManager

a Copy the newly customized file to following directory:

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/InfoManager/app/WEB-INF/
InfoManager.woa/Contents/WebServerResources

b Set the er.extensions.jgroupsSynchronizer.properties property to the file name of the 
newly customized file (e.g. er.extensions.jgroupsSynchronizer.properties=jgroups-
custom.xml) in the following file: 

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/InfoManager/app/WEB-INF/
InfoManager.woa/Contents/Resources/Properties

You must uncomment this property when you edit it, as it is commented out by default.

Important!   Only specify the name of the file; do NOT specify the full path to the file.

For IMWS

a Copy the newly customized file to following directory:

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/imws/app/WEB-INF/
IMWebServices.woa/Contents/WebServerResources

b Set the er.extensions.jgroupsSynchronizer.properties property to the file name of the 
newly customized file (e.g. er.extensions.jgroupsSynchronizer.properties=jgroups-
custom.xml) in the following file:

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/imws/app/WEB-INF/
IMWebServices.woa/Contents/Resources/Properties

You must uncomment this property when you edit it, as it is commented out by default.

Important!   Only specify the name of the file; do NOT specify the full path to the file.
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For InfoCenter

a Copy the newly customized file to the following directory:

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/infocenter/app/WEB-INF/
IMTagLibrary.woa/Contents/WebServerResources

b Set the er.extensions.jgroupsSynchronizer.properties property to the file name of the 
newly customized file (e.g. er.extensions.jgroupsSynchronizer.properties=jgroups-
custom.xml) in the following file:

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/infocenter/app/WEB-INF/
IMTagLibrary.woa/Contents/Resources/Properties

You must uncomment this property when you edit it, as it is commented out by default.

Important!   Only specify the name of the file; do NOT specify the full path to the file.

For any other IM Tag Library based web application

a Copy the newly customized file to the following directory:

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/<WEB_APP>/app/WEB-INF/
IMTagLibrary.woa/Contents/WebServerResources

b Set the er.extensions.jgroupsSynchronizer.properties property to the file name of the 
newly customized file (e.g. er.extensions.jgroupsSynchronizer.properties=jgroups-
custom.xml) in the following file:

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/<WEB_APP>/app/WEB-INF/
IMTagLibrary.woa/Contents/Resources/Properties

You must uncomment this property when you edit it, as it is commented out by default.

Important!   Only specify the name of the file; do NOT specify the full path to the file.

7 Restart the instance for the changes to take effect.

For Tomcat Users
1 Navigate to <8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/

InfoManager/WEB-INF/lib

2 Locate the erjgroupssynchronizer-5.0.jar file and unzip it to a directory we’ll refer to as 
<TMP>

3 Copy the <TMP>/Resources/jgroups-default.xml to the following location.

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/InfoManager/
WEB-INF/InfoManager.woa/Contents/WebServerResources 

Important!   Rename the file to any other name so that there is no conflict with the default 
configuration file (e.g. jgroups-custom.xml).

4 Delete the <TMP> directory

5 Apply your customizations from the previously customized jgroups-default.xml to the newly 
copied file.

6 Distribute the newly customized file to the following locations and register your customized file with the 
application:
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For InfoManager

a Copy the newly customized file to following directory:

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/InfoManager/
WEB-INF/InfoManager.woa/Contents/WebServerResources

b Set the er.extensions.jgroupsSynchronizer.properties property to the file name of the 
newly customized file (e.g. er.extensions.jgroupsSynchronizer.properties=jgroups-
custom.xml) in the following file:

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/InfoManager/
WEB-INF/InfoManager.woa/Contents/Resources/Properties

You must uncomment this property when you edit it, as it is commented out by default.

Important!   Only specify the name of the file; do NOT specify the full path to the file.

For IMWS

a Copy the newly customized file to following directory:

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/imws/WEB-INF/
IMWebServices.woa/Contents/WebServerResources

b Set the er.extensions.jgroupsSynchronizer.properties property to the file name of the 
newly customized file (e.g. er.extensions.jgroupsSynchronizer.properties=jgroups-
custom.xml) in the following file:

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/imws/WEB-INF/
IMWebServices.woa/Contents/Resources/Properties

You must uncomment this property when you edit it, as it is commented out by default.

Important!   Only specify the name of the file; do NOT specify the full path to the file.

For InfoCenter

a Copy the newly customized file to the following directory:

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/infocenter/
WEB-INF/IMTagLibrary.woa/Contents/WebServerResources

b Set the er.extensions.jgroupsSynchronizer.properties property to the file name of 
the newly customized file (e.g. 
er.extensions.jgroupsSynchronizer.properties=jgroups-custom.xml) in the 
following file:

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/infocenter/
WEB-INF/IMTagLibrary.woa/Contents/Resources/Properties

You must uncomment this property when you edit it, as it is commented out by default.

Important!   Only specify the name of the file; do NOT specify the full path to the file.

For any other IM Tag Library based web application

a Copy the newly customized file to the following directory:

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/<WEB_APP>/
WEB-INF/IMTagLibrary.woa/Contents/WebServerResources

b Set the er.extensions.jgroupsSynchronizer.properties property to the file name of the 
newly customized file (e.g. er.extensions.jgroupsSynchronizer.properties=jgroups-
custom.xml) in the following file:
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<8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/<WEB_APP>/
WEB-INF/IMTagLibrary.woa/Contents/Resources/Properties

You must uncomment this property when you edit it, as it is commented out by default.

Important!   Only specify the name of the file; do NOT specify the full path to the file.

7 Restart the instance for the changes to take effect.

Migrate Custom Profanity Lists
This section describes how to migrate a customized profanity list that is used with the IM Profanity Filter for 
Discussion Boards from a previously installed release to the freshly installed release 8.5.1 Information 
Manager.

The text used to flag inappropriate messages containing profanity can be found in the previous release under:

<Pre-8.5.1 INSTALL DIR>/InfoManager/config/SYSTEM/profanitylist.txt

If this file has been customized to add or remove profane words, copy the customized file to the 8.5.1 
installation under and replace the existing file:

<8.5.1 INSTALL DIR>/InfoManager/config/SYSTEM/profanitylist.txt

Migrate Custom Delegate Classes
This sections describes how to migrate custom delegate classes from the previously installed release to the 
freshly installed release 8.5.1 Information Manager.

Though none of the existing delegate class interface signatures have changed in 8.5.1, you must recompile 
the source code of your custom delegate classes with the freshly installed release 8.5.1 imservices-
8.5.1.jar in the class path and the previously released imservices.jar file removed from the class 
path.

After your custom delegate class source code has been compiled against the freshly installed release 8.5.1 
installation, rebuild the jar file(s) that contain your custom class files.

To configure the freshly installed 8.5.1 Information Manager to use your custom delegate classes, copy the 
newly rebuilt jar file(s) to the following directories (where TAGLIB_APP refers to InfoCenter, iConnect, SSP) 
and restart the instance:

WebLogic <8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/InfoManager/app/
WEB-INF/lib

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/imws/app/WEB-INF/
lib

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/<TAGLIB_APP>/app/
WEB-INF/lib
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The freshly installed release 8.5.1 IM Management Console should already be configured to use your custom 
delegate classes by the steps outlined in the “Migrate Custom Settings in config.properties section, above.

Migrate Custom Allowed HTML Tags
This section describes how to migrate a customized allowed HTML tag list that is used with the IM HTML 
Filter for Discussion Boards from a previously installed release to the freshly installed release 8.5.1 
Information Manager.

The HTML tags allowed within discussion messages can be found in the previous release under:

<Pre-8.5.1 INSTALL DIR>/InfoManager/config/SYSTEM/allowedHTMLTags.txt

If this file has been customized to add or remove allowed HTML tags, copy the customized file to the 8.5.1 
installation and replace the existing file:

<8.5.1 INSTALL DIR>/InfoManager/config/SYSTEM/allowedHTMLTags.txt

Tomcat <8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/

InfoManager/WEB-INF/lib

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/imws/
WEB-INF/lib

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/
<TAGLIB_APP>/WEB-INF/lib
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Troubleshooting the Information Manager 
Database Upgrade Utility

TABLE 4. Common Error Messages and Solutions 

Error Message Use Case Suggested Solution

No keystore location  
specified. Please execute 
this script from an ICE  
window.

When the utility is  
verifying access to the 
Keystore during  
initialization.

Ensure you are running the utility from the ICE  
environment of the 8.5.1 parallel installation  
environment.

Keystore is not valid. When the utility is  
verifying access to the 
Keystore during  
initialization.

Ensure the user who is executing has the necessary file 
permissions on the Keystore and its files. For more 
information on Keystore file permissions, review the 
8.5.1 Installation Guide.

No IM_HOME location  
specified. Please execute 
this script from an ICE  
window.

When the utility is verify-
ing access to the  
Information Manager con-
figuration files during  
initialization.

Ensure you are running the utility from the ICE  
environment of the 8.5.1 parallel installation  
environment.

IM_HOME path <8.5.1 
INSTALL DIR>/Info-
Manager does not exist or 
is not a valid Information 
Manager home folder, please 
verify the path.

When the utility is  
verifying access to the 
Information Manager  
configuration files during 
initialization.

Because the Upgrade Guide instructed the users to  
perform a fresh install of 8.5.1, the default location for 
the IM_HOME path after installation is <8.5.1 
INSTALL DIR>/InfoManager. No customizations 
to move this location should have been performed at 
this point. If customizations have been made, modify 
the im_database_upgrade.{sh|bat} file and 
set the -DIM_HOME argument to the customized  
location of the Information Manager configuration files.

IO Exception on <8.5.1 
INSTALL DIR>/Info-
Manager/config/
IMADMIN/applica-
tion.properties

When the utility is  
accessing the database 
configuration during  
initialization.

Make sure the file exists and is readable by the user 
executing the utility.

SQL Exception or Class Not 
Found Exception on the 
Database Driver

When the utility is  
verifying access to the 
database.

Make sure the database is accessible and review the 
connection information in <8.5.1 INSTALL DIR>/
InfoManager/config/IMADMIN/applica-
tion.properties. If the password is not valid, use 
the encrypt.{bat|sh} command from the ICE environ-
ment to encrypt the correct password and save it to the 
file; this change will also need to be made to <8.5.1 
INSTALL DIR>/InfoManager/config/
IMWEBSERVICES/application.properties 
if IMWS was installed; as well as <8.5.1 INSTALL 
DIR>/InfoManager/config/<REPOSI-
TORY>/application.properties if a web 
application was installed.
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FAILED: The Information 
Manager Database Upgrade 
cannot continue until all 
duplicate e-mail addresses 
have been resolved!

When the utility is  
verifying that the pre-
upgrade requirement to 
resolve any shared email 
addresses across users 
has been fulfilled.

Follow the instructions in the Upgrade Guide to fulfill the 
pre-upgrade requirements.

FAILED: The Information 
Manager Database Upgrade 
cannot continue until all 
duplicate content text 
records have been resolved!

When the utility is  
verifying that the system is 
clear of any duplicate  
content text records. (This 
is expected)

Follow the instructions in the Upgrade Guide to resolve 
the duplicate content text records.

Failed to removed duplicate 
content texts indicated in 
<Report File>

When running with the -
delete.from.report 
argument, the utility failed 
to remove the duplicate 
content text records iden-
tified to be removed from 
the system. 

Review your modified report file to ensure no columns 
were removed and that only the values in 
RemoveRecord column have been modified. After the 
report has been reviewed and/or modified, rerun the 
utility supplying the -delete.from.report= 
<full path to the modified report 
file>. If the utility fails again with this error, contact 
Oracle Customer Support.

No current installations exist 
to upgrade. 

When the utility is  
verifying the starting point 
is valid to upgrade.

Most likely the release you are on is pre-8.1.2.1. The 
utility does not support pre-8.1.2.1 releases. Contact 
Oracle Customer Support. You will also get this mes-
sage if you are already on release 8.5.1.

ORA-01653: unable to 
extend table <TABLE> by 
<SIZE> in tablespace 
<TABLESPACE>.

At any point the utility is 
executing on an Oracle 
DB and a failure occurs 
with this message in the 
error stack trace.

Add 30GB to the UNDO table space and 100GB to the 
schema's table space in addition to the resources 
already allocated to those table spaces in order to com-
plete the upgrade. The table spaces can be reduced 
back to the normal size once the upgrade has com-
pleted successfully.

SQL Exceptions on DML 
(Insert, Update and Delete) 
statements that caused the 
script to fail with errors

When the utility is  
executing a pre-data 
migration or post-data 
migration SQL script.

If the error is a table or column does not exist exception, 
verify that the database schema has not been manually 
manipulated and contact Oracle Customer Support.

SQL Exceptions on Alter 
Table Add Column  
statements

When the utility is  
executing a pre-data 
migration or post-data 
migration SQL script.

If the error is a table does not exist exception, verify that 
the database schema has not been manually manipu-
lated and contact Oracle Customer Support.

SQL Exceptions on Alter 
Table Drop Column  
statements

When the utility is  
executing a pre-data 
migration or post-data 
migration SQL script.

If the error is a column does not exist exception, the col-
umn should have existed, but in this case, modify the 
offending script to remove the corresponding ALTER 
TABLE DROP statement and restart the utility with no 
arguments. Pre-data migration and post-data migration 
SQL scripts can be found under <TMP>/sql/oracle for 
Oracle database users and <TMP>/sql/mssql for SQL 
Server database users.

If the error is a table does not exist exception, verify that 
the database schema has not been manually manipu-
lated and contact Oracle Customer Support.

TABLE 4. Common Error Messages and Solutions (Continued)

Error Message Use Case Suggested Solution
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SQL Exceptions on Alter 
Table Add Constraint state-
ments

When the utility is  
executing a pre-data 
migration or post-data 
migration SQL script.

If the error is a table or column does not exist exception, 
verify that the database schema has not been manually 
manipulated and contact Oracle Customer Support.

SQL Exceptions on Create 
View statements

When the utility is  
executing a pre-data 
migration or post-data 
migration SQL script.

If the error is a table or column does not exist exception, 
verify that the database schema has not been manually 
manipulated and contact Oracle Customer Support.

SQL Exceptions on Create 
Index statements

When the utility is  
executing a pre-data 
migration or post-data 
migration SQL script.

If the error is a table or column does not exist exception, 
verify that the database schema has not been manually 
manipulated and contact Oracle Customer Support.

SQL Exceptions on Drop 
Table statements

When the utility is execut-
ing a pre-data migration or 
post-data migration SQL 
script.

If the error is a table does not exist exception, the table 
should have existed, but in this case, modify the  
offending script to remove the corresponding DROP 
TABLE statement and restart the utility with no  
arguments. Pre-data migration and post-data migration 
SQL scripts can be found under <TMP>/sql/oracle for 
Oracle database users and <TMP>/sql/mssql for SQL 
Server database users.

SQL Exceptions related to 
database connectivity during 
a data migration class execu-
tion that caused the class to 
fail with errors

When a data migration 
class is executing SQL 
through JDBC.

If the error is related to database connectivity, make 
sure the database is accessible and review the connec-
tion information in <8.5.1 INSTALL DIR>/
InfoManager/config/IMADMIN/applica-
tion.properties. If the password is not valid, use 
the encrypt.{bat|sh} command from the ICE environ-
ment to encrypt the correct password and save it to the 
file; this change will also need to be made to <8.5.1 
INSTALL DIR>/InfoManager/config/
IMWEBSERVICES/application.properties 
if IMWS was installed as well as <8.5.1 INSTALL 
DIR>/InfoManager/config/<REPOSI-
TORY>/application.properties if a web 
application was installed.

SQL Exceptions not related 
to database connectivity  
during a data migration class 
execution, not including 
com.inquira.infoman-
ager.data.migration.IMMet-
ricsMerger, that caused the 
class to fail with errors

When a data migration 
class is executing SQL 
through JDBC.

If the error is a table or column does not exist exception, 
verify that the database schema has not been manually 
manipulated and contact Oracle Customer Support.

TABLE 4. Common Error Messages and Solutions (Continued)

Error Message Use Case Suggested Solution
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SQL Exception during the 
com.inquira.infoman-
ager.data.migration.IMMet-
ricsMerger data migration 
class that caused the class to 
fail with errors

When the com.inquira.info 
manager.data.migration 
.IMMetricsMerger data 
migration class is execut-
ing the corresponding 
BUILD_immetricsmerger.s
ql SQL script or executing 
SQL through JDBC.

If the exception message is ERROR: While trying to 
run SQL File: sql/<oracle|mssql>/
BUILD_immetricsmerger.sql, use the suggestions 
from the sections above that apply when the utility is 
executing a pre-data migration or post-data migration 
SQL script.

Otherwise, if the error is a table or column does not 
exist exception, verify that the database schema has 
not been manually manipulated and contact Oracle 
Customer Support.

CVDatabase Exceptions  
during a migration class  
execution that caused the 
class to fail with errors

When a data migration 
class is modifying the data 
through WebObjects.

Verify that the database is not being modified  
concurrently by another process and contact Oracle  
Customer Support.

Scheduler Exception during 
a migration class execution 
that caused the class to fail 
with errors

When the 
com.inquira.infoman-
ager.data.migra-
tion.IM8500_NewBatchJo
bs or the com.inquira.info-
manager.data.migration 
.IMMetricsMerger data 
migration classes are reg-
istering new batch jobs 
with the Quartz Scheduler.

There is an underlying problem with the Quartz  
Scheduler; contact Oracle Customer Support.

Exception with message The 
Publish privilege does not 
exist. Please run database 
update scripts.

When the com.inquira 
.infomanager.data.migra-
tion.IM8500_PublishPrivil
ege data migration class 
is attempting to add the 
new publish privilege to 
the content channel  
privileges.

This signifies that the BUILD_8500.sql pre-migration 
SQL script did not complete successfully with no errors. 
Review the <8.5.1 INSTALL DIR>/InfoMan-
ager/logs/UPGRADE/<Install Date>/
8.5.0.0/1_pre-migration-SQL/
BUILD_8500.log for more information.

All other errors that caused 
the utility to fail

During any part of the  
utility's execution.

Contact Oracle Customer Support.

TABLE 4. Common Error Messages and Solutions (Continued)

Error Message Use Case Suggested Solution
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CHAPTER 4

Upgrading InfoCenter and Web 
Applications 

This chapter provides instructions to upgrade and migrate custom settings for InfoCenter and other web 
applications.

Important!   The IM Upgrade must be performed successfully before continuing with the InfoCenter 
upgrade. 

Upgrading InfoCenter and Web Application 
Components
The InfoCenter and web application components upgrade is described in the following sections:

• Migrate Custom Settings In the InfoCenter Web Application Deployment Descriptor

• Migrate a Custom iAuthenticator

• Migrate Custom Rich Text Area Settings

• Migrate Custom JGroups Settings

• Migrate Custom Tag Library Descriptors

• Migrate Custom CSS

• Migrate Custom Java Server Pages

• Migrate Custom InfoCenter Properties

• Migrate Custom ESAPI Properties

• Migrate Custom InfoCenter Resources
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Migrate Custom Settings In the InfoCenter Web 
Application Deployment Descriptor
This section will describe how to migrate custom settings in the deployment descriptor of the previously 
installed version of the InfoCenter web application to the freshly installed version 8.5.1 InfoCenter web 
application.

The web application’s deployment descriptor for the previously installed and deployed version of the 
InfoCenter web application can be found in (where CONTEXT_NAME refers to the deployment context name 
of the InfoCenter web application):

<Pre-8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/
<CONTEXT_NAME>/WEB-INF/web.xml

The web application’s deployment descriptor for the freshly installed version 8.5.1 InfoCenter web application 
can be found in:

The freshly installed 8.5.1 deployment descriptor uses the following descriptor elements:

• Context Parameters

• Filters and Filter Mappings

• Listeners

• Servlets and Servlet Mappings

• Session Configurations

• JSP Configurations

Review the deployment descriptor for the previously installed version of the InfoCenter web application. If the 
web.xml contained any descriptor elements not mentioned above, add them to the freshly installed version 
8.5.1 web.xml.

For every descriptor element we use in the freshly installed version 8.5.1 InfoCenter web application’s 
deployment descriptor, we will outline the out of the box settings and how to maintain your customizations 
form the previously installed version of the InfoCenter web application’s deployment descriptor.

Context Parameters

WOAPPMODE PARAMETER

<context-param>
<param-name>WOAppMode</param-name> 
<param-value>Deployment</param-value>

</context-param>

This parameter setting has not changed for 8.5.1.

WebLogic <8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/infocenter/app/WEB-
INF/web.xml

Tomcat <8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/
infocenter/WEB-INF/web.xml
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WOCLASSPATH PARAMETER

<context-param>
<param-name>WOClasspath</param-name>
<param-value>WEBINFROOT/IMTagLibrary.woa/Contents/Resources/Java/
imtaglibrary-8.5.1.jar</param-value>

</context-param>

This parameter has been updated in 8.5.1. In versions prior to 8.5.1, the parameter’s value was:

<param-value>
WEBINFROOT/Library/Frameworks/JavaJDBCAdaptor.framework/Resources/Java/
javajdbcadaptor.jar
WEBINFROOT/Library/Frameworks/JavaEOControl.framework/Resources/Java/
javaeocontrol.jar
WEBINFROOT/Library/Frameworks/IMModel.framework/Resources/Java/immodel.jar
WEBINFROOT/Library/Frameworks/JavaWOJSPServlet.framework/Resources/Java/
javawojspservlet.jar
WEBINFROOT/Library/Frameworks/IMServices.framework/Resources/Java/
imservices.jar
WEBINFROOT/Library/Frameworks/JavaWOExtensions.framework/Resources/Java/
JavaWOExtensions.jar
WEBINFROOT/Library/Frameworks/IMFoundation.framework/Resources/Java/
imfoundation.jar
WEBINFROOT/Library/Frameworks/JavaWebObjects.framework/Resources/Java/
javawebobjects.jar
WEBINFROOT/Library/Frameworks/JavaEOProject.framework/Resources/Java/
javaeoproject.jar
WEBINFROOT/Library/Frameworks/JavaEOAccess.framework/Resources/Java/
javaeoaccess.jar
WEBINFROOT/Library/Frameworks/JavaFoundation.framework/Resources/Java/
javafoundation.jar
WEBINFROOT/Library/Frameworks/JavaWebServicesSupport.framework/Resources/Java/
javawebservicessupport.jar
WEBINFROOT/Library/Frameworks/JavaWebServicesClient.framework/Resources/Java/
javawebservicesclient.jar
WEBINFROOT/Library/Frameworks/ERJars.framework/Resources/Java/ERJars.jar
WEBINFROOT/Library/Frameworks/ERExtensions.framework/Resources/Java/
ERExtensions.jar
WEBINFROOT/Library/Frameworks/ERJars.framework/Resources/Java/
erxservletadaptor.jar
WEBINFROOT/Library/Frameworks/ERJGroupsSynchronizer.framework/Resources/Java/
ERJGroupsSynchronizer.jar
WEBINFROOT/IMTagLibrary.woa/Contents/Resources/Java/imtaglibrary.jar

</param-value>

If the web.xml for the previously installed version of the InfoCenter web application specified any other class 
files, jar files or directories not listed above in the value of the WOClasspath parameter, add them to the 
WOClasspath parameter value of the freshly installed version 8.5.1 web.xml.

WOAPPLICATIONCLASS PARAMETER

<context-param>
<param-name>WOApplicationClass</param-name> 
<param-value>com.inquira.client.Application</param-value>

</context-param>

This parameter setting has not changed for 8.5.1.
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APPLICATIONRESOURCECLASS PARAMETER

<context-param>
<param-name>ApplicationResourceClass</param-name> 
<param-value>ApplicationResources</param-value>

</context-param>

This parameter setting has not changed for 8.5.1

CUSTOM CONTEXT PARAMETERS

If the web.xml for the previously installed version of the IM Management Console web application specified 
any other context parameters, add them to the freshly installed version 8.5.1 web.xml.

Filters and Filter Mappings

IQOBJECTSTOREASSIGNINGFILTER FILTER

This filter should/will be called before SecurityFilter. Because SecurityFilter uses EOFactory, this filter need to 
do the necessary setup first.
<filter>

<filter-name>IQObjectStoreAssigningFilter</filter-name> 
<filter-class>com.inquira.foundation.utilities.IQObjectStoreAssigningFilter</
filter-class> 
<init-param>

<description>Set this flag to true in IM Console, InfoCenter so that User 
specific ObjectStore is stored in HttpSession. But in IMWS, set this to 
false.</description>
<param-name>attachObjectStoreToHttpSession</param-name>
<param-value>true</param-value>

</init-param>
</filter>

The IQObjectStoreAssigningFilter filter is new in 8.5.1.

IQOBJECTSTOREASSIGNINGFILTER FILTER MAPPING

<filter-mapping>
<filter-name>IQObjectStoreAssigningFilter</filter-name> 
<url-pattern>/*</url-pattern>

</filter-mapping>

The IQObjectStoreAssigningFilter filter mapping is new in 8.5.1.

SECURITY FILTER

<filter>
<filter-name>Security Filter</filter-name>
<filter-class>com.inquira.client.filters.SecurityFilter</filter-class>

<init-param>
<param-name>filter-uri-prefix</param-name>
<param-value>/index</param-value>

</init-param>
</filter>
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The Security Filter is new in 8.5.1.

SECURITY FILTER MAPPING

<filter-mapping>
<filter-name>Security Filter</filter-name>
<url-pattern>/index/*</url-pattern>
<url-pattern>/WebObjects/*</url-pattern>
<url-pattern>/controller/*</url-pattern>
<url-pattern>*.jsp</url-pattern>

</filter-mapping>

The Security Filter filter mapping is new in 8.5.1.

IMTOKENSCANNER FILTER

This filter is used to dynamically replace the IM replacement tokens that can be embedded in the content

By default all request must go thru the IM index servlet in order to be scanned for replacement tokens. You can 
add additional filter mappings as required.

<filter>
<filter-name>IMTokenScanner Filter</filter-name>
<filter-class>com.inquira.services.application.IMTokenFilter</filter-class>

</filter>

The IMTokenScanner filter has not changed in 8.5.1.

IMTOKENSCANNER FILTER MAPPING

<filter-mapping>
<filter-name>IMTokenScanner Filter</filter-name>
<url-pattern>/index/*</url-pattern>

</filter-mapping>

The IMTokenScanner filter mapping has not changed in 8.5.1.

IQSESSIONFILTER FILTER

Filter each request to see if new IQSession id is being set as well as bind new/existing ids to request/response 
thread.

<filter>
<filter-name>IQSessionFilter</filter-name>
<filter-class>com.inquira.client.filters.IQSessionFilter</filter-class>

</filter>

The IQSessionFilter filter is new in 8.5.1.

IQSESSIONFILTER FILTER MAPPING

<filter-mapping>
<filter-name>IQSessionFilter</filter-name>
<url-pattern>/index/*</url-pattern>

</filter-mapping>

The IQSessionFilter filter mapping is new in 8.5.1.
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XSSFILTER FILTER

This filter is used to dynamically replace the Http request's parameters if there is an XSS security concern.

The param-value is the RegEx pattern that should be used to filter out the "malicious code" in parameters. the 
pattern should be separated by delimiter of ":::" and quoted in CDATA .

e.g. 

<![CDATA[<(script)[^>]*>(.*?)</script>:::another pattern]]>
 -->
<filter>

<filter-name>XSSFilter</filter-name>
<filter-class>com.inquira.servletfilter.XSSFilter</filter-class>
<init-param>

<param-name>XSSRegEx</param-name>
<param-value><![CDATA[<(script)[^>]*>(.*?)</script>]]></param-value>

</init-param>
</filter>

The XSSFilter filter was disabled in 8.2.3.0.

XSSFILTER FILTER MAPPING

<filter-mapping>
<filter-name>XSSFilter</filter-name>
<url-pattern>/index/*</url-pattern>

</filter-mapping>

The XSSFilter filter mapping was disabled in 8.2.3.0.

Custom Filters and Filter Mappings
If the web.xml for the previously installed version of the InfoCenter web application specified any other filters 
and filter mappings that were not removed in 8.5.1, add them to the freshly installed version 8.5.1 web.xml.

LISTENERS

IQEncoder Listener

<listener>
<listener-class>com.inquira.esapi.IQEncoderListener</listener-class> 

</listener>

The IQEncoder listener has not changed in 8.5.1. It became available in 8.2.3.0.

Configuration Context Listener

<listener>
<listener-class>com.inquira.client.configuration.ContextListener</listener-
class>

</listener>

The configuration context listener has not changed in 8.5.1.

InQuira HTTP Session Listener

<listener>
<listener-class>com.inquira.services.webcomponents.IQHttpSessionListener</
listener-class> 
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</listener>

The InQuira HTTP session listener has not changed in 8.5.1. It became available in 8.1.3.1.

CUSTOM LISTENERS

If the web.xml for the previously installed version of the InfoCenter web application specified any other 
listeners, add them to the freshly installed version 8.5.1 web.xml.

Servlets and Servlet Mappings

WOSERVLETADAPTOR SERVLET

<servlet>
<servlet-name>WOServletAdaptor</servlet-name>
<servlet-class>er.extensions.jspservlet.ERXServletAdaptor</servlet-class>
<load-on-startup>1</load-on-startup>

</servlet>

The WOServletAdaptor servlet has not changed in 8.5.1.

WOSERVLETADAPTOR SERVLET MAPPING

<servlet-mapping>
<servlet-name>WOServletAdaptor</servlet-name>
<url-pattern>/WebObjects/*</url-pattern>

</servlet-mapping>

The WOServletAdaptor servlet mapping has not changed in 8.5.1.

CONTROLLER SERVLET
<servlet>

<servlet-name>Controller</servlet-name>
<servlet-class>

com.inquira.client.controller.Controller
</servlet-class>
<load-on-startup>3</load-on-startup>

</servlet>

The Controller servlet  has not changed in 8.5.1.

CONTROLLER SERVLET MAPPING

<servlet-mapping>
<servlet-name>Controller</servlet-name>
<url-pattern>/controller/*</url-pattern>

</servlet-mapping>

The Controller servlet mapping has not changed in 8.5.1.

INDEX SERVLET

<servlet>
<servlet-name>Index</servlet-name>
<servlet-class>
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com.inquira.client.controller.Index
</servlet-class>
<load-on-startup>2</load-on-startup>

</servlet>

The Index servlet has not changed in 8.5.1.

INDEX SERVLET MAPPING

<servlet-mapping>
<servlet-name>Index</servlet-name>
<url-pattern>/index/*</url-pattern>

</servlet-mapping>

The Index servlet mapping has not changed in 8.5.1.

CKFINDERCONNECTORSERVLET SERVLET

<servlet>
<servlet-name>CKFinderConnectorServlet</servlet-name>
<servlet-class>com.inquira.services.components.CKFinderConnectorServlet</
servlet-class>
<init-param>

<param-name>configuration</param-name>
<param-value>com.inquira.services.components.CKFinderConfiguration</param-
value>

</init-param>
<init-param>

<param-name>XMLConfig</param-name>
<param-value>/WEB-INF/ckfinder_config.xml</param-value>

</init-param>
<init-param>

<param-name>debug</param-name>
<param-value>false</param-value>

</init-param>
<load-on-startup>4</load-on-startup>

</servlet>

The CKFinderConnectorServlet servlet is new in 8.5.1.

CKFINDERCONNECTORSERVLET  SERVLET MAPPINGS

<servlet-mapping>
<servlet-name>CKFinderConnectorServlet</servlet-name>
<url-pattern>/resources/application/components/ckfinder/core/connector/java/
connector.java</url-pattern>

</servlet-mapping>

The CKFinderConnectorServlet servlet mapping is new in 8.5.1.

Custom Servlets and Servlet Mappings
If the web.xml for the previously installed version of the InfoCenter web application specified any other 
servlets and servlet mappings, add them to the freshly installed version 8.5.1 web.xml. Be sure to start the 
load on startup value for the custom servlets at 5 in order to maintain the instantiation order of the out of the 
box servlets with the custom servlets.
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Session Configurations
<session-config>

<session-timeout>30</session-timeout>
</session-config>

The session timeout defines the default session timeout interval for all sessions created in this web 
application. The default value is 30 minutes. This default value has not changed in 8.5.1. The specified 
timeout must be expressed in a whole number of minutes. If the timeout is 0 or less, the container 
ensures the default behavior of sessions is never to time out. 

If the web.xml for the previously installed version of the InfoCenter web application configured the session 
timeout to a custom value, configure the session timeout with the custom value in the freshly installed version 
8.5.1 web.xml.

JSP Configurations
<jsp-config>

<taglib>
<taglib-uri>/IMDiscussionBoards</taglib-uri>
<taglib-location>/WEB-INF/tlds/discussionboards.tld</taglib-location>

</taglib>
<taglib>

<taglib-uri>/IMTaglib</taglib-uri>
<taglib-location>/WEB-INF/tlds/inquira.tld</taglib-location>

</taglib>
</jsp-config>

The taglib node defines the tag library descriptors that are used by the web application. The defaults for 
InfoCenter include discussionboards.tld and inquira.tld. These default descriptor declarations have not 
changed in 8.5.1.

If the web.xml for the previously installed version of the InfoCenter web application configured other tag 
library descriptors, configure the other descriptors in the freshly installed version 8.5.1 web.xml.

Migrate a Custom iAuthenticator
This section describes how to migrate a custom iAuthenticator used to authenticate users in the previously 
installed release of Information Manager to the freshly installed release 8.5.1 Information Manager.

The freshly installed version 8.5.1 iAuthenticator API Java documentation can be found under:

<8.5.1 INSTALL DIR>/InfoManager/docs/iAuthentication/index.html

Review the 8.5.1 iAuthenticator API Java documentation for updates to the API.

The freshly installed release 8.5.1 iAuthenticator API can be found in the following .jar file:

<8.5.1 INSTALL DIR>/InfoManager/clientLibrary/Java/infra.jar

The previously installed release of the iAuthenticator API may have been contained in one of the following jar 
files:

• infra-1.0.jar together with shared.jar

• inquira-infra-1.1.jar
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• inquira-infra-1.1.1.jar

Though none of the existing iAuthenticator interface signatures have changed in 8.5.1, you must recompile 
the source code of your custom iAuthenticator with the freshly installed release 8.5.1 infra.jar in the class path 
and the previously installed release infra jar file(s) removed from the class path.

Note:   The com.inquira.infra.InquiraException class has changed in 8.5.1. If your custom iAuthenticator has 
any classes that extend this class, review the changes below to resolve potential compilation issues.

REMOVED COM.INQUIRA.INFRA.INQUIRAEXCEPTION FIELDS

• public static final int UNKNOWN = 0;

• public static final int TRANSACTION_RETRY = 2;

• public static final int APPLICATION_FATAL = 3;

• protected static ResourceBundle resources;

• protected static ResourceBundle logResources;

• protected static HashMap resourceFormats = new HashMap();

REMOVED COM.INQUIRA.INFRA.INQUIRAEXCEPTION CONSTRUCTORS

• public InquiraException(String id, Object[] args, int disposition);

• public InquiraException(String id, Object[] args, Throwable cause, int disposition);

REMOVED COM.INQUIRA.INFRA.INQUIRAEXCEPTION METHODS

• public String printLogString();

• public static String printLogString(Throwable t);

• public String getID();

• public int getDisposition();

• public void setArguments(Object[] args);

• public boolean instanceOf(Class c);

• public boolean instanceOf(Throwable t, Class c);

• public String getFullMessage();

• public static String getFullMessage(Throwable theT);

• public String toFullString();

• public static String toFullString(Throwable theT);

• public String getFirstAndLastMessage();

• public static String getFirstAndLastMessage(Throwable theT);

• public String getFirstAndLastStackTrace();

• public static String getFirstAndLastStrackTrace(Throwable theT);

• public String toFirstAndLastString();

• public static String toFirstAndLastString(Throwable theT);
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MISCELLANEOUS UPDATES TO COM.INQUIRA.INFRA.INQUIRAEXCEPTION

The following inner class has been removed:

- public static class Test;

The following method now executes a no-operation (i.e. the method does not append the mode to the 
StringBuilder):

- protected static void appendExecutionMode(StringBuilder sb);

Configuration Steps
After your custom iAuthenticator has been compiled against the freshly installed release 8.5.1 iAuthenticator 
API, rebuild the jar file(s) that contain your custom iAuthenticator class files.

To configure the freshly installed 8.5.1 Information Manager to use your custom iAuthenticator, copy the 
newly rebuilt jar file(s) to the following directories (where TAGLIB_APP refers to InfoCenter, iConnect, SSP, or 
any custom IM Tag Library based web application):

The freshly installed release 8.5.1 IM Management Console should already be configured to use your custom 
iAuthenticator by the steps outlined in the “Migrate Custom Settings in config.properties” section, above. After 
starting up the instance, review the configuration following the instructions below:

1 Log in to your repository in the IM Management Console with an admin user with either of the following 
IM Security Roles:

• Default Administration Role - A user with this role can perform any action on the repository he was 
created for and can only log in to that repository.

• Super Admin - A user with this role can perform any action on any repository.

• Super Support - A user with this role can perform any action on any repository.

2 Navigate to Tools > System Configure.

3 Select Go to Expert Mode.

4 Set the REMOTE_AUTHENTICATION_ENABLED configuration parameter to true.

5 Set the REMOTE_AUTHENTICATION_CLASS configuration parameter to your fully qualified custom 
authenticator class (e.g. com.company.package.CustomAuthenticator).

6 The IFieldBuilder interface was added in version 8.2.3.0. If a custom IFieldBuilder is used, set the 
REMOTE_FIELD_BUILDER_CLASS configuration parameter to your fully qualified custom 
IFieldBuilder subclass.

WebLogic <8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/InfoManager/app/WEB-
INF/lib

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/imws/app/WEB-INF/lib

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/<TAGLIB_APP>/app/WEB-
INF/lib

Tomcat <8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/

InfoManager/WEB-INF/lib

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/imws/WEB-
INF/lib

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/
<TAGLIB_APP>/WEB-INF/lib
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Migrate Custom Rich Text Area Settings
In previous releases of Information Manager, the Rich Text Area component used in the IM Management 
Console and IM Tag Library based web applications was FCKEditor version 2.6.3. In 8.5.1, this component is 
updated to CKEditor version 3.6.1 and CKFinder version 2.0.2.1. CKEditor 3.6.1 is a new version of the 
previous FCKEditor and is a complete rewrite of the product, including major changes in its architecture.

If you configured the FCKEditor in the previously installed release of Information Manager with custom 
settings, consult the documentation from http://ckeditor.com for guidelines on how to map the configuration 
settings from the FCKEditor to the CKEditor.

The CKEditor and CKFinder components can be located in the following directories (where WEB_APP refers 
to InfoManager, InfoCenter, iConnect, and SSP):

The freshly installed version 8.5.1 IM Management Console should have already been configured to use the 
custom rich text editor image upload store paths by the steps outlined in the Migrate custom settings in 
config.properties section above. These image upload store paths will also be used by the rich text editors in 
the IM Tag Library based applications. After staring up the instance, review the configuration following the 
instructions below:

1 Log in to the repository in which the resource configuration settings are configured in the IM 
Management Console as an admin user with either of the following IM Security Roles:

- Default Administration Role - A user with this role can perform any action on the repository he was 
created for and can only log in to that repository.

- Super Admin - A user with this role can perform any action on any repository.

- Super Support - A user with this role can perform any action on any repository.

2 Select Tools.

3 Select System Configure.

4 Select Resource Configuration.

5 Review the Rich Text Editor Image Upload Store Paths.

6 If the WYSIWYG Library Path has been configured to a location other than $IM_HOME/library, set 
the WYSIWYG Thumbnail Path to a different directory in a relatively similar location so the images and 
their thumbnails can be accessed through the shared storage area (e.g. /Server_Name/
Shared_Folder/library and /Server_Name/Shared_Folder/thumbnail)

If you configured the WYSIWYG Library and WYSIWYG Thumbnail paths to locations other than 
$IM_HOME/library and $IM_HOME/thumbnail, you must manually configure the resource web 
application to access the images and thumbnails from the new locations.

WebLogic <8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/<WEB_APP>/app/
resources/application/components/ckeditor

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/<WEB_APP>/app/
resources/application/components/ckfinder

Tomcat <8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/<WEB_APP>/
resources/application/components/ckeditor

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/<WEB_APP>/
resources/application/components/ckfinder
UPGRADING ORACLE KNOWLEDGE



88   UPGRADING INFOCENTER AND WEB APPLICATION COMPONENTS
FOR WEBLOGIC USERS

During the installation process, the administrator specified the resource web application context name. The 
default name is OKResources. This resource web application also hosts the images and thumbnails 
uploaded through the rich text area. The following steps must be performed on the resource web application 
specified during the installation process.

1 Start the Administration Server (if it is not running).

2 Using a web browser, navigate to the WebLogic Administration Console URL. (This can be found at 
http://<Administration Server's Listen Address>:<Administration Server's 
Listen Port>/console).

3 Provide the administration server's credentials to log in.

4 From the Domain Structure section, select Deployments to manage and control the Information 
Manager Web Applications.

5 Select the name that corresponds to the name of the resource web application.

6 Note the Path to the web application; you must navigate there to make changes.

7 Navigate to the Path and edit the weblogic.xml file of the resource web application. (This can be 
found at <8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/<Context Name>/app/
WEB-INF/weblogic.xml)

8 If the WYSIWYG Library Path has been changed, edit the virtual-directory-mapping node that 
corresponds to the library path. 

a Set the local-path node to the parent directory of the new library path. 

b Set the url-pattern node to the directory name of the new library path using the following format:

/<new_library_directory>/

For example, if the WYSIWYG Library Path is /home/username/Oracle/Knowledge/IM/
InfoManager/library, the virtual mapping should read:

<virtual-directory-mapping>
<local-path>/home/username/Oracle/Knowledge/IM/InfoManager</local-
path>
<url-pattern>/library/*</url-pattern>

</virtual-directory-mapping>

c Save the file.

9 If the WYSIWYG Thumbnail Path has been changed, edit the virtual-directory-mapping node that 
corresponds to the thumbnail path. 

a Set the local-path node to the parent directory of the new thumbnail path. 

b Set the url-pattern node to the directory name of the new thumbnail. Use the following format:  
/<new_thumbnail_directory>/

For example, if the WYSIWYG Thumbnail Path was /home/username/Oracle/Knowledge/IM/
InfoManager/thumbnail, the virtual mapping should read:

<virtual-directory-mapping>
<local-path>/home/username/Oracle/Knowledge/IM/InfoManager</local-
path>
<url-pattern>/thumbnail/*</url-pattern>

</virtual-directory-mapping>
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c Save the file.

10 From the WebLogic Administration Console, click the Lock & Edit button in the Change Center to put 
the domain in edit mode.

11 Check the check box that corresponds to the name of the resource web application that was modified.

12 Select Update.

13 Select to Redeploy this application using the following deployment files:

14 Select Finish.

15 Select Activate Changes in the Change Center to activate the modifications to the resource web 
application.

16 The changes are reflected immediately on new web application sessions. For the changes to be 
reflected on existing sessions, the managed server hosting those web applications must be restarted.

FOR TOMCAT USERS

The installation process provided individual context files that represented the web applications used to access 
the images and thumbnails uploaded through the rich text area from the default locations. These context files 
must be manually modified by the administrator to account for the change. The following steps must be 
performed on every instance of Oracle Knowledge. 

WARNING!   The following steps include a restart of the application server.

1 Open the ICE Environment from the Information Manager instance.

2 Execute inquiraim.sh stop on Linux, inquiraim stop on Windows to shutdown the instance.

3 On the file system, navigate to <8.5.1 INSTALL DIR>/instances/<INSTANCE>/
appserverim/conf/Catalina/<InfoManager Host>.

4 If the WYSIWYG Library Path has been changed:

a Rename the library.xml context file to <DIRECTORY>.xml, where DIRECTORY is the directory 
name of the new library path. 

b Edit the file and set the docBase attribute of the Context element to the fully qualified path to the 
new library path. 

c Set the path attribute of the Context element to the directory name of the new library path using the 
following format:

/<directory_of_new_library_path>

For example, if the WYSIWYG Library Path is /home/username/Oracle/Knowledge/IM/
InfoManager/library, the context file should be named library.xml and its contents should 
contain the following:

<?xml version='1.0' encoding='utf-8'?>
<Context docBase="/home/username/Oracle/Knowledge/IM/InfoManager/
library" path="/library">

<Resources className="org.apache.naming.resources.FileDirContext"
              allowLinking="true"/>

</Context>

d Save the file.
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5 If the WYSIWYG Thumbnail Path has been changed:

a Rename the thumbnail.xml context file to <DIRECTORY>.xml, where DIRECTORY is the directory 
name of the new thumbnail path.

b Edit the file and set the docBase attribute of the Context element to the fully qualified path to the 
new thumbnail path.

c Set the path attribute of the Context element to the directory name of the new thumbnail path using 
the following format:

/<directory_of_new_thumbnail_path>

For example, if the WYSIWYG Thumbnail Path is /home/username/Oracle/Knowledge/IM/
InfoManager/thumbnail, the context file should be named thumbnail.xml and its contents 
should contain the following:

<?xml version='1.0' encoding='utf-8'?>
<Context docBase="/home/username/Oracle/Knowledge/IM/InfoManager/
thumbnail" path="/thumbnail">

<Resources className="org.apache.naming.resources.FileDirContext"
              allowLinking="true"/>

</Context>

d Save the file.

6 Delete the Tomcat work directory at <8.5.1 INSTALL DIR>/instances/<INSTANCE>/
appserverim/work.

7 From the ICE Environment, start the application by executing inquiraim.sh start on Linux, 
inquiraim start on Windows.

Migrate Custom JGroups Settings
This section describes how to migrate custom JGroups configurations from previous releases into the 8.5.1 
installation.

In previous releases, customizations could have been made to the JGroups configuration file, jgroups-
default.xml. This file could have been located in the following location (where WEB_APP refers to InfoManager, 
imws, or any IM Tag Library based web application):

<PRE-8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/<WEB APP>/
WEB-INF/Library/Frameworks/ERJGroupsSynchronizer.framework/Resources/jgroups-
default.xml

If you’ve modified this file, follow the instructions below to properly migrate the customizations to the 8.5.1 
installation.

Because the JGroups version was updated to 2.11 in this release, start with the latest jgroups-default.xml file 
from the 8.5.1 installation.
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For WebLogic Users
1 Navigate to <8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/InfoManager/app/

WEB-INF/lib.

2 Locate the erjgroupssynchronizer-5.0.jar file and unzip it to a directory we’ll refer to as 
<TMP>.

3 Copy the <TMP>/Resources/jgroups-default.xml to the following location:

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/InfoManager/app/WEB-INF/
InfoManager.woa/Contents/WebServerResources 

Important!   Rename the file to any other name so that there is no conflict with the default 
configuration file (e.g. jgroups-custom.xml).

4 Delete the <TMP> directory.

5 Apply your customizations from the previously customized jgroups-default.xml to the newly 
copied file.

6 Distribute the newly customized file to the following locations and register your customized file with the 
application:

For InfoManager

a Copy the newly customized file to following directory:

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/InfoManager/app/WEB-INF/
InfoManager.woa/Contents/WebServerResources

b Set the er.extensions.jgroupsSynchronizer.properties property to the file name of the 
newly customized file (e.g. er.extensions.jgroupsSynchronizer.properties=jgroups-
custom.xml) in the following file:

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/InfoManager/app/WEB-INF/
InfoManager.woa/Contents/Resources/Properties

You must uncomment this property when you edit it, as it is commented out by default.

Important!   Only specify the name of the file; do NOT specify the full path to the file.

For IMWS

a Copy the newly customized file to following directory:

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/imws/app/WEB-INF/
IMWebServices.woa/Contents/WebServerResources

b Set the er.extensions.jgroupsSynchronizer.properties property to the file name of the 
newly customized file (e.g. er.extensions.jgroupsSynchronizer.properties=jgroups-
custom.xml) in the following file:

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/imws/app/WEB-INF/
IMWebServices.woa/Contents/Resources/Properties

You must uncomment this property when you edit it, as it is commented out by default.

Important!   Only specify the name of the file; do NOT specify the full path to the file.
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For InfoCenter

a Copy the newly customized file to the following directory:

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/infocenter/app/WEB-INF/
IMTagLibrary.woa/Contents/WebServerResources

b Set the er.extensions.jgroupsSynchronizer.properties property to the file name of the 
newly customized file (e.g. er.extensions.jgroupsSynchronizer.properties=jgroups-
custom.xml) in the following file:

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/infocenter/app/WEB-INF/
IMTagLibrary.woa/Contents/Resources/Properties

You must uncomment this property when you edit it, as it is commented out by default.

Important!   Only specify the name of the file; do NOT specify the full path to the file.

For any other IM Tag Library based web application

a Copy the newly customized file to the following directory:

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/<WEB_APP>/app/WEB-INF/
IMTagLibrary.woa/Contents/WebServerResources

b Set the er.extensions.jgroupsSynchronizer.properties property to the file name of the 
newly customized file (e.g. er.extensions.jgroupsSynchronizer.properties=jgroups-
custom.xml) in the following file:

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/<WEB_APP>/app/WEB-INF/
IMTagLibrary.woa/Contents/Resources/Properties

You must uncomment this property when you edit it, as it is commented out by default.

Important!   Only specify the name of the file; do NOT specify the full path to the file.

7 Restart the instance for the changes to take effect.

For Tomcat Users
1 Navigate to <8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/

InfoManager/WEB-INF/lib

2 Locate the erjgroupssynchronizer-5.0.jar file and unzip it to a directory we’ll refer to as 
<TMP>

3 Copy the <TMP>/Resources/jgroups-default.xml to the following location.

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/InfoManager/
WEB-INF/InfoManager.woa/Contents/WebServerResources 

Important!   Rename the file to any other name so that there is no conflict with the default 
configuration file (e.g. jgroups-custom.xml).

4 Delete the <TMP> directory

5 Apply your customizations from the previously customized jgroups-default.xml to the newly 
copied file.

6 Distribute the newly customized file to the following locations and register your customized file with the 
application:
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For InfoManager

a Copy the newly customized file to following directory:

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/InfoManager/
WEB-INF/InfoManager.woa/Contents/WebServerResources

b Set the er.extensions.jgroupsSynchronizer.properties property to the file name of the 
newly customized file (e.g. er.extensions.jgroupsSynchronizer.properties=jgroups-
custom.xml) in the following file:

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/InfoManager/
WEB-INF/InfoManager.woa/Contents/Resources/Properties

You must uncomment this property when you edit it, as it is commented out by default.

Important!   Only specify the name of the file; do NOT specify the full path to the file.

For IMWS

a Copy the newly customized file to following directory:

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/imws/WEB-INF/
IMWebServices.woa/Contents/WebServerResources

b Set the er.extensions.jgroupsSynchronizer.properties property to the file name of the 
newly customized file (e.g. er.extensions.jgroupsSynchronizer.properties=jgroups-
custom.xml) in the following file:

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/imws/WEB-INF/
IMWebServices.woa/Contents/Resources/Properties

You must uncomment this property when you edit it, as it is commented out by default.

Important!   Only specify the name of the file; do NOT specify the full path to the file.

For InfoCenter

a Copy the newly customized file to the following directory:

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/infocenter/
WEB-INF/IMTagLibrary.woa/Contents/WebServerResources

b Set the er.extensions.jgroupsSynchronizer.properties property to the file name of 
the newly customized file (e.g. 
er.extensions.jgroupsSynchronizer.properties=jgroups-custom.xml) in the 
following file:

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/infocenter/
WEB-INF/IMTagLibrary.woa/Contents/Resources/Properties

You must uncomment this property when you edit it, as it is commented out by default.

Important!   Only specify the name of the file; do NOT specify the full path to the file.

For any other IM Tag Library based web application

a Copy the newly customized file to the following directory:

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/<WEB_APP>/
WEB-INF/IMTagLibrary.woa/Contents/WebServerResources
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b Set the er.extensions.jgroupsSynchronizer.properties property to the file name of the 
newly customized file (e.g. er.extensions.jgroupsSynchronizer.properties=jgroups-
custom.xml) in the following file:

<8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/<WEB_APP>/
WEB-INF/IMTagLibrary.woa/Contents/Resources/Properties

You must uncomment this property when you edit it, as it is commented out by default.

Important!   Only specify the name of the file; do NOT specify the full path to the file.

7 Restart the instance for the changes to take effect.

Migrate Custom Tag Library Descriptors
The IM Tag Library based web applications (InfoCenter, iConnect, and SSP) allow users to provide custom 
tag library descriptors (TLD) for use with custom JSP files. This section describes how to migrate those 
custom TLD files to the 8.5.1 installation.

The tag library descriptors provided by Oracle Knowledge are the IM Core and IM Discussion Board tag 
library descriptors. These files are named inquira.tld and discussionboards.tld respectively.

Custom TLD files can be found here for previously installed version IM Tag Library based web applications 
(where TAGLIB_APP refers to InfoCenter, iConnect, SSP, or any custom IM Tag Library based web 
application):

<Pre-8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/<TAGLIB_APP>/
WEB-INF/tlds

If the previously installed version IM Tag Library based web application contained any custom TLD files, copy 
them to the corresponding 8.5.1 installation IM Tag Library based web application in the following directory:

Migrate Custom CSS
The IM Tag Library based web applications (InfoCenter, iConnect, and SSP) allow users customize the look 
and feel of the application. This section describes how to migrate that look and feel to the 8.5.1 installation IM 
Tag Library based web applications.

Previously installed version IM Tag Library based web application CSS files can be found in the following 
directory (where TAGLIB_APP refers to InfoCenter, iConnect, SSP, or any custom IM Tag Library based web 
application):

<Pre-8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/<TAGLIB_APP>/
apps/infocenter/resources/css

WebLogic <8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/<TAGLIB_APP>/app/
WEB-INF/tlds

Tomcat <8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/
<TAGLIB_APP>/WEB-INF/tlds
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Customized CSS files can be placed in the following directory for the 8.5.1 installation IM Tag Library based 
web application:

Configuring the application to use your custom CSS files is described in the Migrate Custom InfoCenter 
Properties section.

WARNING!   The look and feel of the Oracle Knowledge Information Manager web applications was dramatically 
changed within the 8.5 releases. Other changes to your CSS, custom JSP files, and properties files may be 
needed to achieve the desired look and feel.

Migrate Custom Java Server Pages
The IM Tag Library based web applications (InfoCenter, iConnect, and SSP) allow users to use custom Java 
Server Pages (JSP). This section describes how to migrate the custom JSP files to the 8.5.1 installation IM 
Tag Library based web applications.

The 8.5.1 installation provides TLD documentation for the IM Core and IM Discussion Board tag library 
descriptors.

This documentation can be accessed at:

<8.5.1 INSTALL DIR>/InfoManager/docs/JSP/index.html

In previous releases, the custom JSP files can be located recursively within the following directory (where 
TAGLIB_APP refers to InfoCenter, iConnect, SSP, or any custom IM Tag Library based web application):

<Pre-8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/<TAGLIB_APP>/
apps/infocenter/custom

If the previous installation contained any custom JSP files, review the use of the JSP tags in the custom JSP 
files against the 8.5.1 TLD documentation. After making any necessary changes, copy the custom JSP files to 
the 8.5.1 installation in the following location:

Migrate Custom InfoCenter Properties
IM Tag Library based web applications allow users to customize the look and feel as well as the behavior of 
the web application by customizing the settings specified in a properties file. This property file will have 
different settings for InfoCenter, iConnect, and SSP.

The default settings for the 8.5.1 release can be found in the following location, where TAGLIB_APP refers to 
infocenter, iconnect, or ssp:

WebLogic <8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/<TAGLIB_APP>/app/
apps/infocenter/resources/css

Tomcat <8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/
<TAGLIB_APP>/apps/infocenter/resources/css

WebLogic <8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/<TAGLIB_APP>/app/apps/
infocenter/custom

Tomcat <8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/
<TAGLIB_APP>/apps/infocenter/custom
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In release 8.5.1 customizations should be made in the following file:

In releases prior to 8.1.3.0, customized settings could be found in the following location, where CONTEXT 
refers to the application context name of your deployed IM Tag Library based web application:

<Pre-8.1.3.0 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/<CONTEXT>/
WEB-INF/infocenter.properties

To migrate your customizations from a release prior to 8.1.3.0, compare the settings in the previous release’s 
infocenter.properties to the 8.5.1 default settings. If there are any customizations, create the new 
infocenter_custom.properties file in the 8.5.1 installation and extract the customized values from the previous 
release’s infocenter.properties file to the newly created infocenter_custom.properties file.

In releases 8.1.3.0 and higher, customized settings could be found in the following location, where CONTEXT 
refers to the application context name of your deployed IM Tag Library based web application:

<Pre-8.1.3.0 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/<CONTEXT>/
WEB-INF/infocenter_custom.properties

To migrate your customizations from a release 8.1.3.0 or higher, copy the previous release’s 
infocenter_custom.properties file to the 8.5.1 installation. 

Migrate Custom ESAPI Properties
In release 8.2.3.0, Information Manager introduced the integration of the InQuira Web Application Security 
framework with the OWASP Enterprise Security API (ESAPI) framework. Settings to control the operation of 
the InQuira Web Application Security framework are specified in the following properties files:

• validation.properties

• inquira_whitelist.properties

• inquira_esapi.properties

• securityhandlermap.properties

Validation Properties
In previous release’s, customizations to the validation.properties file can be found under the following 
location, where CONTEXT is the web application context name of your deployed IM Tag Library based web 
application:

<Pre-8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/<CONTEXT>/
WEB-INF/classes/resources/validation_custom.properties

WebLogic <8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/<TAGLIB_APP>/app/
WEB_INF/infocenter.properties

Tomcat <8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/
<TAGLIB_APP>/WEB_INF/infocenter.properties

WebLogic <8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/<TAGLIB_APP>/app/WEB_INF/
infocenter_custom.properties

Tomcat <8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/<TAGLIB_APP>/
WEB_INF/infocenter_custom.properties
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If your previous release contained any settings in the validation_custom.properties file, copy the file to the 
8.5.1 installation in the following location, where TAGLIB_APP refers to infocenter, iconnect, or ssp:

InQuira White List Properties
In previous release’s, customizations to the inquira_whitelist.properties file can be found under the following 
location, where CONTEXT is the web application context name of your deployed IM Tag Library based web 
application:

<Pre-8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/<CONTEXT>/
WEB-INF/classes/resources/inquira_whitelist_custom.properties

If your previous release contained any settings in the inquira_whitelist_custom.properties file, copy the file to 
the 8.5.1 installation in the following location, where TAGLIB_APP refers to infocenter, iconnect, or ssp:

InQuira ESAPI Properties
In previous release’s, customizations to the inquira_esapi.properties file can be found under the following 
location, where CONTEXT is the web application context name of your deployed IM Tag Library based web 
application:

<Pre-8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/<CONTEXT>/
WEB-INF/classes/resources/inquira_esapi_custom.properties

If your previous release contained any settings in the inquira_esapi_custom.properties file, copy the file to the 
8.5.1 installation in the following location:

Security Handler Map Properties
In previous release’s, customizations to the securityhandlermap.properties file can be found under the 
following location, where CONTEXT is the web application context name of your deployed IM Tag Library 
based web application:

<Pre-8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/<CONTEXT>/
WEB-INF/classes/securityhandlermap.properties

If your previous release contained any custom settings in the securityhandlermap.properties file, migrate the 
customized values to the 8.5.1 installation in the following file:

WebLogic <8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/<TAGLIB_APP>/app/
WEB_INF/classes/resources/validation_custom.properties

Tomcat <8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/
<TAGLIB_APP>/WEB_INF/classes/resources/validation_custom.properties

WebLogic <8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/<TAGLIB_APP>/app/
WEB_INF/classes/resources/inquira_whitelist_custom.properties

Tomcat <8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/
<TAGLIB_APP>/WEB_INF/classes/resources/
inquira_whitelist_custom.properties

WebLogic <8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/<TAGLIB_APP>/app/
WEB_INF/classes/resources/inquira_esapi_custom.properties

Tomcat <8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/
<TAGLIB_APP>/WEB_INF/classes/resources/inquira_esapi_custom.properties
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Migrate Custom InfoCenter Resources
IM Tag Library based web applications allow users to customize the labels and text resources that are 
displayed on the web application by customizing the settings specified in a properties file. This property file 
will have different settings for InfoCenter, iConnect, and SSP.

The default label and text resources for the 8.5.1 release can be found in the following location, where 
TAGLIB_APP refers to infocenter, iconnect, or ssp:

These label and text values have been translated to the supported languages. Those files are called 
ApplicationResources_<language>.properties, where language is the language code (e.g. 
ApplicationResources_it.properties for Italian). The default language, English, does not have the language 
appended to the file name.

In release 8.5.1 customizations to the default language, English, should be made in the following file:

Similarly, translations of the customized resources should be made to 
ApplicationResources_custom_<language>.properties (e.g. ApplicationResources_custom_it.properties).

In releases prior to 8.1.3.0, customized resources can be found in the following location, where CONTEXT 
refers to the application context name of your deployed IM Tag Library based web application:

<Pre-8.1.3.0 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/<CONTEXT>/
WEB-INF/classes/ApplicationResources.properties

To migrate your customizations from a release prior to 8.1.3.0, compare the resource values in the previous 
release’s ApplicationResources.properties to the 8.5.1 default settings. If there are any customizations, 
create the new ApplicationResources_custom.properties file in the 8.5.1 installation and extract the 
customized values from the previous release’s ApplicationResources.properties file to the newly created 
ApplicationResources_custom.properties file. Repeat this process for any customized, translated resources 
appending the language code to the custom property file name.

In releases 8.1.3.0 and higher, customized resources can be found in the following location, where CONTEXT 
refers to the application context name of your deployed IM Tag Library based web application:

<Pre-8.1.3.0 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/<CONTEXT>/
WEB-INF/classes/ApplicationResources_custom.properties

WebLogic <8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/<TAGLIB_APP>/app/
WEB_INF/classes/securityhandlermap.properties

Tomcat <8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/
<TAGLIB_APP>/WEB_INF/classes/securityhandlermap.properties

WebLogic <8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/<TAGLIB_APP>/app/
WEB_INF/classes/ApplicationResources.properties

Tomcat <8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/
<TAGLIB_APP>/WEB_INF/classes/ApplicationResources.properties

WebLogic <8.5.1 INSTALL DIR>/instances/<INSTANCE>/webapps/<TAGLIB_APP>/app/
WEB_INF/classes/ApplicationResources_custom.properties

Tomcat <8.5.1 INSTALL DIR>/instances/<INSTANCE>/appserverim/webapps/
<TAGLIB_APP>/WEB_INF/classes/ApplicationResources_custom.properties
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To migrate your customizations from a release 8.1.3.0 or higher, copy the previous release’s 
ApplicationResources_custom.properties file to the 8.5.1 installation. Repeat this process for any customized, 
translated resources appending the language code to the custom property file name.
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CHAPTER 5

Performing an In-place Upgrade 

In-place Upgrade Process Overview
To perform an in-place upgrade to the Oracle Knowledge 8.5.1 release, follow the instructions in this chapter. 
If your environment is configured to use Oracle Knowledge Analytics, be sure to upgrade the Analytics before 
Information Manager and Intelligent Search.

The upgrade package contains the following zip file for the in-place upgrade utilities:

For Linux:

• in_place_upgrade_linux-8.5.1.zip

For Windows:

• in_place_upgrade_windows-8.5.1.zip

Unzip the appropriate zip file for your environment to a temporary directory we’ll refer to later as <TMP>.

Analytics Upgrade
Note:   This patch can be installed directly on the Analytics webpage.

Navigate to <TMP>/Analytics and verify that the following files and directories exist:

SQL
Reporting_Build_8501.sql
Reporting_Build_8502.sql
Reporting_Build_8510.sql
Staging_Build_8502.sql
Staging_Build_8510.sql

Router
AnalyticsEventRouterEA-8.5.1.ear
analytics-messages-8.5.1.jar

Analytics_OBIEE_Artifacts-8.5.1.zip (zip file contents)
analyticsReportingModel-8.5.1.rpd
analyticsReportingModel85V2
CSS/
META-INF/

Analytics_ODI_Packages-8.5.1.zip (zip file contents)
logical/
master/
META-INF/
work/
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Upgrade the Analytics Database Schema
The following sections provide information for upgrading the database schema for DW_Reporting and 
DW_Stage.

UPGRADING DW_REPORTING

From a SQL client tool, go to the DW_REPORTING schema and execute the scripts as per the following matrix.

UPGRADING DW_STAGE

From a SQL client tool, go to the DW_STAGE schema and execute the as per the following matrix.

Upgrade the Analytics JMS Event Router
To upgrade the analytics event router:

1 Start the WebLogic Server.

2 Start the Node Manager.

3 Stop Analytics Router Managed Server.

4 Login to Console, http://localhost:7001/console

5 Delete folder <WebLogic Domain Path>\servers\<Analytics Server Name>\stage 
\AnalyticsEventRouterEA-8.5.0.0

6 Copy the Router/AnalyticsEventRouterEA-8.5.1.ear file to <Analytics Installation 
Dir>/instances/AnalyticsEventRouter/webapps/ and remove the 8.5.0.0.ear file.

7 Delete the 8.5.0.0 JMS Event Router deployment using the WebLogic Admin Console and deploy the 
new 8.5.1 JMS Event Router in its place.

a Open the WebLogic Admin Console.

b Select Deployments in the Domain Structure section in the left-side panel.

Version upgrading from SQL files to run (in the order listed)

8.5.0.0 Reporting_Build_8501.sql

Reporting_Build_8502.sql

Reporting_Build_8510.sql

8.5.0.1 Reporting_Build_8502.sql

Reporting_build_8510.sql

8.5.0.2 Reporting_Build_8510.sql

Version upgrading from SQL files to run (in the order listed)

8.5.0.0 Staging_Build_8502.sql

Staging_Build_8510.sql

8.5.0.1 Staging_Build_8502.sql

Staging_Build_8510.sql

8.5.0.2 Staging_Build_8510.sql
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c Click Lock & Edit in the Change Center section in the left-side panel.

d Select all of the JMS Event Router deployments, in the Deployments table in the main Summary of 
Deployments panel, by selecting the checkbox to the left of each name.

e Click Delete above the table.

f Click Yes when prompted to confirm that you want to Delete Deployments.

g Click Activate Changes in the Change Center section in the left-side panel.

8 Restart the WebLogic server and Node Manager.

9 Start Analytics Router process via the Admin Console.

10 Ensure the new deployment has the name AnalyticsEventRouterEA-8.5.1.

11 Start the Analytics Router Managed Server via the Admin Console, if not started.

Upgrade ODI
The following information is needed to perform an ODI update from 8.5.0/8.5.0.1/8.5.0.2 to 8.5.1:

To update ODI:

1 Stop the ODI package - PKG-ORACLE_KNOWLEDGE_MAIN.

2 Unzip the contents of <TMP>/Analytics/Analytics_ODI_Packages-8.5.1.zip to a temporary 
location, <TMP-DIR>/ODI

UPGRADE THE MASTER ODI REPOSITORY

To upgrade the master ODI repository:

1 Backup the existing Master ODI repository.

2 Open ODI Studio as Supervisor. 

3 Connect to the Master repository.

4 On Topology tab, click on the Connect Navigator icon (top-right). 

5 Select Import > Import the Master Repository. 

6 Click Ok. 

7 On the pop-up window, for Import mode, select Synonym Mode INSERT_UPDATE.

8 Select Import from a folder. 

9 Browse to <TMP-DIR>/ODI and select the Master folder. 

10 Click Ok. The merging takes several minutes.

UPGRADE THE LOGICAL ODI REPOSITORY

To upgrade the logical ODI repository:

1 Backup the existing Logical ODI repository.

2 Open ODI Studio as Supervisor. 
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3 Connect to the Logical repository.

4 On Topology tab, click on the Connect Navigator icon (top-right). 

5 Select Import > Import the Logical Topology. 

6 Click Ok. 

7 On the pop-up window, for Import mode, select Synonym Mode INSERT_UPDATE.

8 Select Import from a folder. 

9 Browse to <TMP-DIR>/ODI and select the Logical folder. 

10 Click Ok. The merging takes several minutes.

UPGRADE THE WORK ODI REPOSITORY

To upgrade the work ODI repository:

1 Backup the existing Work ODI repository.

2 Open ODI Studio as Supervisor. 

3 Connect to the Work repository.

4 On Designer tab, click on the Connect Navigator icon (top-right). 

5 Select Import > Import the Work Repository. 

6 Click Ok. 

7 On the pop-up window, for Import mode, select Synonym Mode INSERT_UPDATE.

8 Select Import from a folder. 

9 Browse to <TMP-DIR>/ODI and select the Work folder. 

10 Click Ok. The merging takes several minutes.

SET THE ORACLE SERVER CONNECTION

After the above three ODI Repositories are successfully imported, continue with setting the Oracle Server 
connection.

To set the Oracle server connection:

1 Open ODI Studio as Supervisor. 

2 Connect to the Work repository.

3 On the Topology Tab, click on Physical Architecture

4 Select Technologies, expand, and select Oracle > ORACLE_SERVER.

5 Open ORACLE_SERVER, select Definition Menu on Data Server.

6 Enter the Instance/dblink (Data Server).

7 Enter Username and password.

8 Select JDBC Menu, select oracle.jdbc.OracleDriver for JDBC Driver:
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9 Complete jdbc:oracle:thin:@<host>:<port>:<sid>  on JDBC URL:

10 Select Oracle > ORACLE_SERVER > ORACLE_SERVER.DW_STAGE

11 Enter the ODI Work Schema in Schema (Work Schema).

12 Select Oracle > ORACLE_SERVER > ORACLE_SERVER.DW_REPORTING

13 Enter the ODI Work Schema in Schema (Work Schema).

14 Save changes.

15 Restart ODI package - PKG-ORACLE_KNOWLEDGE_MAIN.

Upgrade OBIEE
To upgrade OBIEE for Analytics, perform the following tasks:

• Reset the RPD (repository) password

• Configure the connection between OBIEE and the data warehouse

• Deploy the RPD and Catalog to create the Oracle Knowledge Analytics project within OBIEE

• Validate your installation

CONNECT OBIEE TO THE DATA WAREHOUSE

Unzip the contents of Analytics_OBIEE_Artifacts-8.5.1.zip file to a temporary location, <TMP-
DIR>/OBIEE. Connect the OBIEE instance to the data warehouse by editing the database connection 
parameters in the RPD file that is provided in the <TMP-DIR>/OBIEE folder. The RPD file is edited using the 
OBIEE Administration Tool. This tool only runs on the Windows platform.

Open the RPD

You must open the RPD file to configure it for your installation. This operation must be performed on a 
Windows machine using the OBIEE BI Administration Tool.

1 Open the Oracle BI Administration Tool

2 Select File > Open > Offline

3 Select the Oracle Knowledge Analytics RPD file

4 Enter the default password: password85

Change the RPD password

The RPD file is shipped with a default password. It is strongly recommended that you change the RPD 
password prior to deploying the RPD and Catalog.

To change the RPD password:

1 Select File > Change Password

2 Enter the current (old) password: password85

3 Enter the new password and confirm.

The repository password must be at least eight characters, with at least one numeric character. The New 
Password field cannot be empty.
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CONFIGURE CONNECTIONS TO THE DATABASE

The next step is to configure the OBIEE connection to the data warehouse. This requires the creation of 
System ODBC data sources using the Windows Control Panel.

Set your connections using the Oracle Business Intelligence (BI) Administration tool.

CONNECT TO THE REPORTING SCHEMA

Use the following procedures to set the data source, set the reporting schema password, and check the 
connection to the reporting schema.

To set the database connection properties:

1 In the Physical pane of the OBI Administration Tool, select Oracle Data Warehouse > Oracle Data 
Warehouse Connection Pool.

2 Enter the ODBC data source name for the DW_REPORTING schema.

3 Enter the password for schema DW_REPORTING under Shared Logon.

4 Repeat for Oracle Data Warehouse > Oracle Data Warehouse Initblocks Connection Pool.

To check the connection:

1 Select Oracle Data Warehouse > DW_REPORTING > DIM_CONTENT, then select View Data.

2 Select Oracle Data Warehouse Connection Pool, then select OK.

3 If no data has been propagated from the staging schema to the reporting schema, the test succeeds.

4 Repeat this test, but select Oracle Data Warehouse Repository Initblocks Connection Pool 
instead of Oracle Data Warehouse Connection Pool.

SAVE THE RPD

Use this procedure to save the RPD.

1 Select File > Save.

2 Close the OBI Administration Tool.

DEPLOY THE RPD AND CATALOG

The RPD and catalog define the Oracle Knowledge Analytics project, including the dashboards and reports, 
that you access using the OBIEE user interface.

To deploy the catalog:

1 Navigate to OBIEE Enterprise Manager at http://<hostname>:7001/em, where <hostname> is 
the name of the server where OBIEE is installed.

2 Log in with the user name and password you used to install OBIEE.

3 On the left pane, select Business Intelligence/coreapplication.

4 On the right pane, select Lock and Edit Configuration. This prevents anyone else from making 
configuration changes at the same time. Wait for confirmation popup.

5 On the right pane, select Deployment/Repository.
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6 Select Upload BI Server Repository > 

7 Choose File, and select the edited RPD file.

8 Copy the analyticsReportingModel85V2 folder to the catalog directory at: 
<OBIEE_INSTALL_DIR>\instances\instance1\bifoundation\OracleBIPresentationSe
rvicesComponent\coreapplication_obips1\catalog 

9 At BI Presentation Catalog, change the catalog location to $ORACLE_INSTANCE/bifoundation/
OracleBIPresentationServicesComponent/$COMPONENT_NAME/catalog/
analyticsReportingModel85V2.

10 Enter the Repository password.

11 Select Apply.

12 Select Activate Changes.

13 Select Restart to Apply Recent Changes.

14 Select Restart.

The RPD is deployed and the catalog that defines the Oracle Knowledge Analytics project within OBIEE is 
added. 

Note:   To incorporate any customizations in the newly deployed RPD, 

Use OBIEE Admin Tool Merge functionality to merge the backed up RPD (from Section 2.5) with the current 
RPD. More information on this functionality is available at http://docs.oracle.com/cd/E15586_01/
fusionapps.1111/e20836/mngreposfiles.htm#DAFCHIGD

Note:   To migrate custom reports or dashboards into the new 8.5.1 catalog, 

1 Navigate to Oracle Business Intelligence at http://<hostname>:9704/analytics, where 
<hostname> is the name of the server where OBIEE is installed.

2 Go to Catalog, navigate to the folder in the left pane where the backed up reports folder is to be added.

3 Select Unarchive link in the bottom left pane (Tasks).

4 In the Unarchive window:

a Click the Browse button and select the earlier archived file.

b For the Replace field, select the appropriate value 

c For the ACL field, select value Inherit.

d Click OK.
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Information Manager Upgrade
These instructions must be repeated for each installation that contains an IM instance.

Prepare to Upgrade
1 Stop the IM instance using the instructions in the Oracle Knowledge Installation Guide. Take care to 

stop the instance using the method by which it was started. For example, if the instance was started 
using the WebLogic Admin Console, stop the IM instance using the WebLogic Admin Console. If the 
instance was started through ICE, stop the instance using the ICE command.

2 Open a new command prompt and change directory into $ORACLE_ROOT/instances/<company> 
where <company> refers to the IM instance name on this installation.

3 Create an ICE prompt by executing the setenv.sh shell script for Linux/Solaris OR the setenv.bat 
script for Windows.

4 Do not exit the ICE prompt.

Upgrade the IM Applications
To upgrade IM applications:

1 Change directory into the extracted upgrade files temporary directory <TMP-DIR>.

2 On Linux, set permissions on files so that they are executable by executing:

chmod 750 *.sh

3 Modify the ANT_OPTS to allocate the appropriate amount memory for the JVM according to the 
machine’s memory limitations when running this script. The default initial java heap size (-Xms) is set 
to 512M. The default maximum java heap size (-Xmx) is also set to 1024M.  Please raise these 
settings if the system can allocate more memory to the JVM. Please lower these settings if the system 
cannot handle the default memory settings for the JVM in order to prevent Out Of Memory errors.

For Linux/Solaris, modify the applyIMPatch_weblogic.sh file by modifying the following line:

• ANT_OPTS=”-Xmx1024m -Xms512m”

For Windows, modify the applyIMPatch_weblogic.bat file by modifying the following line:

• set “ANT_OPTS=-Xmx1024m -Xms512m”

4 Execute the applyIMPatch_weblogic.sh script for Linux/Solaris OR 
applyIMPatch_weblogic.bat for Windows. The following log file should be reviewed for errors:

$ORACLE_ROOT/backups/8.5.1/im_patch_installation_<INSTANCE_NAME>_ 
<DATE_TIME>.log
UPGRADING ORACLE KNOWLEDGE



108   INFORMATION MANAGER UPGRADE
Upgrade the IM Database
Use the IM Database Upgrade utility to upgrade the database as described in “Upgrading the Information 
Manager Database” on page 19.

Restart the IM Instances
Start the IM instances following the instructions in the Oracle Knowledge Installation Guide to complete the IM 
upgrade. In the WLS console, go to Environments > Servers. Start the IM and/or IC managed server(s).

Note:   The installed e-mail templates and their translations have been provided to $ORACLE_ROOT/
InfoManager/config/SYSTEM/taskconfig. If any customizations were made to any e-mail notification 
templates at the SYSTEM repository level, please migrate your changes from the customized files to the 
new files. The customized files are backed up during the upgrade to $ORACLE_ROOT/backups/8.5.1/
IM_HOME/config/SYSTEM/taskconfig.
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Intelligent Search Upgrade
These instructions must be repeated for each Search installation that may contain a Search Scheduler 
(Indexer) instance, one or more Search Runtime instances, one or more Search Workclient instances, one or 
more Search Query Coordinator instances, or one or more Search Query Worker instances. 

Prepare to Upgrade
Stop all of the Search instances using the instructions in the Oracle Knowledge Installation Guide. Take care 
to stop the instance using the method it was started. For example, if the instance was started using the 
WebLogic Admin Console, stop the Search instance using the WebLogic Admin Console. If the instance was 
started through ICE, stop the instance using the ICE command.

Delete the WebLogic Search Deployments
In 8.5.1, the source location of the Search application war files has been changed to improve performance.   
You must undeploy the existing deployments or they will fail to redeploy after the upgrade.

1 Open the WebLogic Admin Console.

2 Select Deployments in the Domain Structure section, in the left-side panel.

3 Click Lock & Edit in the Change Center section in the left-side panel.

4 Select all of the Search deployments, in the Deployments table in the main Summary of Deployments 
panel, by selecting the checkbox to the left of each name.

5 Click Delete above the table.

6 Click Yes when prompted to confirm that you want to Delete Deployments.

7 Click Activate Changes in the Change Center section in the left-side panel.

Upgrade the Search Installation
1 Open a command prompt and cd into <install_dir>/instances/<instance> where 

<install_dir> is the top search installation folder and <instance> refers to a Search instance 
name on this installation.

2 Create an ICE prompt by executing the setenv.sh script for a Linux/Solaris system or setenv.bat 
script for a Windows system.

3 cd to the <TMP>/Search directory.

4 On Linux, set permissions on files so that they are executable by executing:

chmod 750 *.sh

5 Run the upgrade script by executing the upgrade.sh script for a Linux/Solaris system or 
upgrade.bat script for a Windows system.

• The script compares the versions of the installed Search components with those of the upgrade 
package. It lists a summary of this version information, then prompts you to enter 'y' (Yes) or 'n' (No) 
to confirm that you want to continue with the upgrade.

• If you reply 'y', the upgrader upgrades any component that either does not exist in the current 
installation or which has an older version #.
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• If you are using WebLogic the upgrader prompts you for two values:

a. The full path of the directory where WebLogic is installed (e.g., <oracle_home>/Middleware/
wlserver_10.3, where <oracle_home> is replaced by the path to the parent folder).

b. The full path of the WebLogic domain used for Search servers (e.g.n <oracle_home>/
Middleware/user_projects/domains/<my_domain>, where <oracle_home> is replaced by the 
path to the parent folder and <my_domain> is replaced by the name of your domain).

The Upgrader uses the entered values to verify that the respective WebLogic folders exist. If not, 
the Upgrader exits.

• Before upgrading the components, the upgrader creates a backup folder in the current installation 
(<install_dir>/backup-<release_number>-<timestamp>) and either moves or makes a 
copy of each component to be upgraded to that folder.

6 When the upgrade script finishes, save the console log to a file in the <TMP>/Search directory for 
reference.

7 Exit the ICE window.

Rebuild and Deploy The Web Application Instances
Repeat the following rebuild and deploy steps for the Search Scheduler instance, each Search Runtime 
instance, and each Search Query Coordinator instance.

1 Open a command prompt and cd into <install_dir>/instances/<instance> where 
<install_dir> is the top search installation folder and <instance> refers to the Search Scheduler, a 
Search Runtime, or a Search Query Coordinator instance name on this installation.

2 Create an ICE prompt by executing the setenv.sh script for Linux/Solaris environment OR 
setenv.bat script for Windows environment.

3 Run the buildWebApp and deployApp scripts on each Search Scheduler and Runtime instance and 
Search Query Coordinator instance.

On Linux/Solaris:

a Run buildWebapp.sh script

b Run deployApp.sh script

On Windows:

a Run buildWebapp.bat script

b Run deployApp.bat script

Rebuild and Deploy the Non-Web Application Instances
Repeat the following steps for each Search Workclient instance and each Search Query Worker instance.

1 Open a command prompt and cd into <install_dir>/instances/<instance> where 
<install_dir> is the top search installation folder and <instance> refers to a Search Workclient or 
Search Query Worker instance name on this installation.

2 Create an ICE prompt by executing the setenv.sh script for Linux/Solaris environment OR 
setenv.bat script for Windows environment.
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3 Run the applyUpdates script.

On Linux/Solaris, run applyUpdates.sh script.

On Windows, run applyUpdates.bat script.

Import Dictionary Changes
Open <install_dir>/resources/Dictionary_Import_Files/
8.5.1_Dictionary_Import_Files-README.docx, and import 8.5.1 Dictionary changes according to 
the instructions.

Restart the Search Instances
Start the Search instances using the instructions in the Oracle Knowledge Installation Guide.

AnswerFlow Upgrade
AnswerFlow upgrade support applies to Linux environments using WebLogic only.

Prepare to Upgrade
Stop all the AnswerFlow Editor and RuntimeUI instances using the instructions in the Oracle Knowledge 
Installation Guide. Take care to stop the instance using the method it was started. For example, if the instance 
was started using the WebLogic Admin Console, stop the Search instance using the WebLogic Admin 
Console. If the instance was started through ICE, stop the instance using the ICE command.

Upgrade the AnswerFlow Installation
1 Open a bash shell by entering bash command:

bash

2 Use cd to go to the AnswerFlow upgrade temporary directory, <TMP>.

3 Set permissions on files so that they are executable by executing:

chmod 750 *.sh

4 Start the Editor ICE.

Execute <AnswerFlow installation directory>/instances/Editor/setenv.sh

5 From the Answer Flow Editor ICE command, enter cd <TMP>/AnswerFlow/

6 Execute bash runupgrade.sh <AnswerFlow installation directory>

After the upgrade is complete, execute setSampleUICredentials.sh

1 Start the RuntimeUI ICE.

Execute <AnswerFlow installation directory>/instances/RuntimeUI/setenv.sh

2 Execute setSampleUICredentials.sh

3 You will be asked to enter the credentials for SampleUI to connect to Information Manager.
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Redeploy the SampleUI
If you are planning to run RuntimeUI, you will need to redeploy SampleUI.

1 Start or restart the WebLogic Admin Server for the domain in which you installed AnswerFlow.

2 If the RuntimeUI ICE is not running, start it.

Execute <AnswerFlow installation directory>/instances/RuntimeUI/setenv.sh

3 Execute deploy.sh –s <location of SampleUI source directory> -w <location of 
SampleUI war>

For Example:

deploy.sh -s ../../Sample/SampleUI -w ../../Sample/SampleUI/target/
SampleUI.war

Change Arguments of AnswerFlowRuntimeUIServer on WebLogic Admin 
Console

1 Log on the WebLogic Admin Console.

2 Expand the Environment tree from the Deployment Structure and click Servers.

3 Click Lock & Edit from the Change Center to make changes to the domain.

4 Click the server name for the RuntimeUI instance.

5 Under the Server Start tab, edit the Arguments and remove the parameter:

-XX:+PrintCommandLineFlags 

and add the parameter:

-DKEYSTORE_LOCATION=$KEYSTORE_LOCATION

For example, -DKEYSTORE_LOCATION=/afgroup/apps/Keystore

6 Save the changes.

7 Click Activate Changes from the Change Center to activate the changes to the server.

The AnswerFlow RuntimeUI Server can be started from the WebLogic Admin Console.

Recreate Answer Flow startManagedWebLogic.sh 
If startManagedWebLogic.sh scripts were created prior to the upgrade, they must be recreated after 
upgrading. To recreate:

1 Delete the old startManagedWebLogic.sh scripts under:

Knowledge_ROOT/instances/Editor and Knowledge_ROOT/instances/RuntimeUI

2 Execute createStartupScripts.sh on Answer Flow Editor or RuntimeUI ICE.

Restart the AnswerFlow Instances
Start the AnswerFlow Editor and RuntimeUI instances using the instructions in the Oracle Knowledge 
Installation Guide.
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Post In-Place Upgrade Validation
If your installation is configured to use Oracle Knowledge Analytics, validate that the Analytics Event Router 
upgrade was successful.

To validate the Oracle Knowledge Analytics upgrade: 

1 Ensure that Information Manager has been upgraded to 8.5.1 and its instance restarted.

2 Check Total Messages on Router. Navigation: Login WLS Console: Go to Environment >Services > 
Messaging > JMS Modules.

a Click on SystemModule-OracleKnowledgeModule.

b Click on your Analytics Queue (The default name is Queue AnalyticsQueue).

c Click on Monitoring.

3 Create a new message on Information Manager.

4 Check Total Messages on Router following steps listed in step 2.

5 Compare the results from step 2 and 4. The messages total should be higher in step 4.
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